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GEOGRAPHIC INFORMATION SYSTEMS IN 
HIGH SCHOOL GEOGRAPHY EDUCATION: 

A FEASIBILITY STUDY 

C. Sonia Wardley, M.A.

Western Michigan University, 1997 

This research focused on three aspects of the integration of GIS into the high 

school curriculum. Firstly, the investigation strove to demonstrate how GIS could 

enrich the high school geography curriculum in Michigan. Secondly, GIS software 

programs were evaluated for suitability using three techniques, and thirdly, the study 

area high schools were assessed for their technological capabilities relative to GIS. 

The pedagogical and cognitive benefits of using GIS as a tool were established 

_ from the pertinent literature and the feasibility of incorporating GIS into the curriculum

was examined with the reference to the Michigan geography content standards and 

benchmarks. Four GIS software programs, chosen on the basis of selected criteria, 

were systematically analyzed for ease-of-use. This was followed by a nine criteria 

evaluation conducted by high school students. The technological status of high schools 

within the study area, established through questionnaires, was related to environmental 

and enrollment data and to the hardware requirements of the selected GIS programs. 

Generic GIS projects were successful aligned within the context of the 

Michigan curriculum framework. The evaluations revealed that of the selected GIS 

programs, Map Factory was easiest to use. However, the students favored ArcView 

and Mapinfo. There was some evidence that age and gender influenced student 

preferences. The study area high schools were on the whole technically ill-equipped to 

implement GIS and many did not provided computer access to social studies classes. 
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CHAPTER I 

INTRODUCTION 

Background 

The academic discipline of geography has been neglected in American schools 

for over 50 years (Natoli, 1986). In 1982 only 16% of high school graduates had 

completed a course in geography. Over the next five years this figure continued to 

drop, before increasing to 21 % by 1990. This was less than half of the percentage of 

students completing history courses (Figure 1) (U.S. National Education Goals Panel, 

1993). 
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Figure 1. High School Course Completion-History and Geography. 

Source: U.S. National Education Goals Panel. The National Education Goals 
Report: Building a Nation of Learners: The National Report. Vol. 1. 
Washington, D.C.: GPO, 1993. 
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Americans are beginning to realize, as communication networks increasingly 

encircle the globe, they can no longer remain ignorant of the world around them if they 

are to compete successfully in a world economy. So believed the Nation's governors 

and President Bush, when in 1990 they adopted six National Education Goals to be 

achieved by the year 2000 (Figure 2). Within Goal 3, geography was established as 

one of five core subjects, along with English, mathematics, science, and history. The 

objective was to establish core disciplines "in which all U.S. students are expected to 

demonstrate competency in challenging subject matter by the year 2000" (Goal 3, U.S. 

National Education Goals Panel, 1993) (Figure 2). Committees were subsequently 

established to guide the implementation of these goals, including the National 

Assessment of Educational Progress (NAEP): Geography Consensus Project (U.S. 

Department of Education, 1994). The NAEP developed a blueprint for a national 

assessment in geography, which it was authorized by Congress to administer every five 

years beginning in 1994. The results of the first national assessment in geography 

showed only approximately one quarter of 4th, 8th, and 12th graders met the 

performance standard in geography (Figure 3) (National Center for Educational 

Statistics, 1995). As this assessment was administered almost half way through the ten 

year time frame of Goals 2000: Educate America Act of 1994 (Public Law 103-227), 

there is still a long way to go to reach Goal 3 as established by the nation's governors. 

Nineteen ninety-four was also marked by the publication of Geography for Life: 

National Geography Standards (Geography Education Standards Project, 1994). This 

document details eighteen standards on geography content matter, skills, and 

perspectives which "the geographical informed person" should know and be able to do. 

The standards were presented as guidelines for state and local school districts to adapt 

to regional requirements. 

2 
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THE NATIONAL EDUCATION GOALS 

Goal 1: By the year 2000, all children in America will start school ready to learn. 

Goal 2: By the year 2000, the high school graduation rate will increase to at least 

90 percent. 

Goal 3: By the year 2000, American students will leave grades four, eight, and 

twelve having demonstrated competency in challenging subject matter, 

including English, mathematics, science, history, and geography; and 

every school in America will ensure that all students learn to use their 

minds well, so that they may be prepared for responsible citizenship, 

further learning, and productive employment in our modern economy. 

Goal 4: By the year 2000, U.S. students will be first in the world in science and 

mathematics achievement. 

Goal 5: By the year 2000, every adult American will be literate and will possess 

the knowledge and skills necessary to compete in a global economy and 

exercise the rights and responsibilities of citizenship. 

Goal 6: By the year 2000, every school in America will be free of drugs and 

violence and will offer a disciplined environment conducive to learning. 

Figure 2. The National Education Goals. (This author's emphasis) 

Source: U.S. National Education Goals Panel. The National Education Goals 
Report: Building a Nation of Learners: The National Report. Vol. 1. 
Washington, D.C. GPO, 1993. 
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Geography Achievement in 1994 

Grade 4 
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Grade 12 

100% -------------------- ----------�.
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Figure 3. Percentage of Students Who Met the Goals Panel's Performance Standard 
in Geography and the Projected Improvement for 100% Compliance by 
2000. 

Source: U.S. National Education Goals Panel. The National Education Goals 
Report: Building a Nation of Learners. Washington, D.C. GPO, 1995. 
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All this activity on the national front, prompted many state educators to begin 

work drafting state content standards in geography. For example, in Michigan the 

development of the Michigan Framework for Social Studies Education: Content 

Standards (Michigan Department of Education, 1995) occurred concurrently with the 

period of National Standards' development. Therefore, the Michigan content standards 

in geography, although similar, do not represent a direct adaptation of the National 

Standards. Both the National and the Michigan standards are based on the Five 

Fundamental Themes of Geography, which were developed in 1984 and published in 

Guidelines for Geographic Education: Elementary and Secondary Schools (Joint 

Committee on Geographic Education, 1984). The Michigan Framework for Social 

Studies Education was implemented state-wide in 1996. Student performance in 

geography will be assessed, along with other social studies subjects, by the Michigan 

Educational Assessment Program (MEAP) in grades 5 and 8, and by the High School 

Proficiency Test in grade 11, beginning in 1999. The State's adoption of content 

standards will necessitate major reforms in geography education in Michigan. Hence, 

there is an immediate necessity to provide teachers in Michigan with new programs, 

materials, and tools with which they can teach geographical concepts and content 

effectively and efficiently, so their students can meet these new standards. 

The NAEP Geography Consensus Project details the tools required to study 

geography. These include maps, globes, three-dimensional models, aerial 

photographs, satellite images, and geographic information systems (GIS) (U.S. 

Department of Education 1994). Similarly, Geography for Life: National Geography 

Standards describes the use of tools and technologies such as geographic information 

systems in geographic inquiry as essential skills students are expected to learn in order 

to analyze spatial patterns (Geography Education Standards Project, 1994). While the 

geographic information system is becoming increasingly important in government, 
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industry, business, and tertiary educational institutions for the manipulation of spatial 

data, it has not yet gained widespread acceptance in pre-collegiate education. Can GIS

be successfully integrated into K -/2 geography education? This question is the major 

focus of this research. 

Research Problem 

The research question encompasses numerous cognitive, pedagogical, 

curriculum, and software considerations, which suggest a number of subsidiary 

questions, such as: Where in the geography curriculum could GIS be effectively 

utilized? Would a GIS facilitate better understanding of geographical concepts and 

content than traditional teaching methods? Are there commercial or educational GIS 

software packages suitable for use in K-12 education? Do schools have the necessary 

hardware to run GIS programs? Not all these questions could be addressed in this 

research. Consequently, it was decided to narrow the investigation by targeting three 

aspects of GIS implementation in K-12 education. These were: 

1. How could GIS be incorporated into the curriculum? Since there is no

national curriculum in the United States, nor do many states have prescribed curricula, 

the curriculum is most frequently determined at an intermediate or school district level 

(Stoltman and Wardley, 1996). In order to achieve some degree of widespread 

applicability, this research studied the content standards and benchmarks upon which 

individual curricula are developed. Although the National Content Standards in 

Geography were published in 1994 (Geography Education Standards Project, 1994), 

these are frequently not adopted directly at a state level, but modified to reflect local 

educational requirements (Stoltman and Wardley, 1996). This results in geography 

content standards varying from state to state; hence a single state, Michigan, was 

chosen for this analysis. This project concentrated on identifying those unique GIS 
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features which could enable students to more effectively achieve the benchmarks of the 

Michigan Framework for Social Studies Education: Content Standards (Michigan 

Department of Education, 1995). 

2. Which GIS software program is most suitable for schools? At this time

there are no GIS specifically designed for K-12 education. Teachers who have 

embraced this technology have to select software from a wide array of higher 

educational and business programs, none of which have been developed with the 

school-aged student user in mind. This research, therefore, selected a number of 

commercial GIS for a review of their suitability for use in schools. Having established 

which spatial analysis techniques are most applicable to teaching the Michigan content 

standards, the software programs were examined for their ease of use, both in a 

systematic analysis and in a subjective evaluation by students. The purchase costs and 

hardware requirements of the programs were also taken into account. 

3. Are schools technologically equipped to implement GIS? The technology is

complex, expensive, and requires high powered computer hardware. This raises the 

question of whether schools have the necessary computers to run GIS programs. 

Further, the function of a classroom-based GIS will not be the same at all levels of 

K-12 education because of the different cognitive developmental and pedagogical

requirements of students at various grade levels. GIS are complex computer programs, 

which are not known for their user friendliness (Medyckyj-Scott, 1991). It is probable 

that among K-12 students, those in grades 9 through 12 would make the maximum use 

of a school-based GIS. Consequently, this project was limited to the potential role of 

GIS in high schools. It was further determined to ascertain the technological status of a 

number of Michigan high schools. This investigation was restricted to high schools in 

the cities of Battle Creek and Kalamazoo and the surrounding rural areas. The study 

area, shown in Figure 4, was chosen to provide a variety of urban, suburban, and rural 
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schools with student populations ranging from approximately 200 to 1,300 pupils. 

The research question was thus more narrowly focused to state: 

Could GIS be successfully integrated into high school geography education in a 

selected region of southwest Michigan? 

The research design for the investigation of this problem is summarized in 

Figure 5. The methodologies for each of the three sections outlined above are 

discussed in subsequent chapters. The proposed outcomes of the research will be a 

recommendation of a software program suitable for use in high school geography 

education in a selected region of southwest Michigan and the potential role of GIS in 

these classrooms. 
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Figure 4. The Study Area Showing the School Districts and High Schools. 
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CHAPTER II 

REVIEW OF RELATED LITERATURE 

To establish a cognitive and pedagogical rationale for employing Geographic 

Information Systems (GIS) in high schools, a review of current research literature was 

conducted. The survey was divided into four sections: the status of geography in the 

K-12 curriculum, technology's role in the classroom, the implications of learning and

instructional theory, and examples of GIS being used in K-12 education. 

The Status of Geography in the K-12 Curriculum 

Without geography, you're nowhere. 
Graffiti on Warwickshire canal bridge, UK. (Walford, 1995) 

Historic Perspective 

People have needed and used geography for thousands of years. The first 

known map is inscribed on a fragment of bone found in Mezhirichi, Ukraine and the 

first city map, drawn on a clay tablet from Mesopotamia, is thought to be 4,000 years 

old. (Gregg, 1990). Geography continued through the centuries to play an important 

role in the establishment of settlement and boundaries, and in pursuance of trade and 

war. In America , as in Europe, it was an important academic discipline in schools and 

colleges throughout the nineteenth century. However, the emergence of social studies 

in the early twentieth century lead to geography's demise as a separate discipline in 

American K-12 classrooms (Stoltman, 1990). The implications of this omission was 

recognized as far back as 1924, when the editor of the National Geographic magazine, 

Gilbert H. Grosvenor (Grosvenor, G.M., 1995) noted in a memorandum: 
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I think it is unfortunate that children in most schools receive no 
education in Geography after reaching the age of 13 or 14. In these 
days, when the continual extension of the telephone and the radio makes 
instant communication between all peoples possible, and when the 
increasing popularity of the automobile make intimate travel comfortable 
and quick, it seems desirable that young people should have the 
opportunity in the schools to learn something of all people in all lands. 
And yet, the school curriculum provides no study of this subject which 
they may take. 

The situation continued to worsen in the following decades. In the 1960s the 

High School Geography Project (HSGP) sponsored in part by the National Science 

Foundation, attempted to revitalize the subject by establishing a rigorous inquiry 

approach in line with the quantitative revolution which was sweeping the discipline in 

academic circles. Unfortunately, the HSGP was not widely accepted in schools and the 

subject continued to decline (Stoltman, 1990). By 1984 a University of North Carolina 

survey of 2,200 undergraduate students found 71 % were never taught geography in 

elementary school; 65% had no geography in junior high; and 73% had none in high 

school (Grosvenor, 1995). In the previous year, the publication A Nation at Risk: The 

Imperative for Educational Reform (National Commission on Excellence in Education, 

1983), claimed the educational achievements of a large proportion of the population 

were so low as to place the economic and social status of the nation in jeopardy. Data 

were also presented suggesting there was a serious lack of geographical knowledge 

amongst students (Stoltman and Wardley, 1996). Much media attention followed 

which focused on America's geographic illiteracy. In an extensive international survey, 

commissioned by the National Geographic Society in 1988, American adults ranked in 

the lowest third of the nine nations tested and Americans, aged 18-20, ranked last in 

their geographical knowledge (Gregg, 1990). 

The Renaissance of Geography in the Curriculum 

The response to this unacceptable state of affairs has been a renaissance of the 
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subject within the school curriculum (Grosvenor, 1995). This began in 1984, with the 

publication of Guidelines for Geographic Education: Elementary and Secondary 

Schools (Joint Committee on Geographic Education, 1984), which detailed the Five 

Fundamental Themes of Geography (Table 1). These themes were the result of a 

collaboration between the Geographic Education Committee of the Association of 

American Geographers (AAG) and the National Council for Geographic Education 

(NCGE), who with the help of an international panel of geographers and educators, 

attempted to distill the essence of the discipline into a few broad themes which could be 

readily understood and translated into classroom practice. The five themes have been 

well received by teachers and have been incorporated into texts, new state curricula, 

and in national testing and standards developments (Natoli, 1994). 

Table 1 

The Five Fundamental Themes of Geography 

Location 

Place 

Human/Environment Interaction 

Movement 

Regions 

Position on the Earth's Surface 

Physical and Human Characteristics 

Relationships within Places 

Human Interacting on the Earth 

How They Form and Change 

Other initiatives have been less successful. The Geographic Education National 

Implementation Project (GENIP) was founded in 1985, by the National Geographic 

Society, AAG, and NCGE, to promote geography education. It has subsequently 

published curriculum guidelines, which have not received widespread acceptance 

(Gregg, 1990). Nevertheless, GENIP was highly successful in the establishment of 

13 



www.manaraa.com

the Geography Alliance Network, which brings together academic geographers, 

teachers, administrators, and others interested in promoting geography education at a 

state level. There are now alliances in all 50 states, District of Columbia, Puerto Rico, 

and Ontario, Canada, which are responsible for teacher education and the dissemination 

of new ideas and materials into the schools (Grosvenor, 1995). 

These initiatives did not go unnoticed. The nation's governors and President 

Bush, at their summit meeting on educational reform in Charlottesville in October 1989, 

chose geography as one of five core subjects to be taught in all American schools. 

T. J. Wilbanks (1994) has suggested that this choice was not based on an under­

standing of the essence of the discipline nor on a review of the five themes, but on the 

perception geography could provide much needed education on global economic, 

social, and environmental issues. Nevertheless, the educational goals established at the 

summit and published in The National Education Goals Report gave geography 

education a further boost. These goals required world class standards to be established 

for each of the five core subjects and for student achievement to be regularly tested 

(U.S. National Education Goals Panel, 1993). The latter provision lead to the 

establishment of a framework for the NAEP geography test, first administered in 1994, 

which details those elements of geography which should be learnt by American 

students by the time they reach grades 4, 8, and 12 (U.S. Department of Education, 

1994). The publication of the Geography for Life: National Geography Standards 

(Geography Education Standards Project, 1994) swiftly followed. These standards are 

intended to raise geographic education in the United States to international levels. 

However, as David Florio director of the National Academy of Sciences' National 

Systemic Initiatives program noted, national standards represent "goals that are 

narrative in form, not a curriculum checklist. They are intended to be an aid to state and 

local educators, not a prescription. They are being developed in close collaboration 
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with classroom teachers, who will have to 'own' the final product" (National Education 

Commission on Time and Leaming, 1993). As the decision to adopt content standards 

is made at state or even school district level, local communities need to be convinced of 

the relevance of geography to the education of their students (Wilbanks, 1994). 

The Michigan Perspective 

Many states have begun to revitalizing the geography curriculum within schools 

with the drafting of content standards. In Michigan geography was incorporated as one 

of four disciplines in the Michigan Framework for Social Studies Education which was 

adopted by the State Board of Education on 19 July, 1995. The geography content 

standards contained in this document, while not directly based on the National Content 

Standards, display similar themes (Table 2). Each standard is elaborated with a number 

of benchmarks which specify what students are expected to know and be able to do by 

the end of grades 2, 4, 8, and 12 (Michigan Department of Education, 1995). How 

well students have achieved these benchmarks will be assessed by the Michigan 

Educational Assessment Program (MEAP) in grades 5 and 8, and the High School 

Proficiency Test in grade 11, beginning in 1999 (Michigan Department of Education, 

1996). The blueprints for this test are currently being developed. Thus geography 

now has a state mandated role within the curriculum in Michigan. 

The key milestones in the geography reform movement are summarized in 

Figure 6. 

Classroom Implications of Curriculum Reform 

The adoption of content standards and benchmarks at a state and local level is 

not the only hurdle to be overcome if the educational reforms are to take root. The 

standards are merely goals which have to be translated into teaching materials and 
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Table 2 

A Comparison Between the National and the Michigan Content Standards 

National Geography Content Standards 

World in Spatial Terms 
Standards 1-3 

Places and Spaces 
Standards 4-6 

Physical Systems 
Standards 7-8 

Human Systems 
Standards 9-13 

Environment and Society 
Standards 14-16 

The Uses of Geography 
Standards 17-18 

Michigan Geography Content Standards 

People, Places, and Cultures 
Standard 1 

Regions, Patterns, and Processes 
Standard 4 

Location, Movement, and Connection 
Standard 3 

Human/Environment Interaction 
Standard 2 

Global Issues and Events 
Standard 5 

strategies for use in the classroom. Several studies have suggested students still 

function as passive learners, within the majority of the nation's social studies 

classrooms, using only low-order cognitive skills. Further, social studies teachers 

frequently have little geographical knowledge. A study of 860 teacher training 

institutions in 1977 found that one third required no geography credits for elementary 

social studies teachers and another third required only three credits in geography. In 

1982 a review of state certification requirements revealed one state allowed secondary 

teachers to teach geography with only six credits of study in the discipline (Winston, 

1986). Many teachers, probably as a result of their limited exposure to the subject, 

perceive geography as encompassing little more than absolute location (Marran, 1994). 

Therefore, if students are to meet the new standards and benchmarks, there is a critical 
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INITIATIVES 

High School Geography Project 

A Nation At Risk 

North Carolina Survey 
Guidelines For Geographic Education 

Geography Alliance Movement 

America 2000 

NEAP Geography Test 

Geography For Life 

Michigan Framework For Social Studies 

1960 

1970 

1980 

OUTCOMES 

Rigorous inquiry approach 

Nation jeopardized by low educational standards 

Documented geographic illeracy 
Five fundamental themes of geography 

Teach er alliances founded in each state 

1990 Geography named in the core curriculum 

National testing of geographic proficiency 

Geography standards for K-12 education 

State geography standards and benchmarks 

2000 

Figure 6. Timeline of Geographical Reform Initiatives. 

need for the development of structured, high-level instructional materials linked to the 

curricular standards, along with the training of teachers in their use (Hill, 1994). 

For years instructional materials in geography classrooms have tended to be 

dominated by the traditional textbook, or to consist of disparate fugitive materials often 

used with little regard for any unifying scope and sequence (Hill, 1994). In the early 

1990s the National Science Foundation funded two projects, Geographic Inquiry into 

Global Issues (GIGI) and Activities and Readings in the Geography of the United 
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States (ARGUS) to produce structured geographic materials which require higher-order 

cognitive skills. The GIGI project developed instructional materials for secondary 

schools, which were designed to meet the goals of teaching responsible citizenship, 

modem geographic knowledge, and critical and reflective thinking. It consists of two 

issues-based modules for each of ten world regions (Hill, 1994). ARGUS was also 

developed for secondary school students and focused on the geography of the United 

States. It consists of four components: population geography, economic geography, 

political geography, and environmental geography, and is designed to help students see 

meaning in the landscape, to use maps analytically, and apply a spatial perspective to 

problem solving (Hill, 1994). Unfortunately both GIGI and ARGUS were developed 

before the publication of the National Content Standards. Hence, there is a need to link 

these materials to the standards in order to give them immediate applicability in the 

nation's classrooms (Hill, 1994 ). 

Another recent project, GEOLinks, distributes over a thousand teacher designed 

materials on CD-ROM which can be selected by National Content Standard, keyword, 

grade level, learning style, cognitive level, or location (Salter & Salter, 1995). It was 

originally assembled to support the Minnesota geography curriculum, which supplies 

the scope and sequence for these lessons. Each is organized according to a 

standardized format which emphasizes the objectives and outcomes appropriate for the 

grade level. It is expected to have nationwide applicability (Hill, 1994 ). 

Innovative materials alone cannot raise the quality of geography education, new 

teaching strategies are needed to encourage active learning. 

The Role of Technology in Education 

While much attention has been focused on the development of content standards 

in geography and some quality materials, little has been done to prepare new geography 
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teaching strategies suitable for the 21st century. 

Rationale for Implementation of Computer Technologies in Education 

The SCANS report for America 2000 (U.S. Department of Labor, 1992) details 

five areas of competency required in the workplace. These are described in Table 3. 

Table 3 

Workplace Know-How 

Competencies-Effective workers can productively use: 

Resources: allocating time, money, materials, space, staff. 

Interpersonal Skills: working on teams, teaching others, serving customers, 
leading, negotiating, and working well with people from 
culturally diverse backgrounds. 

Information: acquiring and evaluating data, organizing and maintaining 
files, interpreting and communicating, and using computers to 
process information. 

Systems: understanding social, organizational, and technological 
systems, monitoring and correcting performance, and 
designing or improving systems. 

Technology: selecting equipment and tools, applying technology to specific 
tasks, and maintaining and trouble shooting technologies. 

The report recommends that, "by completion of middle school, students should 

have been introduced to workplace know-how; by the age of 16, they should attain 

mastery of it; and by completion of high school, they should be sufficiently proficient 

in it to earn a decent living," (U.S. Department of Labor, 1992). Opportunities for 

learning these skills, therefore, must become an integral part of the student's school 

experience. This cannot occur if the prevalent didactic teaching methods, with their 
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emphasis on rote memorization, continue to dominate the classroom. Computers can, 

if used judiciously, provided not only experience using technology, but also 

opportunities for other workplace competencies, including information processing, 

systems analysis, and development of interpersonal skills, as detailed in the report. 

Educational Benefits of Computer Technologies 

Much of the research on the educational value of computer use refers to 

computer assisted instruction (CAI) or computer aided learning (CAL) and the various 

offshoots of these, such as ICAI (intelligent CAI) and ITS (intelligent tutoring systems) 

(Venezky, 1991). Many authors have expounded the advantages of using computers in 

education (Kulik, 1983; Harris, 1984; Maffei, 1986; Bullough, 1987; Jonassen, 1988; 

Langhorne, 1989; Venezky, 1991). These researchers suggest computers can: 

1. Provide students with the capacity to acquire information efficiently, e.g.,

by allowing access to large data bases. 

2. Provide feedback to the individual learner and allowing pacing according to

the learner's capability. 

3. With color graphics, provide the potential to change parameters and see

effects through visualization. 

4. Provide for interactive learning in which experimental and alternative ideas

can be explored. 

5. Allow for the development of more logical and critical thinking and help

students to acquire decision-making and analytical skills. 

6. Encourage students to try new things without fear of making mistakes.

7. Provide instructional experience in areas too expensive to be provided

otherwise. 

8. Enhance the curriculum using the special presentation capabilities of the

20 



www.manaraa.com

computer. 

9. Provide possibilities for teaching new subject matter beyond the regular

curriculum, particularly new topics or approaches only possible with a computer. 

10. Provide opportunities for students to work collaboratively in problem

solving. 

All of these advantages are directly applicable to the use of GIS in the 

classroom, since it can provide opportunities for problem solving, experimentation, 

visualization, and collaborative work. 

Other studies have attempted to quantify the cognitive and pedagogical gains 

provided by computer use. Nellis (1994) reported a number of these studies, including 

one in which children were found to gain the equivalent of three months of instruction 

per school year when computers were available to them. In another, CAL produced at 

least 30% more learning in 40% less time, and at 30% lower cost. When the computer 

was used for interactive multimedia methods of instruction, a further study found 

retention was raised to 80%, as opposed to 40% for discussion methods, or 20% for a 

lecture approach using visual aids. In contrast, other research suggests improvements 

may vary with ability. Kulik (1983) reported learning increased with low and high 

achievers, but less so with average students. Still other workers have found CAI 

increases enjoyment, but not necessarily learning. Kulik and Kulik (1985) reported 

experimental groups with access to CAI did better in terms of both grade and attitude 

than those without such access. 

Despite some of the contradictory results of research on the value of computer 

use in education, teachers and researchers generally agree on a number of benefits 

which computers can bring to the classroom. These include: 

1. Cognitive benefits-computers provide for the integration of subjects,

increase time on task, accommodation of a variety of learning styles, and allow time for 
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enrichment and/or review. 

2. Affective benefits-computers provide opportunities for peer teaching, for

role modeling, increased student motivation, and opportunities for teachers to be at ease 

with technology (Clouse, 1991-92). 

Educational Uses of Computer Technologies 

To garner these benefits, computers can be utilized in a variety of different ways 

in the classroom. Roecks (1981) identifies thirteen educational uses of the computer, 

including CAL, computer literacy, computer science, as well as several administrative 

functions. Taylor developed an educational computer applications taxonomy which 

divides computer applications into three categories (Jonassen, 1988). These are: 

1. Tutor-this is a device to deliver electronically programmed instruction

which involves the student interactively and records and manages progress. This is 

more frequently termed drill and practice or computer assisted instruction (CAI). 

2. Tool-this helps the students accomplish tasks quicker, more efficiently and

effectively. The user initiates the activity, learns from modeling the action of the tool, 

and remains largely in control throughout the user-computer interaction. Examples of 

this are word processing and spreadsheets applications. 

3. Tutee-here the student is in control by commanding the computer to

accomplish some desired task. In this the user has to problem solve. An example of 

this includes computer programming. 

GIS, while frequently termed a tool, fits better into the tutee category, since 

GIS requires a cognizant operator to determine which analytical operations to use to 

solve a problem in a meaningful way. The proactive computing environments in some 

GIS provide possibilities for queries not anticipated by the system designers reinforcing 

the tutee role of the computer (Buttenfield, 1994). 
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Some research has investigated the value of computers specifically in geography

education (Snaden, 1988; Unwin, 1991b). Unwin (1991b) proposes four uses for the

computer in the teaching of geography:
\ 

1. Computers as sources of data and information, e.g., to provide access to

very large data bases which the student may actively explore, manipulate, and analyze,

such as national or state demographic, political, social, and economic data and

meteorological data.

2. Computers as analytical tools, e.g., statistical analysis of spatial problems,

remotely sensed image analysis, computer mapping, GIS. These can be used to

investigate other digital geographic information, e.g., Digital Line Graphs (DLG),

Digital Elevation Models (DEM), and Geographic Names Information System files

(GNIS). 

3. Computers as laboratories for investigating the World, e.g., simulations to

model complex world systems, which may be real or imaginary. Snaden (1988) noted

role playing simulations focus on higher order cognitive processes and can be used to

achieve affective objectives.

4. Computers as instructors, e.g., CAI-a programmed, self-paced course of

instruction. These can include drill and practice which focuses on learning at the lower

cognitive levels of factual knowledge and memorization (Snaden,1988). Many of these

programs are now camouflaged with a game format (Fitzpatrick, 1993). Others take

the form of tutorials which tend to be 'page turning' programs of text plus graphic

followed by a question.

It is important to note these authors do not envision the computer as the

.. ) curriculum, but as a tool which can greatly enhance the curriculum (Langhorne, 1989)

L by introducing, enriching, and reinforcing a topic (Maffei, 1986).
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Problems in Integrating Computer Technologies Into the Classroom 

Computers have entered schools largely as a result of cultural diffusion 

following the acceptance of the computer in mass culture. Community initiatives by 

parents, students, and individual teachers have brought this technology into the 

classroom (Harris, 1984; Venezky, 1991). Despite the initial enthusiasm for the 

educational use of computers and the results of research which has reinforced the value 

of computers in education, they are often used for little beyond the teaching of 

keyboarding and basic computer skills and for drills and tutorials in many schools and 

colleges (Audet, 1994). Unwin and Macguire (1990), writing about higher education, 

suggest the reasons for this are deep-seated and social rather than technical in origin. 

They relate to the crude early versions of CAI, which provided very mechanistic 

programmed learning of factual material, the fear of unskilled academic staff and their 

unwillingness to invest in the effort thought necessary to enter the field, and from the 

idea computers are only of value as tools in the more analytical parts of the curriculum. 

This resulted from the inability of faculty members to recognize the enormous potential 

of computers for teaching virtually anything (Unwin, 1991a). These observations 

appear to be just as applicable to K-12 classroom. Other authors suggest the early 

projections of computers driving the much needed revolution in education raised 

expectations beyond what could be delivered, resulting in disillusionment with the 

technology, and leading Venezky (1991) to propose a need for more modest goals for 

CAL as a cost effective approach to instruction. Venezky (1991) also pointed out that 

any new teaching method has to prove its ecological validity by being so much better 

than existing methods, to justify the institutional costs and anxieties caused by change. 

In one of the few comparative studies of learning using GIS, K. Weller (1993) 

examined "The Appropriateness of GIS Instruction in Grade Six for Teaching Kansas 
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Water Resources" in which sixth grade students used manual or computerized GIS for 

ten twenty minute periods over a two week period. The classroom which used the 

computerized GIS did not have sufficient computers to allow the students to interact 

with the computer for the entire ten lessons. This limited exposure to computerized 

GIS did not produce any measurable improvement in learning. 

These issues have to be resolved if geographic education is to be enhanced by 

the integration of computer spatial applications such as GIS. Such software can 

provide students with unrivaled opportunities to understand and model geographic 

patterns and processes (Nellis, 1994). Training students to use these technologies will 

also address the future needs of the workplace, especially in information, systems, and 

technology competencies, as outlined in the SCANS Report for America 2000 (U.S. 

Department of Labor, 1992) (Table 3). 

The Pedagogical Implications of Leaming and Instructional Theory 

Cognitive learning theories attempt to explain how learners employ cognitive 

processes to create meaningful information in the memory from instructional stimuli 

(Happs, 1985). Psychologists have long debated the issue of how humans learn. 

Within the twentieth century two very different bodies of theory have been developed. 

Historic Perspective 

In the first half of the 20th century psychological research in United States was 

dominated by behaviorism, in which learning was thought to result directly from 

sensory experiences. It focused on identifying the environmental stimuli which 

brought about the desirable response in learning; for example, memorization in the 

learner which may be then reinforced or weakened as a result of additional experiences. 

Significant contributions were made to this body of theory by E. L. Thorndike, Ivan 
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Pavlov, and B. F. Skinner. In contrast to this largely empirical approach to the study 

of learning, European psychologists at this time saw learning in terms of rationalism, 

where the environmental stimuli were interpreted by the learner using innate cognitive 

processes (Shute, 1994). This approach was developed, particularly in Germany, by 

Gestalt psychologists who focused on the structural characteristics of mental 

functioning (Shuell, 1994). Gradually both orientations began to coalesce. 

In 1932, F. Bartlett developed the theory of schemata or mental structures in 

which past experiences are used to interpret new knowledge and give it meaning. The 

idea of schema had been first hypothesized by Head, a neurologist, in 1918 (Brewer, 

1984). The Swiss psychologist, J. Piaget, believed these cognitive structures were not 

innate, but were developed through the active acquisition of knowledge and evolved 

through childhood into maturity (Shute, 1994). The Soviet psychologist, L. Vygotsky, 

saw cognition being influenced not only by maturation, but also by cultural factors 

which provided the foundation for cognitive processes. This holistic activity approach 

did not influence learning theory for several decades (Strauss, 1993). 

By the 1960s the zeitgeist of American psychology began to swing from a 

behaviorism to constructivism, as the emphasis moved from changing the environment 

in order to influence learning to encouraging the use of appropriate learning strategies 

(Shuell, 1986). Leaming was no longer thought to be merely a passive response to 

environmental stimuli, but an active constructive process. In the 1970s, research 

concentrated on analysis of memory, problem solving, and language. This cognitive 

psychology brought several new concepts to learning theory, including: (a) learning as 

an active, constructive process; (b) learning encompassing higher level cognitive 

processes; ( c) learning as a cumulative process in which prior knowledge is influential 

to learning; (d) cognitive structures in which knowledge is represented and organized in 

the memory; and (e) the analysis of learning tasks and performance in terms of the 
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cognitive processes involved (Shuell, 1986). Theories of learning seek to explain how 

these cognitive processes are engaged during learning. 

Modern schema theory has been developed by many researchers, including 

Minsky and Rumelhart and Ortony, who sought to explain how new knowledge is 

constructed by a process of creating personal meaning from new information and prior 

knowledge (Brewer, 1984). In this theory, information is stored in the brain as a 

mental picture or schema, which is constructed by direct, active exploration and 

learning. New information is processed into new knowledge by linking it with existing 

schemata, that is prior knowledge, or developing a new schema to accommodate it 

(Conley, 1992). Higher order thinking involves the manipulation of information to 

produce new meaning or comprehension, such that new information can be 

accommodated within schemata. Only then does learning actually occur. 

This idea is further developed in D.E. Rumelhart and D.A. Norman's theory 

which describes three different kinds of learning, these are: (1) accretion in which new 

information is encoded in terms of existing schemata, (2) restructuring or schema 

creation when new schemata are made, and (3) tuning or schema evolution in which 

schemata are refined as a result of experience in different situations. L.B. Resnick has 

suggested accretion and tuning are similar to the processes of assimilation and 

accommodation in Piaget's theory of cognitive development (Shuell, 1986). 

Many learning theories do not consider the influence of instruction on these 

cognitive processes and it was not until the 1980s that instructional psychology became 

a separate part of cognitive psychology (Shute, 1994). 

Cognitive Leaming and Instructional Models 

While theories of learning attempt to describe the behavioral and cognitive 

processes involved in learning, models of learning form a practical application of those 
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theories to groups of students in classrooms by identifying the principles, variables, 

and concepts which support learning. They can also be used to generate instructional 

models for implementation in schools (Burns, 1994). 

A model of school learning developed by J. Carroll in the 1960s related the 

degree of learning to the time spent on task in relation to the time required to complete 

the learning task. A ratio of 1: 1 indicated learning was accomplished. Three variables, 

motivation, opportunity to learn, and time allowed, were thought to influence the time 

spent learning, while aptitude, intelligence, and quality of instruction governed the time 

needed to learn. This model gave rise to the well known concepts of learning rate, 

engaged time, and active learning time which emphasize the importance of time in 

student learning (Burns, 1994). 

Also in this period, J. Bruner developed a model of instruction which focused 

on identifying conditions which improve and optimize learning outcomes. Four factors 

which influence learning were outlined. These included: (1) learner predispositions­

these are the motivational factors which influence learner's desire for learning, (2) 

structure of knowledge-how the knowledge to be learned is represented, (3) sequence 

-the order in which the information is presented, and ( 4) timing and nature of

reinforcement-this relates to feedback on how the learning is progressing. Bruner 

argued for students to be involved in diverse opportunities through which they can 

develop greater understanding and integration of knowledge and skills (Burns, 1994). 

Other researchers have also stressed the importance of students actively 

processing new information if effective learning is to take place. M. Wittrock's 

Generative Learning Model suggests learning with understanding is a function of the 

associations which the learner generates between prior knowledge stored in the long 

term memory and the new stimuli. New meanings and interpretations of events are 

constructed by actively retrieving information from long term memory and using 
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information processing strategies to generate meaning from the new information, which 

is then organized, coded, and stored in the long term memory (Wittrock, 1974). Happs 

(1985) considers Wittrock' s model compatible with the Piagetian constructivist 

approach. 

R. Gagne and R. White proposed long term memory consists of four types of

elements: (1) verbal knowledge, (2) intellectual skills, (3) images, and (4) episodes. 

The verbal knowledge contains facts or beliefs; intellectual skills consists of 

information on task performance; while images are pictorial or diagrammatic 

representations of information; and episodes are memories of events in which the 

individual took part. Gagne and White suggested recall of any element is a function of 

the degree of interlinking with other elements within the memory, therefore, learning 

experiences which involve all four elements are likely to improve retention of related 

factual material within long term memory (Gagne and White, 1978). 

More recently cultural psychology, influenced by sociocultural work of 

Vygotsky, has proposed the use of authentic learning activities in a model of learning 

and instruction called "Cognitive Apprenticeship" (Shuell, 1994). In this context, 

authentic activities are those which simulate situations the student will encounter in life 

outside the classroom. Traditionally school learning has not been placed within the 

context of the real world experiences and social interaction and consequently, has not 

harnessed the innate curiosity and desire for knowledge and social contact of the 

students (Burns, 1994). In this Expert-Novice model, the teacher demonstrates the 

authentic learning task and students work in groups to emulate the expert performance. 

The group activities are designed to provide a supportive learning environment for the 

students and to distribute work across the group. Gradually external support is 

removed as learners assume more responsibility for their learning (Burns, 1994 ). 

Strauss (1993) noted that in this model, the apprentice's cognitive knowledge structures 
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differ in several ways from the expert's, particularly in knowledge content, 

organization, and problem solving strategies. Therefore, students require diverse 

learning opportunities to move from novice to expert status. 

Learning theory demonstrates knowledge is acquired in a variety of ways. 

Simple learning may be facilitated by operant and classical conditioning, whereas 

meaningful learning of complex material is an active, constructive, cumulative, self­

regulated, and goal-oriented process. This latter type of learning is concerned with 

understanding of a complex body of knowledge and the establishment of relationships 

between concepts and facts as opposed to the memorization of separate isolated facts 

found in simpler forms of learning (Shuell, 1994). 

GIS as an Instructional Tool 

The fundamental theoretical foundation for moving GIS technologies into the 

K-12 classroom is based on cognitive, not behavioral, systems, or management

theories, all of which have been applied in the past to CAI, but which are more 

concerned with educational and instructional management (Winn, 1988). The question 

is whether using a GIS can facilitate effective learning of complex materials. 

Instruction must engage students in learning activities which are likely to result 

in effective learning, taking into account prior knowledge, the context in which the 

material is presented, and the realization that the student's interpretation and 

understanding of new information depends on the availability of an appropriate 

schemata (Shuell, 1986). Because of the wealth of information available today and the 

different experiences each learner brings to the classroom, the teacher must provide the 

links between new information and prior knowledge, and design activities which 

accommodate all types of learning (Happs, 1985). Further, the social and cultural 

nature of learning has to be taken into account with the provision of authentic rather 

30 



www.manaraa.com

than artificial tasks and the consideration of motivational and affective influences on 

learning. 

Not all the models of learning and instruction appear directly applicable to 

learning with GIS. However, most models indicate the importance of active 

information processing in learning. Students using GIS must employ higher order 

cognitive skills when manipulating data if meaningful results are to be obtained. The 

Gagne and White model of learning suggests learning experiences which involve the 

four elements of verbal knowledge, intellectual skills, images, and episodes, are likely 

to improve retention of related factual material within long term memory. A concept 

taught using a GIS would provide all four elements: (1) factual information involving 

the context in which the concept is embedded; (2) intellectual skills generated in the 

manipulation of this information; (3) image in the form of the various map layers; and 

(4) an episode when the student performs the task at a computer terminal. It may be

pertinent to add at this point that the strength of event or episodic element may decrease 

as computers become part of the everyday experience of the classroom. Similarly, 

instruction with a GIS fits well with the Expert-Novice model. R. Audet (1993), in his 

study on "Developing a Theoretical Basis for Introducing GIS into High School: 

Cognitive Implications," found GIS experts employed very different methods of 

problem solving than novice high school students. It is, therefore, apparent GIS will 

not teach students problem solving skills, but the teacher as the expert can model 

complex problem solving strategies with authentic tasks using a GIS, which groups of 

students can emulate as they learn the cognitive processes involved. Table 4 

summarizes the instructional benefits of utilizing a GIS for effective learning. 

Using a GIS allows students to manipulate information, investigate 

relationships, and create their own meaning. It also provides opportunities for analysis 

of real world or authentic problems in an environment which allows for self-pacing and 
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Table 4 

Instructional Benefits of Using GIS 

Methods for Effective Learning 

Gagne and White's Model: 

Factual knowledge 

Intellectual skills 

Images 

Episodes 

Expert-Novice Model: 

Problem Solving strategies 

Authentic tasks 

Investigatory approach 

Higher order cognitive skills 

Self-pacing 

Opportunities for collaborative learning 

Accommodates a variety of learning styles 

Motivation 

GIS Facilitates 

✓ 

✓ 

✓ 

✓ 

✓ 

✓ 

✓ 

✓ 

✓ 

✓ 

✓ 

✓ 

a variety of learning styles (Tennyson, 1988). Data manipulation with a GIS involves 

the higher order thinking skills of classifying, comparing, contrasting, generalizing, 

hypothesizing, and drawing inferences and conclusions. Hence, by using GIS 

students can actively investigate spatial relationships, develop a deeper understanding 

of the underlying geographical concepts, and attain more meaningful learning. 
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Examples of GIS in K-12 Geography Education 

Although the potential for using GIS in K-12 has generated enthusiasm among 

professional educators, as demonstrated by the EdGIS conference in January, 1994 and 

the specialty meeting at the National Council for Geographic Education in November, 

1996, there is little evidence of its widespread acceptance in schools. Nevertheless 

there have been a number of initiatives designed to encourage the adoption of GIS by 

schools. 

The National Center for Geographic Education and Analysis (NCGIA), authors 

of a GIS core curriculum for post-secondary education, established the Secondary 

Education Project (SEP) in 1992. The Project has sponsored a number of teacher 

workshops which provide a short basic introduction to GIS and some digital data sets 

which can be used with the GIS programs, IDRIS! and ArcView (Palladino, 1994). 

Environmental Systems Research Institute (ESRI), the manufacturer of ArcView, 

created the "Adopt-a-School" program in 1992 in which the company supplied low cost 

software and data to selected schools and encouraged local government and private 

business GIS users to share data and expertise with the adopted school (ESRI, 1995). 

Teacher training was undertaken by government and private agencies or through 

university programs, some of which were sponsored by state Geographic Alliances. 

By 1994 nearly 250 schools were enrolled in the program (Wendelken, 1994). ESRI 

has also provided software to each of the fifty state Geography Alliances, which run 

demonstrations and workshops at summer institutes for teachers (Fitzpatrick, 1994). 

Despite these initiatives there are only a few documented instances of well 

established GIS programs in secondary schools. At the Thomas Jefferson High School 

for Science and Technology, a magnet school in north Virginia, two GIS software 

packages, IDRIS! and ArcView, are being used in a geoscience class. Here students 
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have classified Landsat images of the 1988 Yellowstone National Park fire, the 1993 

Mississippi floods, and the Gulf War oil fires of Kuwait using GIS, as well as 

conducting studies of local watersheds and solid waste disposal sites (Keranen, 1994). 

Another year-long GIS curriculum is offered in environmental science at the Jupiter 

Community High School in Palm Beach, Florida (Ramirez, 1995). In Ohio, the 200 

acre campus at the University School is used as a field laboratory in a GIS and 

Environmental Science curriculum (Friebertshauser, 1994). In Michigan the students at 

Cass Technical High School in Detroit, have mapped the location of 200,000 homes 

serviced by lead water mains. The maps are being used by the City of Detroit and the 

School of Public Health of the University of Michigan to identify at-risk students. The 

Cass GIS students are involved many other similar community service projects 

(Raymond, 1994 ). In Kansas, a network of teachers and students from across the state 

are involved in an environmental monitoring project In one school students are using 

GIS as part of a national study of Monarch butterfly migrations, while other students 

are monitoring non-point source pollution in a local watershed (Case, 1994). 

All these projects highlight some of the inherent problems of moving GIS 

technology into schools. Firstly, in at least two of the schools, north Virginia and 

Florida, GIS is only available to high achieving students. For example, in the Palm 

Beach school, only teacher recommended, honor students, who have already studied 

earth science, advanced mathematics, geography, and have computer literacy, may take 

the course (Ramirez, 1995). This reflects the universal difficulty in using complex GIS 

software. Secondly, many of these schools have the opportunity to use GIS because 

they are technologically well equipped, as all full-functioned GIS systems use 

sophisticated hardware. The ESRI "Adopt-a-School" program addresses this problem 

by encouraging fund-raising events to finance the necessary hardware to run Arc View. 

Thirdly, although many of the teachers in the schools listed above have had little formal 
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GIS education, they are extraordinarily talented and motivated. Typically extensive 

teacher training is necessary before GIS can be introduced into the classroom. The 

South Florida Water Management District provides 60 hours of GIS training to 

interested teachers, followed by additional studies at national GIS conferences 

(Ramirez, 1995). 

Conclusion 

Modern technology is used in almost every work place in the United States. It, 

therefore, must be an integral part of the student's school experience. Extensive 

research has shown the use of computers can enhance the curriculum by providing 

numerous cognitive and affective benefits and the technology also now has the potential 

to provide access to vast information resources and to facilitate analysis, problem 

solving, and systems modeling. As geography is been endowed with new authority in 

the K-12 curriculum by national and state goals and content standards, GIS seems 

ideally poised, as a computerized system which encompasses the peculiarly 

geographical domain of spatial relationships and demands the use of higher order 

cognitive processes, to move geography into a new era in K-12 education. Some of 

the practical considerations of this lofty ideal as well as an examination of the role of 

GIS in a standards-based Michigan geography curriculum are the focus of this research 

thesis. 
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CHAPTER III 

GEOGRAPHIC INFORMATION SYSTEMS IN THE GEOGRAPHY 
CURRICULUM 

Introduction 

The first part of this research sought to define how Geographic Information 

Systems could be integrated into high school geography curriculum in a selected region 

of southwest Michigan. Efforts to elucidate the role of GIS in higher education have 

fueled a vigorous debate for over a decade. As yet little has been written on the subject 

with respect to K-12 education. However, many of the issues are the same in both 

arenas, although their resolution is likely to be quite different. These issues can be 

consolidated into three research questions: 

1. What are the educational ramifications for the integration of GIS into the

curriculum? 

2. How much education and training will teachers and students require to use

GIS effectively? 

3. Can GIS be integrated into the high school geography curriculum in

Michigan? 

Educational Ramifications of GIS 

Three of the principal concerns educators raise in the post-secondary GIS 

controversy will be discussed with reference to the high school curriculum in Michigan. 
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GIS Education Versus GIS Training 

GIS is becoming a widespread phenomenon for the management and analysis 

of spatial information. As much as 80% of all information held by business and 

government may be geographically referenced (Franklin, 1992) and the realization of 

this has resulted in GIS becoming a multi-billion dollar industry with a growth rate of 

20-30% per year (Barstow, 1994). Such rapid growth has quickly out-stripped the

supply of GIS educated and trained personnel, resulting in many technicians working 

in the field with little formal GIS training. A survey by Medyckyj-Scott and 

Hearnshaw in Europe and Australia found 37% of the 51 respondents had 2 weeks 

training, 24% 1 to 2 weeks, and 33% less than 1 week (Hearnshaw, 1993). This has 

raised the most critical and controversial question of who should train GIS specialists. 

Few seem to argue GIS is not a necessary part of any collegiate geography curriculum, 

. as GIS is the tool of choice for the analysis and modeling of spatial data and associated 

nonspatial or attribute information (King, 1991 ). Nevertheless, many academics 

challenge a technocentric vocational approach to education (Kemp, 1991). Their 

concern focuses on the increase in technical training being at the expense of overall 

geographic education (King, 1991 ). This debate has been waged particularly 

vociferously in Britain, where many scholars believe the university's role is to educate, 

not to vocationally train students. These academics maintain training should be 

provided by software manufacturers or in short post graduate training programs 

(Jenkins, 1991). In the United States many universities now offer courses which teach 

the conceptual framework of GIS, even so there is still some controversy as to how 

much technical proficiency should be achieved. Walsh ( 1992) called for the integration 

of GIS education and GIS training as the most effective way to teach GIS. While the 

universities continue to argue about their role in GIS education, the junior colleges are 
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beginning to address the demand for technically trained personnel, by instigating GIS 

courses which provide some conceptual background with specific technical training 

(Palladino, 1995; Holley, 1996). 

Does this contentious issue translate directly to the K-12 arena? Some believe it 

does. With business and government clamoring for trained personnel, secondary 

education in GIS is seen as necessary to alert students to the possible job opportunities 

in the industry, especially if technical training becomes widely available in community 

colleges (Barstow, 1994, ARCNews, 1995). This view would seem to be reinforced 

by the SCANS report for America 2000 (U.S. Department of Labor, 1992) which 

recommends high school students should attain proficiency in using computers to 

process information; in understanding technological systems; in monitoring and 

correcting (system) performance; designing or improving systems; in selecting 

equipment and tools; applying technology to specific tasks; and maintaining and trouble 

shooting technologies (Table 3). Using a GIS to teach geographical concepts would 

involve many of these skills. How much education or training this K-12 exposure to 

GIS technology would involve has not been widely discussed. 

GIS as a Science Versus GIS as a Tool 

Recognizing a need to incorporate GIS into the curriculum raises another 

dichotomy. Does this mean education about GIS or with GIS? Many universities seem 

to be choosing to educate about GIS by offering GIS courses, frequently at the 

graduate level. Some undergraduate courses are being developed or GIS modules are 

being incorporated into existing spatial techniques courses (Walsh, 1992). The 

National Center for Geographic Information and Analysis (NCGIA), responding to the 

industry's need for trained personnel, developed a collegiate core curriculum to 

encourage the initiation of quality courses in GIS and to provide a standard for what 
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students educated about GIS should know (Kemp, 1991). This year-long course is 

divided into three sections: Introduction to GIS; Technical Issues in GIS; and 

Application Issues in GIS. 

Even though the SCANS report (U.S. Department of Labor, 1992) emphasizes 

the importance of the technological training, many educators do not believe there should 

be a similar GIS curriculum in secondary schools (Tinker, 1994). The Edgis meeting, 

a GIS in K-12 education specialist group, at the NCGE conference in Santa Barbara, 

California, in November 1996, came to the conclusion there would always be a few 

schools which could offer a GIS curriculum, for example, as an elective in science and 

technology magnet schools. Students studying such a curriculum would receive the 

appropriate social studies or science credit for the content discipline in which the 

curriculum is embedded. In the majority of schools, however, GIS would be used as a 

tool within a number of different disciplines. The curricular requirements of a GIS 

course will be quite distinct from those engendered by using GIS as a tool. 

No core curriculum for GIS has been developed at secondary level and there is 

as yet no consensus among educators as to what such a GIS curriculum should include. 

Therefore, schools which wish to institute a GIS curriculum have no relevant research 

to guide the development of their courses. 

If, on the other hand, GIS is to be used as a tool, what is it essential to know 

about GIS theory to successfully use a GIS? This issue has not been resolved at the 

university level where GIS is being used in a wide spectrum of disciplines, from 

landscape architecture, environmental science, engineering, forestry, urban and 

regional planning, to geography (Walsh, 1992). In business and government, GIS is 

increasingly utilized by the casual user who is not trained in GIS technology nor 

theory. As GIS interfaces become more user friendly, this trend is likely to increase. 

How much knowledge do such users need to produce accurate and meaningful results? 
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White and Simms (1993) see danger in GIS driving the methodology of problem 

solving in these situations. If the user does not first develop a true understanding of the 

question, the GIS could take on the aura of a 'magic box'. Walsh (1992) expresses 

similar concerns that the casual user will conduct analyses with insufficient 

understanding of conceptual and analytical considerations. To counteract technology 

driving decision-making Chrisman (1987, 1997) has suggested the GIS curriculum 

should not be centered on GIS software operations but structured around the nature of 

geographic information and how GIS processes are dependent on social and cultural 

contexts. Again there is no body of research in this field with respect to secondary 

education. How much GIS theory would the teacher and the student need to know to 

successfully utilize this tool? Research is needed to resolve these issues before 

successful widespread implementation of GIS can occur. 

Commercial Versus Educational Software 

The third contentious issue in GIS education and training is which type of 

software to use. Rogerson (1992) ponders whether an academic program can or even 

should use a commercial software package. Other authors express frustration at the 

high cost of hardware and software necessary for introducing GIS into the curriculum, 

and the frequently recurring costs of maintenance and upgrades which prevent small 

and less well-funded university departments from offering their students exposure to 

industry standard GIS (Wise, 1991, Wilke, 1991). Campbell (1991) promotes the use 

of a spreadsheet as a low cost GIS, and Unwin (1991b) believes the most basic GIS 

concepts and principles can be taught at an introductory level using relatively low cost 

software, e.g., ARC/DEMO and its successor, GIST!, and GISTutor (Raper, 1992). 

GIS software available in the public domain can also be used, e.g., ArcView 1.0, 

OZgis, and TNT MIPS Light. Wise (1991) describes a British initiative to centrally 
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purchase a commercial program which could be made available to campuses at reduced 

costs. Such discussion becomes moot when employers continue to select candidates 

for GIS related jobs who have had hands-on experience with a particular commercial 

software package, despite protestations that they want well-educated and well-rounded 

employees (Rogerson, 1992). This returns full circle to the issue of the universities' 

role in education or training. The reality of the job market may indeed resolve both 

issues regardless of the opinions of the academic purists. 

This latter consideration is of no particular consequence in the K-12 arena. No­

one expects a high school student to become sufficiently proficient to enter directly into 

the work force as a GIS technician. Despite this, the question of which software to use 

is equally problematic, but for different reasons. As there are no programs specifically 

designed for secondary education, schools have no alternative but to use higher 

educational or commercial packages. The suitability of these programs for high school 

education is investigated elsewhere in this research (see Chapters IV and V). 

Learning to Use a GIS 

GIS are only as useful as the information the users can gain from them. 
(Andrew Frank 1993, 12). 

This statement reaches to the very heart of the problem. Generating 

meaningful, comprehensible information with a GIS can be very difficult and 

frustrating, particularly for the novice. How do we prepare students to make the 

necessary, huge leap in understanding within the constraints of the high school 

curriculum? 

It is quite clear students will not be able to use a GIS as a tool without some 

education and training. Hearnshaw (1993) recognizes four types of learning in training 

a GIS user: (1) education about GIS, (2) education with GIS, (3) training about GIS, 

41 



www.manaraa.com

and (4) training with GIS. Education refers to the learning of GIS concepts and GIS 

applications, and training is learning which is software and hardware specific. This 

format will be used to discuss the GIS education and training of high school users. 

Education About GIS 

How much the student needs to know about GIS theory to effectively use the 

system as a tool cannot be accurately answered as yet. Personal experience in operating 

GIS software would seem to indicate certain prerequisites are essential. For instance, 

students will need initially to know the types of data a GIS can handle and how these 

are encoded. GIS is ideally suited to process spatial data which is geo-referenced, but 

people do not think spatially in terms of the arcs, nodes, and polygons of a vector 

system nor in terms of the pixels of a raster system. Consequently, significant 

cognitive and behavioral modification has to occur to understand and manipulate these 

spatial depictions (Medyckyj-Scott, 1991). This became apparent in this research when 

the majority of the students in their brief exposure to GIS failed to grasp the 

significance of the mode of data encoding on the results of the analysis they conducted, 

even though it was pointed out to them (Chapter V). Students also require an accurate 

cognitive map of the data base and of ways a GIS can display this information, if they 

are to appreciate and exploit it fully (Blades, 1993). 

Secondly, although many students and casual users may never enter data, 

especially as more digital data becomes readily available, sources of data and methods 

of entry are important in understanding the accuracy and limitations of the data for 

analysis. Even though some schools will be involved in community GIS projects 

where accuracy is a critical factor in decision making, e.g., Cass Technical High 

School (Raymond, 1994 ), curriculum restraints will limit the majority of the projects 

undertaken in high schools to the teaching of concepts and not in solving community 
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problems. For students to fully understand data constraints, it would be advantageous 

for students at some stage to develop their own database from paper maps or field 

survey. This would be in-line with cognitive learning theories which stress the 

importance of students actively processing new information for effective learning. Not 

all systems support tablet digitizing and it is unlikely schools will be able to purchase 

the necessary additional hardware and software for such occasional use. Many 

systems, however, do allow for the screen digitizing of scanned maps or images. Data 

acquisition is frequently taught first, mimicking the beginning of any GIS project, but 

the more fundamental implications of data entry can be missed as the student struggles 

with the mechanical issues of operating the hardware and software. System familiarity 

may be necessary for the full ramifications of data entry to be realized. Knowledge of 

data entry may also be necessary for the overall comprehension of the system. The 

students who participated in this research specifically asked how the maps were entered 

into the GIS. 

The third necessity is an understanding the range of analyses GIS can perform 

and where these can be applied. Coulson and Waters (1991) found college students, in 

introductory level GIS courses, frequently employ inappropriate analyses and 

demonstrate a lack of understanding of the statistics used. In the high school where 

GIS is used as a tool, the teacher will have to assume responsibility to guide students 

away from these pit-falls. This implies the teacher has a comparatively advanced 

knowledge of GIS, which is seldom the case. These problems serve to highlight the 

depth of knowledge required by the teacher will be very different from that required by 

the student who uses GIS as a tool to conduct inquires. 

Fourthly, knowledge of principles of data display and output is necessary since 

the purpose of using a GIS is for visualization of information. Most systems allow for 

a variety of display modes, including graph, table, map, text, image, and photograph 
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and a few even incorporate audio and video. Some permit the display of all of these on 

a single screen. For such output to have the desired impact some graphing, 

cartographic, and artistic know ledge will be needed, if appropriate choices are to be 

made. Geographers frequently bemoan the garish maps shown in GIS advertisements 

and magazines designed by the cartographically illiterate for instantaneous visual 

gratification, but which lack meaning. Medyckyj-Scott (1991) suggests GIS should 

have minimum default values based on map design principles to avoid the production of 

poorly devised, ineffective maps. In the high school setting, it is to be hoped the 

students will have acquired graphing and cartographic skills from previous mathematics 

and geography courses, prior to working with a GIS. This indeed will be the case in 

Michigan if they have attained proficiency in the geography content standards and 

benchmarks for the previous grades (Michigan Framework for Social Studies 

Education, Michigan Department of Education, 1995). 

Apart from an introduction to GIS, the learning of most of this information can 

be integrated into GIS projects. In fact teaching the fundamentals of GIS in a situation 

where theory is not divorced from performance will probably be the most effective 

strategy. This requires that the first GIS projects be carefully structured to introduce 

the concepts one at a time, so that students have the time to assimilate the new 

knowledge into existing schema or construct a new schemata before application is 

required. 

Training About GIS 

Before students can use GIS effectively they have to learn how to operate the 

hardware and software. This can be so time consuming some high school GIS courses 

demand computer literacy as a pre-requisite for participation (Ramirez, 1995). Even 

with knowledge of the hardware, learning to use the software is not easy. Although 
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many programs now use a more user-friendly Microsoft Windows interface standard, 

the learning curves can be quite long and steep. This is a significant problem in a 

situation in which GIS will be used as an occasional tool in a social studies course, 

which may be already over burdened with too much content. Nevertheless, students 

still have to be trained in the appropriate skills and behavior patterns for specific GIS 

tasks, beginning with information on the overall structure of the system and the 

procedural steps to do basic tasks, e.g., start, stop, assess a file, and save a file 

(Hearnshaw, 1993). Only through knowledge of the file structure and methods of 

retrieval can appropriate files be assembled for use as a project. 

Once these essential skills have been mastered, students can learn to manipulate 

maps by changing the scale and performing visual overlays of compatible map layers. 

All systems allow for querying of maps and the database and for some analyses, hence, 

students require training in the querying process and in how the GIS performs 

individual analyses. In a raster system, maps may require recoding prior to or as a part 

of data manipulation, if map objects are to remain distinguishable. In addition detailed 

knowledge of the operation is often necessary in order to interpret the results. In a 

vector system the user can be less intimately involved in the individual operations, even 

so an analysis frequently has to be conducted in stages in which tables may require 

joining or intermediate maps constructing. Finally, the student will have to be aware of 

the display capabilities of the system and learn how to color a map appropriately and 

create a layout which effectively shows the information. Some of the basic skills 

needed to operate a GIS are shown in Table 5. 

Education and Training With GIS 

These two types of GIS learning will be treated together as they are intrinsically 

interwoven. Education and training with GIS is essentially where students are educated 
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Cartography 

. Manipulating tables 

Graphics 

Table 5 

Some Basic Skills Needed to Operate a GIS 

Changing scale and selecting map projections. 

Subsetting data. 

Classifying data. 

Choropleth maps. 

Choosing symbols and colors. 

Overlay. 

Querying a map by logical expression or spatially. 

Map analysis. 

Restructuring a table. 

Sorting a table. 

· Querying a table.

Joining tables.

Joining a table to a map layer.

Choosing graph types. 

Selecting numerical scales 
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Table 5-Continued 

Layouts 

Source: 

Combining appropriate maps, tables, graphs, and text. 

Creating effective maps. 

Adapted from GIS in K-12 Education. ArcView White Paper Series. 
Redlands, CA.: Environmental Systems Research Institute, April 1995. 

in how GIS can be used to study other disciplines, e.g., geography, earth science, 

biology, or environmental science, and receive training in manipulating a particular 

system to solve specific topical problems. 

It is important not to lose sight of the cognitive and curricular constraints of the 

high school classroom, when realizing the potential of using this new technology to 

.involve students in exciting investigatory research. Firstly, there is a need to analyze 

the cognitive demands of GIS tasks to ensure the students have the cognitive 

prerequisites to understand or learn the task (Liben, 1994). This will be less of a 

problem in high school grades than with younger children. Although there is no 

research data on the cognitive development levels necessary for specific GIS tasks, in 

this research there was a noticeable difference in the speed and depth of concept 

assimilation between the 9th grade and the 11th and 12th grade students. This could 

pose significant problems in high schools where geography is open to all grades. Even 

so, this situation could also provide opportunities for cooperative learning where older 

students work with and help the younger students. 

Secondly, where GIS is used as a tool, any GIS project must meet the aims and 

objectives of the curriculum in which it is used (Jenkins, 1991). Many school curricula 

are becoming content standard driven. This is particularly so for many disciplines in 
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Michigan. The Michigan Framework for Social Studies Education contains content 

standards for the four Social Studies discipline strands of history, geography, civics, 

and economics, and the three cross-cutting strands of inquiry, public discourse and 

decision making, and citizen involvement (Figure 7). The content standards of these 

latter strands will be achieved within the context of the four social studies disciplines. 

Benchmarks for each content standard have been established to designate what students 

are expected to know and be able to do at the end of early elementary, late elementary, 

middle, and high school grade levels (Michigan Department of Education, 1995). 

These benchmarks are to be used as the basis for state-wide assessment in grades 5, 8, 

and 11, beginning in 1999. This assessment is linked to state funding of schools and 

maintenance of local control of schools. Therefore, with such high stakes state 

assessment, it is readily apparent that any integration of GIS into the geography 

curriculum will have to address the discipline's content standards and benchmarks. 

The content standards not only incorporate the content of the curriculum but the 

methods by which it is taught. The cross-cutting content standards promote an inquiry 

approach to geography education. This is further reinforced by the Standards for 

Teaching (Michigan Department of Education, 1996) which encourage the development 

of lessons which involve students in higher order thinking, deep knowledge, and 

connections to the world beyond the classroom. This is in-line with current cognitive 

learning theories which stress the importance of the active acquisition of knowledge 

though authentic learning tasks. GIS is particularly suited to an inquiry approach to 

learning. The Michigan high school content standards and benchmarks for the 

geography and cross-cutting strands are shown in Figures 8 and 9. 

Typically the development of curricula is determined at a school district level in 

Michigan. However, by virtue of the state recommended core curriculum and state 

mandated assessment, the scope and sequence of geography curricula in Michigan 
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SOCIAL STUDIES STRANDS AND CONTENT STANDARDS 

Historical Geographic Civic Economic 

Perspective Perspective Perspective Perspective 

Time and Chronology People, Places, Purposes of Individual and 

and Cultures Government Household choices 

Comprehending the Human/Environmental Ideals of American 
Business Choices 

Past Interaction Democracy 

Analyzing and Location, Movement, Democracy in Role of 
Interpreting the Past and Connection Action Government 

Judging Decisions American 
Regions, Patterns, Government and Economic Systems from the Past and Processes. Politics 

Global Issues American Government 
Trade 

and Events and World Affairs 

Figure 7. Michigan Social Studies Strands and Content Standards. 

Public Discourse 

Inquiry and Decision 

Making 

Information Processing 
Identifying and 

Analyzing Issues 

Conducting 
Group Discussion 

Investigations 

Persuasive Writing 

Citizen 

Involvement 

Responsible Personal 
Conduct 

Source: Michigan Department of Education. Michigan Framework for Social Studies Education: Content Standards. 
Michigan Social Studies Education Project, July 1995. 
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schools can be determined. The context for the MEAP tests are shown in Figure 10. 

As can be seen the regional emphasis at the lower grades changes to a thematic 

approach in high school geography in the form of Global Issues. Therefore any 

program to integrate GIS into the classroom must be within this context. Most of the 

current initiatives for using GIS in the classroom have focused on local issues 

(Keranen, 1994; Raymond, 1994; Case, 1994; Friebertshauser, 1994). Indeed this is 

the recommended approach for the integration of GIS into the curriculum (Audet, 

personal communication, 1996; ESRI, 1997). This has largely arisen from instances in 

which students use field work to collect their own information to build databases and 

from the perception that students learn better when studying issues which are close to 

them geographically as well as emotionally. Further, digital data are often easier to 

obtain from local government agencies and businesses. Michigan's global context for 

high school geography curricula does not totally preclude the use of local data. In a 

thematic approach, traditionally the basic principles of a process are taught first and 

then illustrated with case studies, and where possible, one with a local or national focus 

is followed by international instances which provide comparisons and contrasts. With 

an inquiry approach t9 learning this is frequently reversed, whereby the investigation of 

the case studies allows students to 'discover' the concepts of the underlying processes. 

GIS is particularly suited to this approach, as Tinker (1994) aptly expresses it, tools 

like GIS allow learning at the edge. Thus a teacher may begin a global issues topic 

with an investigation of a local or national example. While data may or may not be 

readily available in digital form, the students may be able to build their own database 

using digital, geo-referenced base map outlines. As the students begin to understand 

the relationships and implications involved in the local example, contrasts can be made 

with similar situations in other countries, by comparing the data. The students can 

finally attempt to formulate solutions to these issues, as they grapple with the cultural, 
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STRAND 2-GEOGRAPHY PERSPECTIVE 

Standard 2.1 Diversity of People and Places, and Cultures. 
Students will describe, compare, and explain the locations and characteristics 
of places, cultures, and settlements. 

2.1.1. describe how major world issues and events affect various people, 
societies, places, and cultures in different ways. 

2.1.2. explain how culture might affect women's and men's perceptions. 

Standard 2.2 Human/Environment Interaction. 
Students will describe, compare, and explain the locations and characteristics 
of ecosystems, resources, human adaption, environmental impact, and 
interrelationships among them. 

2.2.1. describe the environmental consequences of major world processes 
and events. 

2.2.2. assess the relationship between property ownership and the 
management of natural resources. 

Standard 2.3 Location, Movement, and Connections. 
Students will describe, compare and explain the locations and characteristics 
of economic activities, trade, political activities, migration, information flow, 
and the interrelationships among them. 

2.3.1. describe major world patterns of economic activity and explain the 
reasons for the patterns. 

2.3.2. explain how events have causes and consequences in different parts 
of the world. 

Standard 2.4 Regions, Patterns, and Processes. 
Students will describe, compare, and explain characteristics of ecosystems, 
states, regions, countries, major world regions, and patterns and explain the 
processes that created them. 

2.4.1. explain how major world processes affect different world regions. 
2.4.2. explain how major world regions are changing. 
2.4.3. explain how processes like population growth, economic 

development, urbanization resource use, international trade, global 
communication, and environmental impact are affecting different 
world regions. 

2.4.4. describe major patterns of economic development and political 
systems and explain some of the factors causing them. 

Standard 2.5 Global Issues and Events. 
Students will describe, compare and explain the causes, consequences, and 
geographic context of major global issues and events. 

2.5.1. explain how geography and major world processes influence major 
world events. 

2.5.2. explain the causes and importance of global issues involving 
cultural stability and change, economic development and 
international trade, resource use, environmental impact, conflict 
and cooperation, and explain how they may affect the future. 

Figure 8. Michigan High School Geography Content Standards and Benchmarks. 
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STRAND 5-INQUIRY 

Standard 5.1 Information Processing. 
Students will acquire information from books, maps, newspapers, data sets, 
and other sources, organize and present the information in maps, graphs, 
charts, and timelines, interpret the meaning and significance of information, 
and use a variety of electronic technologies to assist in accessing and 
managing information. 

5.1.1. locate information pertaining to a specific social science topic in­
depth using a variety of sources and electronic technologies. 

5.1.2. use traditional and electronic means to organize and interpret 
information pertaining to a specific social science topic and prepare 
it for in-depth presentation. 

5.1.3. develop generalizations pertaining to a specific social science topic 
by interpreting information from a variety of sources. 

Standard 5.2 Conducting Investigations. 
Students will conduct investigations by formulating a clear statement of a 
question, gathering and organizing information from a variety of sources, 
analyzing and interpreting information, formulating and testing hypotheses, 
reporting results both orally and in writing, and making use of appropriate 
technologies. 

5.2.1. conduct an investigation prompted by a social science question and 
compare alternative interpretations of their findings. 

5.2.2. report the results of their investigation including procedures 
followed and a rationale for their conclusions. 

STRAND 6 - PUBLIC DISCOURSE AND DECISION MAKING 

Standard 6.1 Identifying and Analyzing Issues 
Students will state an issue clearly as a question of public policy, trace the 
origins of the issue, analyze various perspectives people bring to the issue, 
and evaluate possible ways to resolve the issue. 

6.1.1. generate possible alternative resolutions to public issues and 
evaluate them using criteria that have been identified. 

Standard 6.2 Group Discussion 
Students will engage their peers in constructive conversation about matters of 
public concern by clarifying issues, considering opposing views, applying 
democratic values, anticipating consequences, and working towards making 
decisions. 

6.2.1. engage each other in elaborate conversations that deeply examine 
public policy issues and help to make reasoned and informed 
decisions. 

Standard 6.3 Persuasive Writing. 
Students will compose coherent written essays that express a position on a 
public issue and justify the position with reasoned arguments. 

6.3.1. compose extensive elaborated essays expressing and justifying 
decisions on public policy issues. 

Figure 9. Michigan High School Cross-Cutting Content Standards and Benchmarks. 
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Figure 9-Continued 

STRAND 7-CITIZEN INVOLVEMENT 

Standard 7 .1 Responsible Personal Conduct. 

Students will consider the effects of an individual's action on other people, 
how one acts in accordance with the rule of law, and how one acts in a 
virtuous and ethically responsible way as a member of society. 

7 .1.1. act out of respect for the law and hold others accountable to the 
same standard. 

7 .1.2. plan and conduct activities intended to advance their views on 
matters of public policy, report the results of their efforts, and 
evaluate their effectiveness. 

Figure 9. Michigan High School Cross-Cutting Content Standards and Benchmarks. 

Source: Michigan Department of Education. Michigan Framework for Social Studies 
Education: Content Standards. Michigan Social Studies Education Project, 
July 1995. 

Contexts for MEAP Test 
Grade 5 

Contexts for MEAP Test 
Grade 8 

Contexts for MEAP Michigan 
High School Proficiency 

Regions of the Test 
Major World Regions United States 
and Cultures 

Geographic and Environ-
mental Implications of 
Global Issues and Events 

Figure 10. Geography Context for Test Items for the Michigan State Assessment in 
Social Studies. 

Source: Michigan Department of Education. Michigan Framework for Social 
Studies Education: Plan for Statewide Assessment of Social Studies. 
Michigan Social Studies Education Project, July 1996. 

economic, and regional differences which affect the problem. 

For example, pollution is a common topic included in Global Issues courses. 
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Within this context, in a study of acid rain students could develop different map layers 

showing the distribution and size of major point sources of sulfur dioxide emissions in 

the United States; the acidity of rainfall; instances of forest damage (this could be a 

satellite image showing vegetation distress); and biotically dead lakes and waterways. 

If groups of students are responsible for developing different data layers this provides 

an excellent opportunity for collaborative learning. Comparing these data layers with 

weather and climatic information and elevation data would allow the students to 

describe patterns, analyze relationships, and develop an understanding of the basic 

processes and consequences of acid rain and predict which areas are also at risk from 

this damaging pollutant. This could lead to a discussion on the spatial implications and 

possible resolution of air pollution problems in North America and the need for 

international cooperation in developing public policies to control emission of pollutants. 

Moving this issue to a global scale and still employing a GIS becomes more 

problematic, as the necessary digital data are more difficult if not impossible to obtain. 

Indeed finding analog data for other regions of the world can be very tedious. Despite 

this, some basic mapping on a country or regional scale may be possible, which may be 

all that is necessary _as the process remains largely the same, although the resolution is 

more complex due to the numbers of countries involved, the cultural perceptions of the 

issues, and the individual country's financial capabilities to rectify the situation. This 

could be the principal focus of the latter part of the study. The culmination of this 

investigation could be a presentation to interested parties or letters to legislators. 

In developing a curriculum which uses GIS, it is essential to ensure that it 

addresses the required context and content standards and benchmarks for geography 

education in Michigan. In this instance such an investigation into acid rain using GIS 

fits well into the geography high school context of "Geographic and environmental 

implications of global issues and events." It fulfills in part four content standards 
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within the geography perspective, and almost all the cross-cutting content standards, 

with a total of nine benchmarks, as shown in Table 6. 

Could all this be accomplished without using GIS? Indeed, much of it could, 

as paper maps similar to the data layers could be prepared, but, the analysis of the 

information would be more difficult and cumbersome using so many maps and tables. 

The specific GIS features of querying and overlay are ideally suited to investigating a 

database of this type, allowing student to experiment with ideas as they formulate an 

understanding. An additional advantage of the GIS is the superior quality of the GIS 

output which would allow students to swiftly prepare professional quality graphics to 

accompany presentations or letters to legislators. Finally using the GIS would also 

allow students to attain mastery of much of the workplace know-how as outlined in the 

SCANS report for America 2000 (U.S. Department of Labor, 1992) (Table 3). 

Other topics which fit within the Michigan Geography context for high schools 

and which lend themselves to an investigatory approach using GIS as a tool are 

described in Table 7. Each is referenced to the geography content standards and 

benchmarks it could help the student achieve. The cross-cutting standards and 

benchmarks are not �ited as almost all the Inquiry benchmarks (Strand 5) will be met in 

every investigation. The benchmarks from Public Discourse and Decision Making 

(Strand 6) and Citizen Involvement (Strand 7) which will be addressed will depend 

upon the questions posed and the methods used in the inquiry. 

There are two types of GIS projects which fit particularly well the geography 

context and content standards, the mapping of global and regional patterns and local 

case studies. As can be seen from the Table 7 the former is very powerful in satisfying 

numerous benchmarks. The local case studies on the other hand, while important in 

understanding underlying principles, address fewer benchmarks. Consequently, it is 

important to ensure local case studies do not dominate the curriculum and sufficient 
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Table 6 

The Curriculum Requirements Met by an Investigation Into Acid Rain Using GIS 

Bench- Content Standard 
mark 

2.2.1. describe the environmental consequences of major world processes and 
events. 

2. 3. 2. explain how events have causes and consequences in different parts of the 
world. 

2.4.3 explain how processes like population growth, economic development, 
urbanization resource use, international trade, global communication, and 
environmental impact are affecting different world regions. 

2. 5. 2. explain the causes and importance of global issues involving cultural 
stability and change, economic development and international trade, 
resource use, environmental impact, conflict and cooperation, and explain 
how they may affect the future. 

5. 1. 1 . locate information pertaining to a specific social science topic in-depth using 
a variety of sources and electronic technologies. 

5. 1. 2. use traditional and electronic means to organize and interpret information 
pertaining to a specific social science topic and prepare it for in-depth 
presentation. 

5. 1 . 3. develop generalizations pertaining to a specific social science topic by 
interpreting information from a variety of sources. 

5. 2. 1. conduct an investigation prompted by a social science question and compare 
alternative interpretations of their findings. 

5. 2. 2. report the results of their investigation including procedures followed and a 
rationale for their conclusions. 

6.1.1. generate possible alternative resolutions to public issues and evaluate them 
using criteria that have been identified. 

6. 2. 1. engage each other in elaborate conversations that deeply examine public 
policy issues and help to make reasoned and informed decisions. 

6.3 .1. compose extensive elaborated essays expressing and justifying decisions on 
public policy issues. 
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Table 6---Continued 

Bench- Content Standard 
mark 

7 .1.2. plan and conduct activities intended to advance their views on matters of 
public policy, report the results of their efforts, and evaluate their 
effectiveness. 

time is given to regional and global comparisons. Care was taken to select projects for 

which data are probably readily available at least in analog form and which could be 

performed using a simple GIS program. Not all the projects could be performed on a 

single piece of software, as some of the investigations are more suited to a raster and 

others to a vector system. The table demonstrates many global issues can be 

investigated using GIS as a tool, but most of the projects would be very time 

consuming as databases would first have to be constructed. It is, therefore, envisaged 

that only 2 or 3 projects using GIS would be conducted each year. Subsequent classes 

could utilize these databases more swiftly and could update and revise projects as well 

as create new ones. In this manner a wealth of digital data will eventually become 

available to the school, which could be utilized by other disciplines. 

Conclusion 

GIS technology has exploded onto the business scene in the past decade, 

generating numerous educational issues which still remain to be fully resolved despite 

extensive academic discussion. In the newly emerging secondary education GIS field 

the necessary research questions to address these issues have barely been formulated, 

however, some fundamental principles are beginning to emerge. Firstly, GIS is most 

likely to be used as tool within established disciplines rather than as a stand-alone 
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Global Issue 

Population Dynamics 
Change 

Movement 

Human Welfare 

Environmental Hazards 

Earthquake 

Table 7 

GIS Projects for a Global Issues Curriculum 

GIS Projects 

Global mapping of spatial and temporal patterns; comparison with 
spatial and temporal patterns of GNP and Food Index per capita. 

Mapping of gains and losses due to migration within US; compared to 
employment statistics. 

Benchmarks 

2.1.1., 2.4.1., 2.4.2., 
2.4.3., 2.5.1., 2.5.2. 

2.3.1., 2.3.2., 2.4.2., 
2.4.3. 

Global mapping of sources of US immigration-changing temporal and 2.1.1., 2.3.1., 2.3.2., 
spatial patterns. 2.4.1., 2.4.2., 2.4.3., 

2.5.1., 2.5.2. 

Case study-impact of refugees by comparison of economic and human 2.1.1., 2.3.1., 2.3.2., 
welfare statistics for receiving countries. 2.4.1., 2.4.2., 2.5.2. 

Global mapping of indicators of human welfare, e.g., life expectancy, 
birth rate, infant mortality, disease burden, safe water and sanitation 
provision, health care provision, PQLI, GNP, literacy, education level. 

Global mapping of spatial, temporal, and magnitudinal patterns; 
comparison of damage and injury with population density, economic 
indicators. 

Case study-mapping extent of damage with distance from epicenter, 
population density, and soil type. 

2.1.1., 2.4.1., 2.4.2., 
2.4.3., 2.5.2. 

2.1.1., 2.2.1., 2.4.1.,. 
2.4.3., 2.5.1. 

2.2.1., 2.4.1., 2.4.3., 
2.5.1. 

Ul 
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Table 7-Continued 

Global Issue 

Volcanic eruption 
Mud slides 

Flood 

Hurricane/Tornado 

Human Modification of 
Ecosystems 

Environmental Conservation 

GIS Projects 

Case study-using a DEM and stream function to model zones at high 
risk from inundation from lava or mud. 

Case study-mapping of elevation, precipitation, landuse, soils, and 
population density to model zones of high risk. 

Case study-mapping of tracks, magnitudes, and damage; comparison 
of damage with landuse, population density, economic indicators. 

Case study-locating shelters, planning evacuation routes. 

Global mapping of spatial and temporal patterns of deforestation, 
agriculture, mining, urbanization, and fisheries, etc. 

Case study--comparing landcover with flora and fauna populations 
spatially and temporally to define criteria for habitat which sustains 
populations. 

Benchmarks 

2.2.1., 2.4.1., 2.4.3., 
2.5.1. 

2.2.1., 2.4.1., 2.4.3., 
2.5.1. 

2.2.1., 2.4.1., 2.4.3., 
2.5.1. 

2.2.1., 2.3.2. 

2.1.1., 2.2.1., 2.3.1., 
2.3.2., 2.4.1., 2.4.2., 
2.4.3., 2.4.4., 2.5.2. 

. 2.2.1., 2.4.3., 2.5.2. 

Case study-identification of suitable habitat for reintroduction of 2.2.1., 2.4.3., 2.5.2. 
species. 

Case study-monitor the health of wetlands over extended time period. 2.2.1., 2.4.3., 2.5.2. 

V1 
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Table 7-Continued 

Global Issue 

Soil Conservation 

Environmental Pollution 
Water 

Air 

Land 

Waste Management. 

Economic Development 

Resource Development 

GIS Projects 

Global and regional mapping of soil erosion, meteorological factors, 
and agricultural practices. 

Case study-mapping of soil type, agricultural practices, and slope, to 
identify soil erosion potential. 

Benchmarks 

2.2.1., 2.3.1., 2.3.2., 
2.4.1.,2.4.3., 2.5.2. 

2.2.1., 2.3.2., 2.4.1., 
2.4.3., 2.5.2. 

Case study-regional or local mapping of point and non-point pollution 2.2.1., 2.3.2., 2.4.3., 
sources compared to water quality of ground and surface waters. 2. 5. 2.

Case study-regional mapping of air pollution sources, meteorological 
factors, and areas of pollution damage to establish relationships. 

Case study-mapping of location of brown field sites to predict impact 
on economic development of community. 

Case study-determining the optimum location for a local landfill, 
waste water recovery plant, regional radio-active waste disposal site. 

2.2.1., 2.3.2., 2.4.3., 
2.5.2. 

2.2.1., 2.3.2., 2.4.3., 
2.5.2. 

2.2.1., 2.3.2., 2.4.3., 
2.5.2. 

Global mapping of spatial and temporal patterns of economic indicators. 2.3.1., 2.3.2., 2.4.1., 
2.4.2., 2.4.3., 2.4.4., 
2.5.2. 

Global mapping of resource reserves, production, and consumption. 

Case study-determining optimum location for resort (recreational) 
development. 

2.3.1., 2.3.2., 2.4.2., 
2.4.3., 2.5.2. 

2.3.1., 2.4.3., 2.5.2. 
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Table 7-Continued 

Global Issue 

Industrial Development 

Energy Development 

Urbanization 

Communications 
Air, Road, Rail, and Water 
Transportation, Tele­
communications 

GIS Projects 

Case study-determining the optimum location of an industrial 
(commercial) facility. 

Case study-determining the optimum location for wind (solar, HEP) 
energy generation. 

Global mapping of spatial patterns to compare rate of urbanization with 
economic indicators and human welfare indicators. 

Case study-determining areas (un)suitable for urban development. 

Case study-modeling plans for urban renewal. 

Case study-modeling of plans for airport noise management. 

Benchmarks 

2.3.1., 2.4.3., 2.5.2. 

2.3.1., 2.4.3., 2.5.2. 

2.1.1., 2.4.1., 2.4.2., 
2.4.3., 2.5.1., 2.5.2. 

2.1.1., 2.2.1., 2.5.2. 

2.1.1., 2.2.1., 2.5.2. 

2.1.1., 2.2.1., 2.5.2. 

Global, regional, and local mapping of spatial and temporal patterns of 2.3.1., 2.3.2., 2.4.1., 
trading routes and volumes. · 2.4.2., 2.4.3., 2.5.1.,

2.5.2.

Global, regional, and local mapping of spatial and temporal patterns of 
communication routes and usage. 

Case study-determining optimum route for new highway. 

2.3.1., 2.3.2., 2.4.1.,
2.4.2., 2.4.3., 2.5.1.,
2.5.2.

2.2.1., 2.3.2., 2.4.3. 
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curriculum in secondary schools. King (1991) points out, "Geography students need 

to understand that the major contribution they can make to solving real world problems 

is in the area of applications of GIS technology, not in the technology itself." Secondly, 

the extent of education and training about GIS necessary for its effective use will have 

to be determined on a trail and error basis at the present time as the research has yet to 

be conducted. Thirdly, any project which uses GIS will have to match the instructional 

goals, the discipline's content standards and benchmarks, and the context of instruction 

in the curriculum (Woronov, 1994). Finally, despite these constraints there are 

numerous ways in which GIS can be used in an inquiry approach to learning. 

Although there may be compelling cognitive and pedagogical reasons for 

integrating GIS into the geography curriculum there are numerous practical 

considerations which have and will continue to impede its widespread acceptance. 

Some of these issues will be addressed in the subsequent chapters of this research. 
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CHAPTER IV 

A SYSTEMATIC EVALUATION OF SELECTED 
GEOGRAPHIC INFORMATION SYSTEMS 

Introduction 

The second part of this research was an evaluation of Geographic Information 

System software programs. Thorough research revealed there are no GIS programs 

specifically for pre-collegiate education. Therefore, the K-12 teacher has little option 

but to purchase a GIS designed for undergraduate education, for research, or a 

commercial business software package. Faced with this choice, how does the teacher, 

newly enthused with the potential of using GIS in the classroom, decide which 

program to use? A review of the literature suggests that IDRIS! (an educational and 

research package from Clark University) and Arc View (a commercial business program 

from Environmental Systems Research Institute, Inc.) are the most widely used 

programs. How these selections were made is frequently not described in the literature, 

although in one instance IDRIS! was chosen for "its relatively low cost and low 

learning curve" (Fazio, 1995). These two programs were also selected for use in two 

dissertations on GIS in K-12 education. Weller (1993) for her study on "The 

Appropriateness of GIS Instruction in Grade Six for Teaching Kansas Water 

Resources" selected ID RISI on the basis of recommendations from a "GIS in Schools" 

workshop held by The National Center for Geographic Information and Analysis in 

1992 and Audet (1993) used Arc View in his work on "Developing a Theoretical Basis 

for Introducing GISs into High School: Cognitive Implications." Some vendors are 

very active in the K-12 arena, e.g., ESRI with their Adopt-a-School program (see 
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Chapter II). 

Software choice may be dependent upon which programs are most readily 

available, those of which the teacher has most knowledge, or those for which there is 

available training. Little research was found which could help guide the teacher in this 

decision-making process. Consequently, in order to elucidate this critical issue further 

a fourth research question was posed: 

4. Which GIS programs are most suitable for use in high school education?

Research Design 

The identification of suitable GIS programs was conducted in three stages. The 

first two stages, the initial selection and a systematic evaluation, are described below 

and the third, a student evaluation, is detailed in Chapter V. 

Initial Selection 

There are a large number of GIS programs available. They can be divided into 

two basic types, those using a vector representation of spatial data and those using a 

raster form. In the ve�tor model, spatial information is represented using points, lines, 

and polygons, the position of which are defined by coordinate values. The attributes or 

information associated with these features are stored in attribute tables. In the raster 

model, data are represented by a grid, usually of squares, but any tessellating polygon 

could also be used. Here each cell or pixel carries a single attribute which applies to 

every location within the cell (Aronoff, 1993). Many programs now incorporate both 

models, however these tend to be the more expensive packages. Less expensive 

software often displays both types of data representation but can only analyze one type. 

Since neither model is inherently superior to the other, as each performs some types of 

analysis more effectively than the other, it was determined to include both models 
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amongst the programs selected (Mitchell, 1991). 

The initial identification of GIS programs suitable for high school education 

was approached on the basis of two criteria; cost and ease-of-use. These factors were 

chosen because of current fiscal constraints on education in Michigan and the limited 

time allotted to geography within the Michigan curriculum. 

Recent changes in the state funding of education in Michigan has led to leaner 

budgets in many school districts. The local electorate appear less tolerant of millage 

increases to fund education calling upon school boards to improve efficiency and 

reprioritize their spending. For example, within the study area of this research, the 

Gull Lake School District proposed an increase millage in 1996 to finance a much 

needed upgrade in student computer technologies (Gull Lake Community Schools, 

1996). This was rejected by the electorate leading the school board to scale back its 

plans and seek funds from other areas in the budget. Therefore, in the initial selection 

procedure a somewhat arbitrary limit of $500 per student copy was set on the cost of 

the software. This is probably too high, as state and local fiscal constraints mean there 

will be little money available to purchase multiple copies of expensive software for use 

by a single discipline. However, there are very few programs which fall below this 

limit at present. 

The second criterion chosen was ease-of-use, as GIS are notorious for their 

steep and long learning curves. Inservice teacher training is customarily conducted in 

short workshop sessions or week-long university courses. Hence, if GIS is to be 

integrated into social studies classrooms teachers will expect to attain proficiency 

swiftly. In addition, it is also unlikely the teacher will be able or willing to devote 

much class time to teaching program operation, because of the wide breadth of the 

social studies curriculum and the limited time devoted to the discipline in many schools. 

In the initial selection, any GIS program which followed the Microsoft Windows 
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interface standard was considered to fulfill the ease-of-use criterion. DOS or menu 

driven interfaces were thought to lengthen the learning curve too much to make them a 

practical proposition for introduction into the average high school social studies class. 

Systems using UNIX were excluded on the basis of the low cost criterion as they are 

usually prohibitively expensive. As a result, only GIS programs with a Windows 

interface standard which cost less than $500 were chosen. 

Once this initial selection of GIS programs had been made, basic information on 

hardware requirements, the data representation, and the methods of data entry were 

recorded for each GIS. The programs were then subjected to a systematic evaluation. 

Systematic Evaluation 

Even using a Windows interface standard, there is a considerable difference in 

the learning curves of programs. Therefore, in order to narrow the choice of programs 

still further, a methodology was devised to systematically evaluate the ease-of-use of 

the various GIS. A list was developed of attribute and spatial data functions a GIS 

could be expected to perform based on those described by Aronoff (1993), Chrisman 

(1997), and Albrec�t (1996) and adapted for use in K-12. It is recognized that all GIS 

programs do not implement these functions in similar ways. However, they do achieve 

comparable educational outcomes, which does permit a direct comparison between 

programs. Further, only those functions which could be performed by all the selected 

GIS programs were included. 

In order to assess how easy these functions were to operate, the number of 

actions needed to implement each operation was counted. It would also have been 

possible to use time-to-execute as a means of evaluating ease-of-use. This has a 

number of advantages, including differentiating between functions which are simple 

and quick to implement and those which require the same number of actions, but which 
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are more complex and time consuming. Despite these benefits, it was decided human 

factors such as variations in familiarity with the software and fatigue, would be too 

influential on the time taken to execute a function. 

In order to allow for the comparison of the results between programs, a strict 

protocol was established. It was necessary to clearly define the meaning of "a single 

action". Clicking once on a button or selecting from a menu were both considered a 

single action since only a single click of the mouse was used, even though the latter 

took more time. A double click of the mouse was also counted as one action. 

All the programs tested made extensive use of dialogue boxes. Some of these 

could be filled out by typing a line of script or by selecting the appropriate words from 

scrolling menus. Others required the typing of individual words or the selection of 

these words from lists and the clicking of buttons on or off. In many cases there were 

two ways of filling out the same box, typing the command or selecting it from a list or 

menu. Because of this duplicity of command entry and the difficulty of determining the 

number of actions involved in typing a line of script, it was decided to describe the 

filling out of any single dialogue box as one action. Therefore, if a function required 

the opening and fillip.g out of a dialogue box, two actions were recorded, one to open 

the box and the second to fill it out. It was recognized this gave an unfair advantage to 

those programs with complex dialogue boxes. Two other problems arose with 

dialogue boxes. Firstly in programs which used nested dialogue boxes, the completion 

of each box was counted as one action. Secondly in most programs closing a dialogue 

box and executing the function involved clicking on a single button displayed within the 

box. This was counted as part of the single action of filling out the box. By contrast, 

in one program the operator had to return to the main program menu and scroll and 

select the 'execute' command to close the box. It was decided to count this as an extra 

action because it involved going outside the dialogue box itself. 
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Not only was the definition of a single action clearly defined, but the same data 

set was entered into each of the selected GIS to ensure there would be no variations due 

to differences in the data to be analyzed. Finally, for each GIS function tested one 

procedure or task was chosen to be carried out with each program. For example, to 

evaluate the ease-of-use of the attribute editing function, the attribute of one individual 

areal feature on the landuse map was changed and the number of actions needed to 

accomplish this task was recorded. The choosing of suitable tasks raised further 

problems as some functions can be used in several different ways. In these cases it 

was determined to perform the simplest operation or the one judged most likely to be 

used in a high school settling. 

This systematic evaluation was used to identify the simplest GIS for one 

function or for a group of functions, or to determine which GIS program was easiest to 

use overall. 

Materials 

The data set used in the systematic evaluation was the same one developed for 

the student software ev:aluation described in Chapter V. It consisted of six map layers 

for Thornapple Township in Barry County, Michigan (Table 8). The data files were 

digital, but they had to be converted into different formats for entry into each of the GIS 

programs. The file preparation and conversion are described in Appendix A. 

Also included in the systematic evaluation for comparison with the 

computerized GIS was a Manual GIS (Appendix B). It was constructed using the 

Thornapple data set and its preparation is described in Appendix A. 
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Map Layer 

ELEVATION 

LANDUSE 

LAKES 

RIVERS 

ROADS 

HIGHWAY 

Table 8 

Systematic and Student Evaluation Data Set 

Description and Source Map Number of Classes 

Elevation (USGS 1:24,000) 15 

Land cover/use 1994 (Miris, 1978) · 30 

Lakes (Miris, 1978) 2 

Rivers (Miris, 1978) 2 

Country roads (Miris, 1978) 2 

Highway M 37: Hastings to Grand Rapids 2 
(Miris, 1978) 

USGS-United States Geological Survey. 
Miris-Michigan Resource Information System. 

Methodology 

Initial Selection 

A number of approaches was used to create a list of GIS programs from which 

to make the initial selection. GIS user and education specialist discussion groups on 

the Internet were asked which GIS programs they would recommended for high school 

use. Map II, MapGrafix, Maplnfo, and Atlas were some of the programs mentioned 

by the respondents. A literature search found K -12 more or less dominated by two 

GIS programs, IDRISI and ArcView, as outlined previously. Trade papers, 

magazines, promotional materials, and advertisements were also studied to find 

possible candidates. Public domain software was not considered because of its limited 

functionality. 
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The two criteria of ease-of-use and low cost were then used to make the initial 

selection. Firstly, the cost of a single student copy was determined from promotional 

materials, from a company's World Wide Web site, or by calling a company's sales 

department. Only those program costing less than $500 with an educational discount 

were included. Secondly, only programs which used the Windows interface standard 

were retained. 

Once a short list had been established, the data representation format of the 

program and the platforms offered were ascertained. Five programs were selected in 

which both vector and raster data representation models and PC and Macintosh 

environments were included. The manufacturing companies for the GIS programs 

were then approached. Each company either loaned or donated a copy of their software 

to the Department of Geography at Western Michigan University for use in the study. 

Systematic Evaluation 

The functions and tasks used in the systematic evaluation are described in 

Figure 11. Every effort was made to determine whether a program could perform each 

task, including care(ul study of the available manuals and on-line help. Non-standard 

terminology made this task difficult. Each software company's technical support 

service was used as the final confirmation if a function did not appear to be supported 

from the printed manual or on-line help service. 

The tasks were performed on each of the selected GIS programs. As each task 

was accomplished the number of actions needed to implement the operation was 

counted. Each task was repeated at least once to ensure accuracy. The decision rules 

which were followed are shown in Table 9. 
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,----------- -- - ----------------- -�71

BASIC GIS FUNCTIONS AND TASKS FOR SYSTEMATIC EVALUATION 

1. SINGLE MAP MANIPULATION:

( 1) Map Retrieval-displays a map layer.

Task: Display Thornapple Township landuse map.

(2) Zoom-changes the scale of a display.

Task: Change the scale of landuse map display.

(3) Find point coordinates-finds the x,y coordinates of one map location.

Task: Find the x,y coordinates of one point/pixel on the landuse map.

( 4) Search by Attribute-searches for selected attributes.

Task: Find all the areas of wetland on the landuse map.

(5) Classification-classifies spatial features.

Task: Group landuse categories into agricultural, non-agricultural, urban and

displaying resultant map.

(6) Attribute editing-this could involve changing or adding attribute data.

Task: Change the landuse code of one polygon/contiguous zone on the landuse

data layer.

(7) Rescale-changing units of measurement using a mathematical operator.

Task: Convert the elevation data from feet to meters.

(8) Subset-subsets out a small portion of a map.

Task: Subset the city of Middleville from the landuse map. (If this cannot be

done as a rec.tangle, the appropriate polygons will be selected and clipped.)

2. MEASUREMENT:

( 1) Distance between object pairs-measures distances.

Task: Measure the straight line distance between two points/pixels on a map.

(2) Area of a polygon

Task: Find the area of one landuse polygon/contiguous zone.

(3) Perimeter of a polygon

Task: Find the perimeter of one landuse polygon/contiguous zone.

Figure 11. Basic GIS Functions and Tasks Used in Systematic Evaluation. 
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Figure I I-Continued 

3. LOCATIONAL ANALYSIS:

( 1) Visual overlay-overlays different map layers.

Task: Overlay ELEV A TION and LAKES map layers.

(2) Logical overlay-finds where specific conditions from several data layers

apply.

Task: Find all the residential areas at elevations of less than 740 feet, as these

may be subject to flooding.

(3) Buffer zone generation-creates a buffer zone of specified width around a

point, line, or polygon/zone.

Task: Find all the wetlands within a 500 foot buffer along the Grand Rapids­

Hastings highway.

4. DATA OUTPUT:

( 1) Printed output

Task: In each GIS, a map was constructed of Thornapple Township showing

the elevation, lakes, rivers, roads, and the highway. It was custom colored and

transferred to a layout where a legend, title, and north arrow were added. The

Thornapple River was labeled, where possible parallel to the line of flow. The

resulting layout was then printed on a color ink-jet printer. This multi-faceted

task was also used to evaluate the data output of each GIS.

Figure 11. Basic GIS Functions and Tasks Used in Systematic Evaluation. 

Results 

Initial Selection 

The initial selection of GIS programs resulted in identification of five GIS 

programs which met the criteria of costing less than $500 and following the Windows 
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Table 9 

Decision"Rules for Systematic Evaluation 

Action 

Single or double mouse click. 

Opening and selecting an item on drop down menu. 

Completion of each dialogue or script box. 

If more than one method of completing a task was known, the shortest 

one was used. 

Count 

1 

1 

1 

NA 

All required maps were assumed to be in the appropriate form and NA 

displayed on the screen if necessary, before a task was executed. 

NA-Not Applicable 

interface standard. Three were vector-based and two raster-based. Details of these 

programs are shown in Table 10-. 

The costs quoted are for a single student copy of the software and reflect the 

reductions which �any companies customarily give for educational purposes. Two of 

the programs, ArcView and Maplnfo, are available for both PC and Macintosh 

environments. As can be seen in Table 10, the minimum hardware requirements vary 

widely between the five programs. It should be stressed, as each manufacturer does in 

the documentation, these are very much minimum values. Problems were experienced 

running all the programs, except Map Factory, on machines with 8 Megabytes (MB) of 

Random Access Memory (RAM). Some programs ran very slowly, e.g., ArcView, 

and some were unable to perform certain tasks, e.g., Maplnfo and Maptitude. For the 

purposes of the systematic evaluation, both the PC and the Macintosh machines used 
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Table 10 

General Information on Selected GIS Programs as Determined in 1996 

INFORMATION PROGRAMS 

ArcView IDRIS! Map Fty Maplnfo Maptitude 
v. 2.l a V. 1.0 V. 1.0 V. 4.0 v.3.0

Cost per single student copy $250 $248 $250 $349 $395 

PLATFORM 

PC ✓ ✓ ✓ ✓ 

MAC ✓ ✓ ✓ 

Workstation ✓ ✓ ✓ 

HARDWARE REQUIREMENTS minimums 

Hard disk capacity (MB) 25 1 / 132 10 1.1 4 1 / 4.52 16 

RAM(MB) 12 1 / 82 4 1.5 8 1 / 42 8 

DATA REPRESENTATION 

Raster only ✓ 

Raster/display vector ✓ 

Vector/ display raster ✓ ✓ ✓ 

DATA ENTRY 

Tablet digitizing ✓ ✓ ✓ 

Scanned maps ✓ ✓ ✓ ✓ ✓



www.manaraa.com

Table IO-Continued 

INFORMATION 

Screen digitizing 

Common data formats 

REGISTRATION 

By relative position 

By absolute position 

PRINTER COMPATIBILITY 

Ink-jet 

Laser 

TUTORIAL 

Hardcopy 

On-line 

Macintosh 
2 PC 
3 Arclnfo only 
✓ Available
MB Megabytes 

ArcView 
v. 2. l a

✓ 

✓3 

✓ 

✓ 

✓ 

✓ 

✓ 

RAM Random Access Memory 

PROGRAMS 

IDRIS! Map Fty Maplnfo 
V. 1.0 V. 1.0 V. 4.0

✓ ✓ ✓ 

✓ ✓ ✓ 

✓ 

✓ ✓ ✓ 

✓ ✓ ✓ 

✓ ✓ ✓ 

✓ ✓ ✓ 

Arc View, Environmental Systems Research Institute Inc., Redlands, CA. 
IDRISI, Clark University, Worcester, MA. 
Map Fty: Map Factory , ThinkSpace Inc., London, Ontario, Canada. 
Maplnfo, Maplnfo Corp., Troy, NY. 
Maptitude, Caliper Corporation, Newton, MA. 
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Maptitude 
v.3.0

✓ 

✓ 

✓ 

✓ 

✓

✓ 
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were upgraded to 24MB of RAM, after which all the selected programs ran swiftly and 

well. 

The GIS identified reflect both types of data representation, raster and vector. 

All the programs, except Map Factory which is a purely raster system, could display 

both types, though none could query and analyze more than one type. One of the most 

important considerations in GIS selection is data entry: All the programs can import a 

variety of common data formats, accept ArcView which only accepts Arclnfo 

coverages. IDRISI, Maplnfo, and Maptitude support tablet digitizing, while all the 

programs provide for some screen digitization. To allow for accurate overlay of data 

layers, the maps should be registered to a coordinate system. In ArcView, the Arc 

coverages (Arclnfo files) already contain coordinate files. Map Factory, Mapinfo, and 

Maptitude also allow for absolute registration to a number of coordinate systems. 

IDRISI, while supporting absolute registration, also has the provision for relative 

registration in which one map layer is registered to another map. This can allow for the 

correction of some map distortions. Output is very important in an educational setting, 

since the student will wish to display the fruits of his/her efforts. No program 

suggested the use of _a dot matrix printer. Indeed maps printed by such printers are 

very unsatisfactory representations of the computer screen graphics. By comparison, 

ink-jet and laser printers produce accurate and attractive results, particularly in color. 

The final informational detail collected was on the type and quality of tutorial support 

with the GIS. All, except ArcView, provided comprehensive tutorials in hardcopy. 

ArcView's tutorial called Quick Start includes a few very basic instructions on 

operating the program. 

Systematic Evaluation 

Four of the programs identified in the initial selection procedure were chosen 
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for the systematic evaluation. These were: ArcView, IDRISI, Map Factory, and 

Maplnfo. Maptitude was eliminated for a number of reasons. The close similarity of 

Maptitude and Maplnfo would have produced some redundancy if both programs had 

been included in the evaluation. Maptitude was slightly more expensive and required 

more RAM than Maplnfo to operate successfully. Further, much more difficulty was 

experienced in data entry and program operation with Maptitude. Maplnfo had the 

added advantage of being available for both PC and Macintosh environments. For 

these combined reasons Maplnfo was chosen for evaluation. Arc View was used on a 

Macintosh and Maplnfo on a PC. IDRISI (PC) and Map Factory (MAC) were platform 

specific. The PC programs were Windows versions run on Microsoft Windows 

version 3 .1. The Thornapple data set was loaded into each of these software programs. 

The four selected computerized GIS and the Manual GIS were systematically 

evaluated. The number of actions required to complete each of the predetermined tasks 

was recorded as shown in Table 11. These data were totaled for each of the principal 

categories of functions. The totals for the four categories are shown in Figure 12. 

All the selected programs easily performed the basic single map manipulation 

operations of map r�trieval, zoom, and locating point coordinates. Similarly searching 

by attribute was universally easy to accomplish, in raster systems with straight forward 

recoding and in vector systems by query scripts. However, the remaining map 

manipulation operations were accomplished with varying degrees of difficulty. 

Maplnfo performed all the map manipulation tasks with the fewest actions. 

Map measurement is also a common aspect of map processing. The vector 

programs, because of their data structure, readily provide polygon area and perimeter 

measurements. This process is more complex in the raster model, particularly with 

IDRISI. Perimeter measurements were not available in Map Factory. A student armed 

with a pencil, length of string, ruler, and fine grid overlay could perform each of these 
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Table 11 

Results of the Systematic Evaluation 

TASKS ArcView IDRIS! Map Maplnfo Manual 
Factory 

Map retrieval 1 2 1 2 1 

Zoom 2 2 1 2 NA 

Find point coordinates 1 1 2 1 2 

Search by attribute 3 4 3 3 109 

Classification 14 4 3 4 1094 

Attribute editing 8 4 11 3 2 

Rescale 6 4 3 2 30 

Subset 7 6 3 3 35 

Map manipulations-Totals 42 27 27 20 1273 

Distance btwn object pairs 2 16 3 3 1 

Area of polygon 2 10 3 2 3 

Perimeter of polygon 2 10 NA 2 2 

Measurement-Totals 6 36 6 7 6 

Visual overlay 1 4 3 2 1 

Logical overlay 7 8 3 15 51 

Buffer zone generation 6 10 6 14 35 

Locational analysis-Totals 14 22 12 31 87 
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Table 11-Continued 

TASKS ArcView IDRIS! Map Maplnfo Manual 
Factory 

Layout window 3 2 1 2 NA 

Map annotation 2 3 2 2 1 

Feature labels 3 15 2 5 1 

Color 4 5 3 5 486 

Lines styles 4 5 3 5 198 

Standard graphic symbols 2 2 1 3 1 

Map printing 2 2 2 2 NA 

Data output-Totals 20 34 14 24 687 

Totals of all functions 82 119 59 82 2053 

NA-Not Applicable 

tasks on a hardcopy map with relative ease. 

Another critical function of GIS is locational analysis. Vector systems perform 

the visual overlay of two or more map layers most easily, rivaling a manual system. 

Arc View was especially straight forward requiring a mere click of the mouse and, since 

alignment is automatic, less time consuming than even a manual system. Raster 

systems require more thought as coding is important in overlay, sometimes requiring 

recoding of one or more layers prior to overlay if all map objects are to remain visible 

and distinguishable. Logical overlay and buffer zone generation functions evaluate the 

characteristics of the area from more than one data layer and are the investigations in 

which computers excel. Performing any of these tasks manually is extremely tedious, 
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Figure 12. Number of Actions Required to Perform Principal Function Categories. 

often unsatisfactory, and certainly of little educational value in relation to time required 

to complete the exercise. Map Factory performed the three types of locational analysis 

most easily. 

All the computerized GIS have some provision for hardcopy data output. The 

output performance using color ink-jet printers was compared in this trial. Color inkjet 

printers are much less expensive than lasers, costing around $300, and they produced 

very acceptable results. The output maps are shown in Appendix D. Map Factory 
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required the fewest actions to produce the specified map. 

The GIS programs were ranked from 1 to 5 (with 1 requiring the lowest 

number of actions) for ease-of-use for these operations. These rankings are shown in 

Table 12. 

Table 12 

Ranking of Selected GIS for Ease of Operation on Specified Tasks 

TASKS 

Map manipulations 

Measurement 

Location analysis 

Data output 

Overall Ranking 

1 = Easiest to use. 

ArcView IDRIS! 

4 2 

1 5 

2 3 

2 4 

2 4 

Map Maplnfo 
Factory 

2 1 

1 4 

1 4 

1 3 

1 2 

Manual 

5 

1 

5 

5 

5 

The Manual GIS ranked last in the majority of the group functions. Of the 

computerized programs Map Factory required fewest actions to complete the prescribed 

tasks and was deemed the easiest to use. 

Discussion 

Initial Selection 

The two selection criteria of Windows interface standard and low cost swiftly 

reduced the number of GIS programs under consideration. Maplnfo and Maptitude 
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appeared very similar in mode of operation and in screen appearance. These are both 

desk-top mapping programs directed at the business market. The third vector-based 

program, Arc View, had quite different screen graphics and operational interface. It has 

very limited data entry and analytical procedures, as it was developed primarily as a 

simple desk-top module to display and manipulate Arclnfo data. All the vector 

programs can display, but not process raster data.· The two raster-based systems 

selected were originally developed for educational purposes and since they emphasize 

cartographic modeling provide much greater analytical capabilities. IDRISI is the more 

sophisticated of the two. Map Factory has a very simple, intuitive interface where 

refreshingly a map is a map, not a theme or a table or an image! It uses a straight 

forward scripting language based on Tomlin's map algebra to perform most of the 

analytical and manipulation functions (Tomlin, 1990). IDRISI, on the other hand, 

makes extensive use of dialogue boxes, but requires a much greater knowledge of data 

structure and representation. ID RISI can also display, but not analyze, vector data. 

There were considerable variations in documentation provided with the GIS 

programs. Arc View came with almost no documentation beyond how to install and 

start the program. A book called Getting to Know ArcView (1996) provides effective 

documentation for the program. Mapinfo and Maptitude had single instructional 

volumes which included some tutorial materials. Map Factory had three volumes, one 

of which was entirely devoted to a tutorial. IDRISI also provided extensive 

documentation and a useful and effective tutorial. Unfortunately, there was no index 

with IDRISI which was extremely frustrating when searching for a particular function. 

It is worth bearing in mind that many teachers will not be prepared to spend much time 

trying to find out how to execute an operation. If a function cannot be easily found, the 

program will be deemed deficient. It is beholden on the software companies to provide 

comprehensive and intelligible manuals with indices and effective tutorials particularly 
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for educational products. 

Decisions on software purchase are seldom based on purely educational 

considerations. Cost and platform availability can bias a choice. GIS is expensive as 

the programs are complex, but with educational discounts these programs can be 

affordable. Two of the GIS tested here are available for both Macintosh and PC 

environments, removing this constraint from the decision equation. However, the 

computer memory requirements of these programs are considerable and an important 

consideration in a school settling. A slow running program seriously detracts from the 

educational value of a GIS. The student must be held on task if educational objectives 

are to be met and a slow program can only result in at best, frustration and at worst, 

inattention. Introducing GIS can, therefore, require considerable capital expenditure, if 

fast, powerful machines are required and are not already available within the school. 

Only Map Factory could run with as little as 1.5 MB RAM and minimum hard disk 

capacity of 1.1 MB. 

The choice of type of data representation is difficult, as each has distinct 

advantages and disadvantages. Although no attempt was made in the systematic ease­

of-use assessment to compare the results of the specified tasks, there were considerable 

differences in output. The raster systems could also perform many more types of 

analysis than the vector systems. 

Data entry is always a thorny issue in GIS. The most time consuming and 

frustrating part of this entire project was data entry. The map layers were already in 

digital format and merely had to be imported into the selected programs. 

Unfortunately, the lists of supported file formats in a program's documentation were no 

guarantee the data would be easy to import. Often "GIS experts" were able to offer 

little more guidance than to try another method. The alternative is the digitizing of data. 

Two of the selected GIS, IDRIS! and Maplnfo, have digitizing modules, as well as 
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allowing for the scanning and screen digitizing of data. Map Factory and Arc View 

support the latter method only. Therefore, it is readily apparent that pre-built databases 

in an appropriate format are an absolute necessity for widespread use of GIS in high 

schools, since the busy teacher is unlikely to be willing to digitize data except perhaps 

for small student projects, nor spend many frustrating hours converting data. 

Systematic Evaluation 

It is important to note at the outset this systematic trial was not intended to be 

definitive. Many of the tasks, particularly the multi-faceted operations, could be 

accomplished in several different ways, all producing different action counts. All 

programs were new to the researcher at the beginning of this project. Therefore, any 

differences in her ability to use the programs was a direct reflection of the ease-of-use 

and quality of documentation of the program. An expert in each program could 

produce different results. Teachers will rarely have the benefit of such expertise. 

Therefore, the objective of the research was to simulate to some extent a classroom 

setting, demonstrating what one individual new to a program could realistically 

accomplish using some GIS knowledge and the documentation provided. 

There were fundamental differences in the mode of operation of individual 

programs. IDRISI tended to require more actions per task because maps are not 

automatically displayed upon the completion of an operation, as occurs in the other 

GIS. The display launcher module has to be employed and a dialogue box completed 

whenever a map is portrayed on screen. For instance, to display a map in custom 

colors with a legend in IDRISI requires the opening of the dialogue box and the 

entering of five pieces of information. This was counted as only two actions in this 

research. By comparison, in ArcView and Map Factory, the same task requires a 

single click of the mouse. This was counted a one action, but it is obviously more than 
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twice as fast as the IDRISI procedure. Two other drawbacks with IDRISI are 

measurement, which was circuitous and tedious, and map data output which has limited 

flexibility and was difficult to execute. 

The second raster-based program, Map Factory, was the simplest to use in 3 of 

the 4 function groups as well as overall. Map display is simple, requiring a click of the 

mouse on the map name in the project box. Most functions are executed by typing a 

script or choosing the words from scrolling menus in a dialogue box. This counted as 

two actions, but a third action was always incurred, since it was necessary to return to 

the main menu to execute the operation. 

Both vector systems performed some operations very easily, particularly map 

display and visual overlay, but they. have much more limited range of analytical 

functions. Arc View was ranked first or second in 3 of the 4 function groups. Arc View 

performed many tasks very easily, while a few required more complex procedures. 

For example, ArcView has no provision for designating custom categories for 

choropleth mapping which would permit the rapid visual classification of spatial 

features. 

Finally, Maplnfo ranked first in one of the individual function groups and 

second overall along with ArcView. Many of its functions are performed relatively 

easily, particularly the single map manipulations. Its analytical capabilities, however, 

are limited and the execution procedures quite complex. 

Although it is clearly impossible to select one program which is easier to use in 

every function, Map Factory, a raster-based program for the Macintosh was the easiest 

to use overall. In the vector-based programs both Arc View and Mapinfo were equally 

easy to use overall. 

85 



www.manaraa.com

CHAPTER V 

A STUDENT EVALUATION OF SELECTED 
GEOGRAPHIC INFORMATION SYSTEMS 

Introduction 

The initial selection procedure and systematic evaluation were designed to select 

the Geographic Information Systems which met the criteria of low cost and ease-of­

use, as defined in the previous chapter. However, neither of these methods 

accommodated personal preference. Each GIS program uses a very different interface, 

some of which appeared more intuitive and user-friendly than others. Therefore, it was 

determined to ask high school students to evaluate the selected GIS programs against 

several criteria. This was the third part of the software evaluation in response to the 

fourth research question: 

4. Which GIS programs are most suitable for use in high school education?

Research Design 

In this selection procedure, it was determined to ask students which program 

they preferred. The Human Subjects Institutional Review Board (HSIRB) of Western 

Michigan University requires all research projects involving human subjects be 

submitted for review by the board. Strict regulations govern the writing of the 

experimental protocols and recruitment of volunteers, particularly of minors. 

Therefore, the research design for the student evaluation of the software was carefully 

structured to follow the requirements and recommendations of the Review Board. 

The GIS laboratory at Western Michigan University was chosen as the site for 
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the evaluation because of the special hardware requirements. Students were invited to 

attend the University on a Saturday morning, so the study would not interfere with their 

regular schooling. Letters for student assent and parental consent were drafted, along 

with an explanatory cover letter for parents. These letters and the experimental 

protocols were submitted to the HSIRB and received approval under the exempt 

category of review (Appendix E). 

Four GIS programs were selected for this evaluation. To ensure an equal 

representation of the two data models, two raster-based programs and two vector-based 

programs were chosen. Not all the programs were available for both PC and 

Macintosh platforms and since some schools favor one platform over the other, it was 

decided to include both types in the test. Raster and vector programs were selected for 

both the PC and the Macintosh. The Manual GIS was included to allow for 

comparison with the electronic forms, since some GIS educators believe this is the 

most appropriate form of GIS at the K-12 level. 

The five GIS programs (four computerized and one manual) were loaded with 

the same data set. A local data set was chosen so the students would be able to relate 

more easily to the research questions posed in the evaluation. A geographical concept 

was chosen for the students to investigate using GIS. This was selected from the 

geography strand of the Michigan Framework for Social Studies Education (Michigan 

Department of Education, 1995). Two authentic problems were developed to explore 

this concept and the students performed the same two problem solving exercises on 

each of the GIS in turn. 

The choice of which spatial analysis procedure to select proved quite difficult, 

since the GIS vary considerably in the types of analysis they can perform, how difficult 

they are to execute, and in the results which they produce. There was a conscious 

effort to select procedures which did not favor one GIS over another in their ease of 

87 



www.manaraa.com

operation or the quality of the results. An initial decision to use a polygon within 

polygon analysis had to be abandoned because the vector-based programs either could 

not perform the procedure or produced results which were unacceptable. For example, 

the problem initially proposed was to identify which types of landuse are found within 

the flood zone of the principal river system as this might impact insurance rates in the 

area. Two data layers were to be used, one of the landuse and the other of the flood 

zone. One of the vector-based programs achieved this polygon within polygon analysis 

by highlighting all the landuse polygons which in some part fell within the flood zone 

polygon. The landuse layer contained over a thousand polygons, however, most of the 

land area was cropland which was displayed as one continuous polygon with numerous 

other landuse polygons within it. In the analysis the cropland polygon was selected, 

resulting in most of the map appearing highlighted even though the flood zone was 

quite small. Using an alternative offered by the program to show only those polygons 

which were completely contained within the flood zone, almost no polygons were 

highlighted because the flood zone was a narrow feature. Neither result was 

considered suitable for a study in which students would have limited time to interpret 

the results. 

The two exercises finally chosen involved visual overlay operations and a 

spatial analysis involving buffer zones. These were selected because they were 

procedures used frequently in spatial data analysis, ones which each of the programs 

could perform reasonably well, and which were thought to be most applicable to 

geography education in the high school setting. Since there would be insufficient time 

for the students to become proficient users of each program, detailed instructions were 

written for the individual exercises on each GIS. 

At the end of the evaluation the students were given a questionnaire in which 

they were asked to compare all five GIS. To ensure the students could differentiate 

88 



www.manaraa.com

between the programs they tested, they were supplied with the proprietary names and 

the programs were also color coded and the .machines upon which they were operated 

were marked with an appropriately colored card. The students made extensive use of 

this color coding system. 

Each student evaluation session was restricted to a maximum of 10 students, 

who worked in groups of two. This. limitation was the result of only two Power 

Macintosh computers being available. It was, therefore, decided to run two sessions in 

order to increase the sample size to a maximum of twenty. The recruitment of student 

volunteers was limited to those with computer skills, since the students were required 

to give their considered opinions on the various GIS programs and it was important 

their judgment was not influenced by an inability to operate the hardware. In light of 

this, it was decided to recruit one set of volunteers from the Kalamazoo Area Math and 

Science Center (KAMSC), a magnet school which draws pupils from 15 area high 

schools. The KAMSC students are selected by examination and teacher 

recommendation and attend the school for half of the school day, returning to their area 

high schools for the rest of the curriculum. The students do not study social studies at 

KAMSC, but do take those courses in their home schools. They have required 

computer skills classes in the first two years at the Center. It was recognized these 

student were not representative of the general student body, but their computer and 

analytical skills were thought to be beneficial to the project. 

The second group was recruited from Loy Norrix High School, one of the two 

high schools in Kalamazoo. The students here study social studies, but geography is 

an elective course. The approved experimental protocols and details of the study were 

submitted to KAMSC and Loy Norrix when the researcher requested permission to 

make a short presentation and recruit volunteers for the study. 
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Materials 

Two data sets were prepared, one for the demonstration to recruit student 

volunteers and another for the systematic evaluation and for the student evaluation. 

Recruitment Demonstration 

A Michigan raster-based data set was prepared for the demonstration. This was 

chosen because students would be able to more easily relate to problems in their home 

state. This data set is in the public domain and was available within the Geography 

Department of Western Michigan University in ERDAS format. Each image is geo­

referenced to the UTM coordinate system, has cell resolution of 1 kilometer, and a file 

size of 733 rows and 633 columns containing 4 or 8 bit data. The seven map layers of 

Michigan selected are described in Table 13. 

Three fictitious problem scenarios were selected to demonstrate the use of GIS 

(Appendix F). The procedures for solving these problems could not be demonstrated 

in real time as this would take too long. Consequently, maps illustrating various stages 

of the resultant analysis were prepared using IDRIS!. These were imported into 

Arc View for the Macintosh. Arc View was chosen because of its ease of display and 

visual overlay. Here, with the judicious use of color and transparent backgrounds, it 

was possible to visually overlay the map layers to simulate the problem solving process 

in a matter of minutes, for each of the scenarios. Since no computer display was 

available at Loy Norrix High School, the maps were transferred to overhead 

transparencies, for the demonstration. 
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Map Layer 

MIBOUND 

MICOVER 

MIFOREST 

CTYROADS 

WATER 

ADMIN 

CITIES 

Table 13 

Demonstration Data Set 

Description and Source Map (if known) 

Boundary outline of State of Michigan 

Land cover/use 

Major forest associations (USFS '83) 

County roads (USGS 1 :500,000) 

Number of Classes 

2 

10 

9 

2 

Lakes, rivers, and streams. (USGS Hydro) 4 

Administrative boundaries of national and 

state parks, recreational areas, and military 

lands etc. (Michigan State Forest map) 

Major cities 

11 

2 

USFS-United States Forest Service. 
USGS-United States Geological Survey. 

Student Evaluation 

Data Set 

A local data set was chosen in order to demonstrate to the students that GIS is 

applicable to their lives and neighborhoods. Unfortunately no data set for Kalamazoo 

was readily available, therefore, a data set for Thornapple Township in Barry County, 

approximately thirty miles north northeast of Kalamazoo, was selected. It consisted of 

six map layers, as shown in Table 8. The preparation of this data set for importation 

into the four selected computerized GIS is described in Appendix A. 

91 



www.manaraa.com

Exercises 

Two exercises were developed for student evaluation. The geographical 

concept chosen for investigation was: Human and Environmental Interaction (Content 

Standard 2.2, Geography Perspective of Michigan Framework for Social Studies 

Education). In the first exercise visual overlay was used to explore the way in which 

the environment affected the rectangular survey system in Thornapple Township. The 

research question posed was: "How did the environment affect the rectangular survey 

in Thornapple Township?" The exercise began with an explanation of the concept and 

of the rectangular survey. Four map layers were used in this exercise; ELEVATION, 

LAKES, RIVERS, and ROADS. The second exercise involved looking at the concept 

from the opposite perspective of how people impact the environment. The research 

question posed was: "Are urban developments encroaching on wetlands in Thornapple 

Township?" Three map layers were used in this exercise; LANDUSE, ROADS, and 

HIGHWAY. Spatial analysis utilizing buffer zones and visual overlay were used to 

address this question. Detailed instructions were developed to guide the students step­

by-step through the exercises. Questions were placed throughout the directions to 

encourage the students to examine the maps carefully at each stage of the analysis. 

Each set of instructions was designed to be as similar as possible, varying only where 

operational differences occurred in the software. Five evaluation questions were 

constructed for inclusion at the end of each set of exercises. These asked what the 

student liked and disliked about the program's performance on Exercise 1 and Exercise 

2, and how well it defined the results of the analysis. An example of a set of 

instructions can be found in Appendix G. 
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Questionnaire 

A questionnaire was prepared for the students to complete at the end of the 

session. It requested general personal details and required the students to rank the five 

GIS on nine criteria. These criteria were selected as those which high school students 

may consider important. Finally, three questions were included to discover what the 

students felt about GIS in general and whether it was the type of software they would 

like to use in high school (Appendix G). 

Methodology 

Student Volunteer Recruitment 

The first group of volunteers for the student evaluation were recruited from 

KAMSC. Three presentations were given to the freshman and sophomore classes at 

the Center, a total of 150 students. The address began with a brief description of GIS 

and its uses. This was followed by a computerized demonstration of GIS using the 

Michigan data set (Appendix F). Finally, the student's role in the evaluation of GIS 

software was carefully explained, as well as the location and date of the study, and the 

time involved. The procedure for volunteering was then outlined along with the 

importance of the assent and consent letters. Interested students volunteered to 

participate by informing their teachers after the presentation and receiving all the 

necessary documents. Three days prior to the study the completed assent and consent 

letters were collected from the schools and campus maps and directions given to the 

student volunteers. 

The second group of student volunteers was recruited from Loy Norrix High 

School. Difficulty was experienced in finding a sufficient number of students willing 

to volunteer at KAMSC. As a result, it was determined to approach the Honors Society 
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at Loy Norrix, as this is a group of over fifty students with a strong commitment to 

community volunteerism. These students were also more representative of the full 

grade range of the school and could be expected to possess the necessary computer and 

analytical skills. The researcher was given the opportunity to briefly address this group 

at the beginning of one of their monthly meetings. The presentation followed the same 

format as the one use at KAMSC,. except the maps were displayed on an overhead 

projector instead of a computer. 

Pilot Student Evaluation Study 

The materials for the student evaluation were pilot tested by two freshmen 

college students. The instructions for conducting the two exercises on each of the 

individual GIS were found to be accurate and detailed enough for the students to 

operate the programs largely unaided. The students' principal complaint was that 

boredom set in when they were confronted with the same questions on each set of 

directions and they tended to ignore them and hence not study the maps carefully. In 

light of this, the instructions were redesigned. It was decided the risk of unfairly 

influencing a student's perception of a program by asking different questions was 

greatly outweighed by the negative aspects of boredom distracting the student attention 

from the exercises and evaluation process. Therefore, one set of instructions was 

constructed for each GIS program containing identical introductions to the concepts, 

linking and explanatory statements, and questions. These would be used at the 

beginning of the evaluation session. Then a second set of instructions was developed 

for each GIS, in which much of the introductory and explanatory materials were 

removed, except for those referring to the operation of the software. New questions 

were inserted, such that each set of instructions contained different questions. This 

resulted in each student starting the evaluation session using identical instructions, 
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except for variations in operating directions. After which, with each new GIS the 

student was confronted by different questions and no repetition of ancillary materials. 

An example of a second set of instructions can be found in Appendix G. 

Student Evaluation Study 

The two student sessions were conducted in exactly the same manner on 

different Saturdays. Each session lasted about six hours. The first session consisted 

of seven KAMSC ninth grade students, the second of nine Loy Norrix eleventh and 

twelfth grade students. 

Two Power Macintoshes, one with 16MB RAM and the other with 24MB Ram, 

and two Pentium PC computers each with 32MB RAM were used in the study. One 

selected GIS program was loaded into each of the computers, which was color coded 

appropriately (Table 14). The Thornapple data set was entered into each program and 

assembled into the two exercises. 

Type of Computer 

Pentium PC 

Pentium PC 

Power MAC 

Power MAC 

Table 14 

GIS Programs and Computer Allocation 

GIS Program 

IDRIS! 

Maplnfo 

ArcView 

Map Factory 

Color Coding 

Green 

Yellow 

Blue 

Red 

Each session began with a brief introduction to GIS. In order to explain the 

differences between raster and vector-based file structures, the students were provided 
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with a simplified map on which they practiced the different methods of spatial and 

attribute data encoding (Appendix G). The procedures for the evaluation were carefully 

explained. The location of the data set was demonstrated on a black and white satellite 

image of Michigan. The students were then given the questionnaire which they were to 

fill out upon completion of the session and its contents were explained. 

The students were asked to work in pairs and encouraged to rotate between the 

roles of instruction reader and mouse operator. Since there were an odd number of 

students in both sessions, one elected to work on her own. This proved unsatisfactory, 

as without a partner to share the reading of the instructions and debate the answers to 

the questions progress was slow and errors were more frequently made. Therefore, in 

each session the student was offered the services of an adult, unversed in GIS, to read 

the exercises to her, which she accepted. On one of the computer rotations in Session 

1, the student worked with another group, as only one program upon which they had 

not worked was available. 

Each group drew lots to determine on which program to begin, since the 

sequence in which the programs were used may influence student preferences. 

Students recorded when they began and finished using each GIS, so it would be 

possible to determine the time spent on each program and the sequence in which they 

were used. Plans to orchestrate the moves from raster to vector or vice versa proved 

impractical as students worked at different rates and some programs took longer to run 

than others. Therefore, once a group finished it moved on to the next available 

computer. Help on operating the programs was only provided when it was requested. 

When a group completed the two exercises on a GIS, each student answered five 

evaluation questions. Upon completion of the entire session, each student individually 

completed the final questionnaire. Copies of printed data output from each program 

were made available. 
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· Results

There were three ways in which the students responded during the evaluation. 

They answered exercise questions, evaluated individual GIS, and comparative ranked 

the programs. The results will be described within this framework. Owing to the small 

sample size and the subjective and nominal form of the data collected, statistical 

analysis of the data was limited to analysis of percentages and proportions in multi­

dimensional contingency tables, without reference to differential statistics. With no 

prior knowledge of the pattern of the relationships between variables, an exploratory 

technique called Determinacy Analysis v. 3.0 (Chesnokov, 1982, Zaslavsky, 1995, 

Software available from Context, Ltd., Moscow, 1992) was used to assess the 

relationships between variables. 

Exercise Questions 

The questions embedded within each exercise were not designed to measure 

comparative differences in the learning of geographic concepts with individual GIS and 

none were detected. The students' ability to analyze the maps they produced did not 

appear to be affected by which GIS they were using. Nevertheless, from the nature of 

some of the responses, a universal lack of geographic education was discernible. 

Evaluation of Individual GIS 

Upon completing work on an individual GIS, the students were asked what 

they liked and disliked about the way the program performed the visual overlays in 

Exercise 1 and the analysis in Exercise 2. They were also asked how well the GIS 

defined the results of the analysis by showing the urban areas which may be 

endangering wetlands. The student responses are summarized for each GIS. 
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ArcView 

All sixteen (100%) students thought ArcView performed visual overlays easily. 

Fifty-six percent disliked having to rearrange the Table of Contents to control the order 

in which the maps are drawn, _but 6% liked this feature. Ninety-three percent of the 

students thought the analysis was easy to perform, though 19% qualified this with 

comments such as, "I wouldn't have a clue what to do or how to do it without the 

specific instructions," and "It could be screwed up very easily." Forty-four percent 

thought the analysis was tedious or there were too many intermediate steps. Thirty-one 

percent thought Arc View defined the results of the analysis well, while 50% thought 

the buffer zones should be shown or that only the part of the polygon within the buffer 

should be highlighted, as one student expressed it "(it) showed all the urban areas 

affected, not where or by how much." Twelve percent particularly liked the graphics 

and 6% liked the way the unnecessary areas were deleted from the final map. 

IDRISI 

Eighty-one percent of the students thought IDRISI performed visual overlays 

easily, 12% did not like it at all and 69% thought it repetitive, complicated, or time 

consuming. On the analysis there were very mixed responses, 12% found nothing to 

like about it, while 25% found nothing to dislike about it as it was effective and "did the 

job." One student wrote, "I don't know how an independent researcher without step­

by-step instructions would fare in the raster/vector environment." Twelve percent liked 

the Map Composer menu for vector overlay, and 6% liked the way maps were created 

at each stage, while a further 6% like the fact the steps were repeated and the commands 

easy to understand. However, 31 % thought there were too many dialogue boxes and 

6% wanted the maps to automatically display. Sixty-nine percent thought IDRISI 
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defined the urban areas clearly and concisely, though 19% did not think the graphics 

were good or thought they were "blobby." Twelve percent thought the buffer zones 

should be shown or did not like the fact the buffer zones were twenty feet too narrow 

because of cell resolution. Other individual positive comments on IDRIS! included: 

"liking the clear images; finding the legend simple to follow; and liking the way the 

maps opened at a good size." 

Map Factory 

In the first Exercise, 56% of the students thought Map Factory performed visual 

overlays easily, 12% thought "it showed everything neatly and organized," and 19% 

liked the way all the maps were visible at each stage. Thirty-one percent disliked the 

scripts, although 6% thought they were easy to understand, and a further 12% thought 

the coding was confusing and required a written description. In the analysis 44% 

thought it performed well, 50% disliked constructing the scripts, 25% did not like 

having to enlarge each new map, and 12% disliked the initial lack of color. Eighty­

seven percent thought Map Factory defined the urban areas well, though 12% disliked 

the 20 foot inaccuracYcaused by the limitation of cell resolution. Other individual 

comments included: "the white background made the maps clearer; the tool bar was 

good particularly the numeric magnifying glass; the colors were easy to control; there 

were too many intermediate steps; and querying is not as clearly defined as with 

IDRIS!." 

Maplnfo 

Fifty-six percent of the students thought Maplnfo performed visual overlays 

easily, though 37% thought it was tricky. Nineteen percent liked the tool bar, but they 

did not like having to return to the select tool after using another tool, and 25% liked the 
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information box. In the analysis, 75% thought Mapinfo performed well, they 

particularly liked being able to see the buffer zones, though 44% thought the analysis 

was difficult to execute. Sixty-nine percent thought it defined the urban areas well, 

although 19% recognized some of the polygons were not shown. Individual comments 

included: "a lack of clarity of the graphics necessitated the repeated use of the zoom 

function; the terminology is unnecessarily confusing; and the cosmetic layer was 

somewhat mysterious." Several students had problems resizing the map window and 

others lost a map when trying to select it. 

Manual 
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Everyone thought visual overlays were easy with the manual GIS and 31 % 

thought it was easier and took less time than the computer GIS. Even so, 44% had 

problems aligning the map layers. Sixty-two percent thought the analysis was easy to 

perform, though 50% were concerned about accuracy, and 62% thought it was too time 

consuming compared to the computer analysis. Ninety-four percent did not think the 

manual GIS defined the urban areas well, because of human error, the thickness of the 

markers, the tendency for the markers to smear, and problems identifying features on 

the maps. Other individual comments included: "I am in control, not some machine;" 

"It's easy to physically touch and move the map;" "it took .. .less know how to perform 

Exercise 1 ;" "there were no (error-43) complications to worry about;" "You couldn't 

experiment with them;" and "(you) have fewer options on how to manipulate data on 

the maps." 

Comparative Evaluation 

In the comparative evaluation, 65 variables were observed for each of the 16 

students who participated. These were categorized into four types; personal 
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information, the time on task, sequence in which the GIS were used, and rankings of 

the GIS. The students were also asked for their opinions on GIS and its usefulness in 

the classroom. The results are summarized within this framework. 

Personal Information 

The students were asked to supply personal information on gender, age, and 

grade level and to rate themselves on computer expertise (Table 15). 
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Session 1 consisted of seven 9th grade students, six of whom were 14 and one 

was 15 years old. They were fairly evenly divided by gender. The students worked in 

groups of two and only one group was mixed gender. Session 2 contained six 11th 

and three 12th grade students. Five students were 16 years old, and the remaining four 

were 17 years old. Seven of the students were male. These students also worked in 

groups of two and only one group was mixed gender. The majority of the students in 

Session 1 considered themselves intermediate in computer skills and geographic 

knowledge. The students in Session 2 were more equally spread between advanced 

and intermediate, which may be a reflection of their perceived status within their 

schools. 

Time and Sequence 

The mean and range of time taken to complete the exercises on each program are 

shown in Figure 13. The manual GIS appears to be completed more quickly than the 

others. However, the students were only expected to complete a small portion of the 

analysis as it was recognized that drawing 500 foot buffer zones to scale around 109 

wetlands would be too time consuming for this evaluation (Appendix B). Of the 

computerized GIS, IDRISI, Map Factory, and Maplnfo had mean times of 52 to 53 

minutes. Arc View's mean was 7 minutes less. The vector programs showed the 
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Session 

Session 1 
(7 students) 

Session 2 
(9 students) 

Table 15 

Student Evaluation-Personal Information 

Gender 
Male Female 

43 57 

78 22 

Percentage of Students 

Age (years) 
14 15 16 17 

86 14 

56 44 

Grade 
9 10 11 12 

100 

67 33 

Students' Personal Rating of Their Expertise (%) 

Expert Advanced Inter- Novice No 
(16 students) mediate expenence 

Using a PC 12.5 19 56 12.5 

Using a Macintosh 12.5 75 12.5 

Using new software 25 44 25 6 

Your geographical 6 50 38 6 
knowledge 
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greatest ranges. Of the raster programs IDRIS! was the most consistent, taking 50 to 

55 minutes to complete in 6 out of 8 of the groups which entered a recording. This was 

probably due the large number of dialogue boxes IDRIS! uses. Group S1G4, which 

consistently took longer to complete using each computerized GIS, consisted of two 

males who had difficulty keeping on task. If this group is removed, the maximum time 

taken on each computerized GIS was remarkably consistent, ranging from 55 to 60 

minutes. The minimum times were more varied ranging from 31 to 4 7 minutes, with 
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the vector programs being completed the quickest. 

• Mean

70 : Range

60 

I I 50 

en 

40 
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0 
ArcView IDRISI Map Factory Maplnfo Manual 

Figure 13. Time Taken to Complete Exercises on Selected GIS. 

The time taken to complete the exercises may have been a function not only of 

the individual GIS, but of the sequence in which they were used (Figure 14). As might 

be expected students ( 66%) tended to become more proficient as the session 

progressed, even though each GIS was different they were becoming more familiar 

with the exercises and the GIS process. Time may influence ranking, if time spent 

using a GIS is a measure of its ease-of-use, students may prefer the GIS which 

performed the quickest. In Figure 14, time is plotted with students' rankings of the 

GIS they would most like to use again. There appears to be no correlation between 

time and GIS preference, though this was investigated further using Determinacy 

Analysis (see page 107). 
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Sequence may also influence GIS preference. It was postulated that the 

programs used in the middle of the session may be preferred, because at the beginning 

of the session students were in a new environment struggling with unfamiliar processes 

on new hardware and software. By the end of the session, after six hours of repetitive 

work, tedium may have become a factor. Both these scenarios could influence the 

student's perception of a program. Although some groups reflected such trends, e.g., 

S1G2, others did not, e.g., S2Gl (Figure 14). Determinacy Analysis was used to 

further clarify this relationship (see page 107). 

Ranking of GIS 

104 

The students were asked to rank the GIS for nme criteria, including 

performance on each of the two exercises, ease of operation, intuitiveness, quality of 

screen graphics and hard copy output, most fun to use, and would like to use again 

(Appendix G). These rankings are summarized in Figure 15. 

On Exercise 1 (visual overlay) the students thought Arc View performed the best 

(56%) and the manual the worst (75%). Eighty-one percent rated Map Factory third or 

fourth. They were more divided about IDRISI and Maplnfo, though they had more 

positive views about Maplnfo (76% ranking it second or third compared to 50% for 

IDRISI). On Exercise 2 (analysis) the students were in agreement that the manual GIS 

was the worst (88%), otherwise Maplnfo was marginally preferred to ArcView (38% 

to 31%). The students thought ArcView was the easiest to use (44%) and most 

intuitive (38% ). For quality of screen graphics, Map Factory was the favorite (50% ), 

followed by Maplnfo ( 44% ), while Maplnfo came out on top for quality of hardcopy 

( 46% ). The students did not feel any of the GIS aided their understanding of 

geographic concepts more than another. Maplnfo was considered most fun to use 

(38% ), followed closely by Arc View (31 % ) and ID RISI (31 % ). However, the 
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Figure 14. Sequence of Use, Time Taken, and Ranking of Selected GIS by Group. 
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students wished to used IDRIS! (38%) and Maplnfo (38%) again. 

Overall ArcView received 48 first rankings (out of a possible 144) closely 

followed by Maplnfo with 45 (Figure 16), although Maplnfo had fewer fourth and fifth 

place rankings. Students had very varied views about IDRISI, all five rankings were 

given with similar frequency (range of 23 to 36). Map Factory was repeatedly given 

middle to low rankings and the manual GIS was frequently relegated to fifth rank 

(82 /144). Comparing overall incidence of ranking and students' choice of the GIS 

they would like to use again, the students chose ID RISI and Maplnfo equally (38%) as 

the program they would most like to use again, even though overall in ranking Arc View 

was selected first 34% of the time compared to 32% for Maplnfo and 25% for ID RISI. 

This suggests that the criteria selected for the evaluation were not equally important in 

the final choice of GIS preference and that some other factors played a role. A slightly 

different picture emerges when comparing those GIS programs selected first and 

second as the GIS they would most like to use again. In this instance Arc View was 

clearly preferred (63%), followed by IDRISI (50%) and Maplnfo (44%). Overall, 

ArcView received first and second ranking 57%, Maplnfo 53%, and IDRISI 45% of 

the time. 

Determinacy Analysis 

Determinacy Analysis, a frequency analysis of multi-dimensional contingency 

tables, was used to investigate relationships between the variables (Chesnokov, 1982, 

Zaslavsky, 1995, Software available from Context, Ltd., Moscow, 1992). Since the 

number of subjects was so small, secondary aggregating variables were constructed 

where possible so more meaningful comparisons could be made. For example, for the 

variable 'like to use again' it was considered that those students who ranked a GIS first 

or second liked the GIS and those who ranked it third, fourth, and fifth did not. This 
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Figure 16. Overall Ranking of Selected GIS. 

division was selected since the evaluation was designed to find the best GIS for use in 

high schools, therefore, any program ranked third or lower would be unlikely to fall 

into this category. Questions were developed to direct comparisons between the 

108 
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variables. The analysis is summarized in Table 16. 

1. Did older students rank the GIS differently from the younger students? For

this analysis the students were grouped by session, since the 14 and 15 year old 

students were all in Session 1 and the 16 and 17 year olds in Session 2 (Table 17). The 

younger students preferred ArcView, compared to the older students, 86% to 44% 

(Figure 17). All the younger students liked its performance (ranked it 1 or 2) on 

Exercises 1 and 2, whereas 67% of the older students liked its performance on Exercise 

1 and only 11 % on Exercise 2. Eighty-six percent of the younger students thought 

Arc View was easy to operate and intuitive compared to 44% of the older students. The 

reverse seem to be true with IDRIS!. Here the older students showed a considerable 

preference for IDRIS! compared to the younger students, 78% to 14%. None of the 

younger students thought it was easy to operate nor intuitive nor fun to use. With the 

other GIS the differences were less clear. The younger students marginally preferred 

Map Factory compared to the older students, 43% to 22%, and thought Maplnfo more 

fun to use, 71 % to 33%. 

2. Was there a difference in time taken to complete the exercises on each GIS

by age? The time data were not available for all the students. Two time designations 

were used, less than the mean time and the mean time and above for each GIS (Table 

18). There was no apparent difference by age in the time taken to complete the 

exercises on Arc View and ID RISI, although the missing data could upset this balance. 

In contrast, the older students completed the tasks more quickly than the younger 

students with Map Factory and Maplnfo (67% less than the mean time for older 

students compared to 29% for younger students). With the Manual GIS, 89% of the 

older students completed the exercises less than the mean time compared to 57% of the 

younger students. 
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Table 16 

Summary of Results of Determinacy Analysis 

Question Posed 

1. Did older students rank the GIS differently from the younger students?

2. Was there a difference in time taken to complete the exercises on each GIS by age?

3. Did the girls rank the GIS differently from the boys?

4. Was there a difference in time taken to complete the exercises on each GIS by gender?

5. Did the skilled computer users rank the GIS differently from the unskilled users?

6. Did the geographically knowledgeable rank the GIS differently from the less geographically
knowledgeable?

7. Did students rank the GIS differently for performance on Ex. I and Ex.2?

8. Were some criteria more important to the students when selecting those GIS they would most like to use
again?

9. Were the preferred GIS, the ones upon which the exercises were completed most quickly?

10. Were the GIS used in the middle of the session preferred to those used early or late in the session?

Yes 

✓ 

✓ 

✓ 

✓ 

No 

✓ 

✓ 

✓ 

✓ 

✓ 

✓ 

...... 

...... 
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Table 17 

Comparison of Students by Age Who Ranked the GIS 1 or 2 for Selected Criteria 

Criteria Percentage of Students 

ArcView IDRIS! Map Factory Maplnfo Manual 
14-15 16-17 14-15 16-17 14-15 16-17 14-15 16-17 14-15 16-17
years. years years. years years. years years. years years. years 

Performance on Ex. 1 100 1 67 14 67 14 22 . 71 33 14 11 

Performance on Ex. 2 100 11 43 78 14 33 43 78 0 0 

Ease of operation 86 44 0 67 43 11 43 44 29 33 

Most intuitive to use 86 44 0 56 57 22 43 22 14 56 

Quality of screen graphics 57 33 14 56 71 67 71 44 29 0 

Quality of hardcopy 29 33 29 78 14 33 29 78 14 11 

Clarified concepts 57 44 14 67 43 89 14 22 57 56 

Most fun to use 57 56 0 67 71 11 71 33 14 33 

Liked to use again 86 44 14 78 43 22 43 44 14 11 

1 Interpretation - 100% of the students aged 14-15 years ranked Arc View 1 or 2 for performance on Ex. 1. 
There were 7 students aged 14-15yrs. and 9 students aged 16-l 7yrs. 

...... 

...... 
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Figure 17. 
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•Younger Students
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7 8 9 

Comparison by Age of Student Rankings of Arc View and IDRISI. 
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Table 18 

Comparison by Age of Time Taken to Complete the Exercises by Students Who Ranked the GIS 1 or 2 for Like to Use Again 

Time 

<Mean 

=>Mean 

ArcView 
14-15 16-17
years. years 

43 1 44 

57 33 

IDRIS! 
14-15 16-17
years. years 

29 33 

57 67 

Percentage of Students 

Map Factory Maplnfo Manual 
14-15 16-17 14-15 16-17 14-15 16-17
years. years years. years years. years 

29 67 29 67 57 89 

57 22 57 33 29 11 

1 Interpretation - 43% of the students aged 14-15 years who ranked Arc View 1 or 2 for 'like to use again' completed the 
exercises on Arc View in less than the mean time for Arc View. 

There were 7 students aged 14-15yrs. and 9 students aged 16-l 7yrs. 
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3. Did the girls rank the GIS differently from the boys? Some differences

seemed to occur by gender in two programs, IDRIS! and Maplnfo (Figure 18). The 

boys preferred ID RISI compared to the girls, 70% to 17%, though the girls (78%) 

thought it performed better on Exercise 2 than did the boys ( 43%) (Table 19). 

However, the girls liked Maplnfo more in all respects than the boys, 67% to 30%. 

Some of the differences observed with IDRIS! may be a reflection of age, since the 

older students also liked IDRIS I and the majority of the boys (70%) were older 

students. The girls' preference for Maplnfo cannot be so easily linked to age, since 

both age groups ranked this program similarly. With Arc View, all the girls thought it 

performed well on Exercise 1, while only 11 % liked its performance on Exercise 2. 

The boys, on the other hand, thought it performed well on both exercises. Overall 

there were no other discernible differences by gender on Arc View, Map Factory, and 

Manual GIS. 

114 

4. Was there a difference in time taken to complete the exercises on each GIS

by gender? There was no consistent difference in time by gender (Table 20). The girls 

performed the exercises more quickly than the boys with ArcView (67% of girls to 

30% of boys less than the mean) and IDRIS! (50% of girls to 20% of boys less than 

the mean). The boys worked more quickly than the girls with Map Factory (60% to 

33%) and the Manual GIS ( 100% to 33% ). 

5. Did the skilled computer users rank the GIS differently from the unskilled

users? There was no evidence those skilled on the PC or the Macintosh favored the 

programs using those platforms (Tables 21, and 22). The unskilled computer users 

also did not appear to favor one platform over another. Neither the students skilled nor 

those unskilled in using new software showed a marked preference for one program 

(Table 23). 
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Comparison by Gender of Student Rankings of ID RISI and Maplnfo. 
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Table 19 

Comparison of Students by Gender Who Ranked GIS 1 or 2 for Selected Criteria 

Criteria Percentage of Students 

ArcView IDRISI Map Factory Maplnfo Manual 
Male Female Male Female Male Female Male Female Male Female 

Performance on Ex. 1 70 1 100 60 17 20 17 40 67 10 17 

Performance on Ex. 2 100 11 43 78 14 33 43 78 0 0 

Ease of operation 60 67 40 33 40 0 30 67 30 33 

Most intuitive to use 70 50 40 17 40 33 10 67 40 33 

Quality of screen graphics 40 50 40 33 80 50 40 83 10 17 

Quality of hardcopy 40 17 60 50 20 33 50 67 20 0 

Clarified concepts 70 17 60 17 60 83 10 33 60 50 

Most fun to use 60 50 50 17 30 50 30 83 30 17 

Liked to use again 60 67 70 17 30 33 30 67 10 17 

1 Interpretation - 70% of the male students ranked Arc View 1 or 2 for performance on Ex. 1. 
There were 10 male students and 6 female students. 
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Table 20 

Comparison by Gender of Time Taken to Complete Exercises by Students Who Ranked the GIS 1 or 2 for Like to Use Again 

Time 

<Mean 

=> Mean 

Percentage of Students 

Arc View IDRIS! Map Factory Maplnfo Manual 
Male Female Male Female Male Female Male Female Male Female 

30 1 

50 

67 

33 

20 

80 

50 

33 

60 

40 

33 

33 

50 

50 

50 

33 

100 

0 

0 

50 

1 Interpretation - 30% of the male students who completed the exercises in less than the mean time for Arc View ranked Arc View
1 or 2 for 'like to use again' 

There were IO male students and 6 female students. 
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Table 21 

Comparison of Students Skilled and Unskilled in PC Use Who Ranked the GIS 1 or 2 for Selected Criteria 

Criteria Percentage of Students 

ArcView IDRIS! Map Factory Maplnfo Manual 
Skilled Unskill Skilled Unskill Skilled Unskill Skilled Unskill Skilled Unskill 

Performance on Ex. 1 60 1 91 60 36 20 18 60 45 0 18 

Performance on Ex. 2 40 55 80 55 20 27 60 64 0 0 

Ease of operation 60 64 20 45 60 9 20 55 40 27 

Most intuitive to use 40 73 20 36 80 18 20 36 

Quality of screen graphics 40 45 60 27 80 64 20 73 0 18 

Quality of hardcopy 40 27 40 64 40 18 40 64 20 9 

Clarified concepts 80 36 60 36 60 73 20 18 60 55 

Most fun to use 60 55 40 36 40 36 40 55 20 27 

Liked to use again 60 64 60 45 60 18 20 55 0 18 

1 Interpretation - 60% of the students skilled in PC use ranked Arc View 1 or 2 for performance on Ex. 1. 
There were 11 skilled students and 5 unskilled students. 

...... 

...... 
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Table 22 

Comparison of Students Skilled and Unskilled in MAC Use Who Ranked the GIS 1 or 2 for Selected Criteria 

Criteria Percentage of Students 

ArcView IDRISI Map Factory Maplnfo Manual 
Skilled Unskill Skilled Unskill Skilled Unskill Skilled Unskill Skilled Unskill 

Performance on Ex. 1 100 1 79 0 50 50 14 0 57 50 7 

Performance on Ex. 2 0 57 100 57 50 21 50 64 0 0 

Ease of operation 50 64 50 36 0 29 50 43 50 29 

Most intuitive to use 100 57 50 29 0 43 0 36 

Quality of screen graphics 50 43 0 43 100 64 50 57 0 14 

Quality of hardcopy 0 36 100 50 0 29 100 50 0 14 

Clarified concepts 50 50 0 50 100 64 0 21 50 57 

Most fun to use 50 57 50 36 0 43 50 50 50 21 

Liked to use again 50 64 50 50 0 36 50 43 50 7 

1 Interpretation - 100% of the students skilled in MAC use ranked Arc View 1 or 2 for performance on Ex. 1. 
There were 2 skilled students and 14 unskilled students 
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Table 23 

Comparison of Students Skilled and Unskilled in New Software Use Who Ranked the GIS 1 or 2 for Selected Criteria 

Criteria Percentage of Students 

ArcView IDRIS! Map Factory Maplnfo Manual 
Skilled Unskill Skilled Unskill Skilled Unskill Skilled Unskill Skilled Unskill 

Performance on Ex. 1 75 1 83 75 33 0 25 25 58 25 8 

Performance on Ex. 2 25 58 100 50 25 25 50 67 0 0 

Ease of operation 75 58 25 42 25 25 25 50 50 25 

Most intuitive to use 75 58 25 33 25 42 25 33 

Quality of screen graphics 25 50 25 42 50 75 100 42 25 8 

Quality of hardcopy 50 25 75 50 0 33 50 58 25 8 

Clarified concepts 50 50 75 33 75 67 25 17 50 58 

Most fun to use 50 58 25 42 25 42 50 50 50 17 

Liked to use again 50 67 75 42 0 42 50 42 25 8 

1 Interpretation - 75% of the students skilled in new software use ranked Arc View 1 or 2 for performance on Ex. 1. 
There were 4 skilled students and 12 unskilled students 

N 
0 
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6. Did the geographically knowledgeable rank the GIS differently from the less

geographically knowledgeable? The geographically knowledgeable preferred IDRIS!

compared to the less geographically knowledgeable, 78% to 14% (Table 24). However 

the less geographically knowledgeable tended to prefer Maplnfo, 71 % compared to 

22% for the geographically knowledgeable. This could be a gender difference, since 

70% of boys considered themselves geographically knowledgeable and the boys liked 

IDRIS!, whereas 67% of the girls considered themselves less geographically 

knowledgeable and girls favored Maplnfo. 

7. Did students rank the GIS differently for performance on Ex.1 and Ex.2?

The students did distinguish between GIS performance on Exercise 1 and 2 (Table 25). 

They preferred the performance of Arc View (81 % ranked it 1 or 2) and Maplnfo (50%) 

on Exercise 1 and IDRIS! and Maplnfo equally (63%) on Exercise 2. 

121 

8. Were some criteria more important to the students when selecting those GIS

they would most like to use again? With Arc View of the 63% of students who would 

like to use it again, 80% liked the way it performed on Exercise 1, they also thought it 

was easy to operate and intuitive (Table 26). Of the 50% of students who liked 

IDRIS!, 75% thought it performed well on both Exercise 1 and 2 and they found it 

helpful in understanding geographic concepts. Only 31 % of students liked Map 

Factory, of these 80% thought it intuitive to use and liked the quality of the screen 

graphics. Eighty-six percent of the proponents of Maplnfo, liked its performance on 

Exercise 1 and thought it easy to operate. Only 12% of students liked the Manual GIS 

and they all ranked it highly for all criteria except quality of graphics and hardcopy (the 

map they created). As can be readily seen there were no criteria which the students as a 

group consistently perceived as important in evaluating the individual GIS programs 

(Figure 19). 
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Table 24 

Comparison of Geographically Knowledgeable Students and the Less Geographically Knowledgeable 
Who Ranked the GIS 1 or 2 for Selected Criteria 

Criteria Percentage of Students 

ArcView IDRIS! Map Factory Maplnfo Manual 
Kn. Unkn. Kn. Unkn. Kn. Unkn. Kn. Unkn. Kn. Unkn. 

Performance on Ex. 1 78 1 86 67 14 33 0 11 100 11 14 

Performance on Ex. 2 33 71 78 43 33 14 56 71 0 0 

Ease of operation 67 57 44 29 22 29 22 71 44 14 

Most intuitive to use 67 57 44 14 44 29 11 57 33 43 

Quality of screen graphics 22 71 44 29 78 57 56 57· 11 14 

Quality of hardcopy 44 14 67 43 33 14 67 43 22 0 

Clarified concepts 67 29 67 14 67 71 11 29 67 43 

Most fun to use 67 43 58 14 33 43 33 71 22 29 

Liked to use again 67 57 78 14 22 43 22 71 11 14 

I Interpretation - 78% of the geographically knowledgeable students ranked Arc View 1 or 2 for performance on Ex. 1. 
Kn. - Geographically knowledgeable, 9 students. Unkn. - Geographically less knowledgeable, 7 students. 
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Table 25 

Comparison of Students Who Ranked the GIS 1 or 2 for Performance on Exercise 1 and 2 

Criteria 

Performance on Ex. 1 

Performance on Ex. 2 

ArcView 

8! 1 

50 

IDRIS! 

43 

63 

Percentage of Students 

Map Factory 

19 

25 

Maplnfo 

50 

63 

1 Interpretation - 81 % of the students ranked Arc View 1 or 2 for performance on Ex. 1. 

Manual 

12 

0 
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Table 26 

Students Who Ranked Criteria 1 or 2 for the GIS Which They Would Like to Use Again 

Criteria Percentage of Students 

ArcView IDRIS! Map Factory 
10 students 1 8 students 1 5 students 1 

Performance on Ex. 1 1002 88 40 

Performance on Ex. 2 70 88 60 

Ease of operation 90 62 60 

Most intuitive to use 90 62 80 

Quality of screen graphics 50 63 80 

Quality of hardcopy 20 63 40 

Clarified concepts 60 88 40 

Most fun to use 80 75 60 

1 Number of students who ranked the GIS 1 or 2 for 'like to use again'. 

Maplnfo 
7 students 1 

86 

75 

86 

71 

86 

57 

43 

86 

Manual 
2 students 1 

100 

100 

100 

100 

50 

0 

100 

100 

2 Interpretation - 100% of the students who would like to use Arc View again ranked Arc View 1 or 2 for performance on Ex. 1. 
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Perlormance Ex. 1 

Performance Ex. 2 

Ease of operation 

Most intuitive to use 

Screen graphics 

Quality of hardcopy 

Most fun to use 

Figure 19. 

ArcView IDRISI Map Factory Maplnfo Manual 

0 100 0 100 0 100 0 

Percentage of Students Who Ranked the Criteria 1 or 2 

Percentage of Students Who Ranked Individual Criteria 1 or 2 on the 
GIS They Would Most Like to Use Again .. 

100 

9. Were the preferred GIS, the ones upon which the exercises were completed

most quickly? Preference for a GIS did not seem to be dependent on the time taken to 

complete the exercises (Table 27). 
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10. Were the GIS used in the middle of the session preferred to those used

early or late in the session? It is important to point out that the sample size in this 

comparison is very small. No more than four students could use a program at any one 

time, that is two in each session. However, students do appear to prefer the GIS they 

used third, apart from the Manual (Table 28). Nevertheless most of the students did 

not necessarily dislike the programs they used first or last, which might be expected if 

unfamiliarity and boredom were the sole deciding factors in their choice. 

Student Opinions 

The students were asked if they wanted GIS software to be available in their 

high school classroom. All of them concurred, however, 19% qualified this by saying 
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Table 27 

Comparison of Time Taken to Complete Exercises by Students Who Rank the GIS 1 or 2 for Like to Use Again 

Time 

<Mean 

=>Mean 

ArcView 
10 students 1 

572

57 

IDRISI 
8 students 1 

40 

60 

Percentage of Students 

Map Factory 
5 students 1 

50 

29 

Maplnfo 
7 students 1 

25 

33 

1 Number of students who ranked the GIS 1 or 2 for 'like to use again'. 

Manual 
2 students 1 

50 

0 

2 Interpretation - 57% of the students who completed the exercises in less than the mean time for Arc View ranked Arc View 1 or 
2 for 'like to use again'. 
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Table 28 

Students' Ranking the GIS for Like to Use Again and the Sequence in Which They Used the GIS 

Programs Percentage of Students 

First Second Third Fourth 
Liked Not Liked Not Liked Not Liked Not 

Liked Liked Liked Liked 

ArcView 50 1 (2)2 50 (2) 0 (0) 100 (1) 100 (4) 0 (0) 40 (2) 60 (3) 

IDRIS! 67 (2) 33 (1) 50 (2) 50 (2) 100 (2) 0 (0) 33 (1) 67 (2) 

Map Factory 50 (1) 50 (1) 0 (0) 100 (4) 100 (2) 0 (0) 0 (0) 100 (2) 

Maplnfo 0 (0) 100 (4) 33 (1) 67 (2) 80 (4) 20 (1) 50 (2) 50 (2) 

Manual 0 (0) 100 (3) 25 (1) 75 (3) 33 (1) 67 (2) 0 (0) 100 (2) 

1 Interpretation - 50% of the students who used Arc View first ranked Arc View 1 or 2 for 'like to use again'. 
2 Number of students. 

Fifth 
Liked Not 

Liked 

100 (2) 0 (0) 

25 (1) 75 (3) 

33 (2) 67 (4)

0 (0) 0 (0) 

0 (0) 100 (4) 
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they personally did not have classes to which it was applicable and a further 19% 

wanted GIS software providing it was not IDRISI. 

In response to the question of why they would find GIS useful in school, the 

students thought the computerized GIS was easier, quicker, more fun, more accurate, 

and a source of more data than the Manual version. Being faster, it was suggested, a 

computerized GIS would provide more time for experimentation, being fun it would 

stimulate more people to learn and keep them interested. GIS would also provide 

additional computer skills. One student thought it provided a better understanding of 

geography and another said it helped her to see the relationships between land features, 

drainage, and urban areas. 

In the final open comment section, students said GIS was fun, interesting, and 

useful. Some expressed concern that the software was difficult to learn and impractical 

for their schools, which could not even afford pencils. Four students declared Mapinfo 

was the best, another that with a few modifications Arc View was definitely superior, 

and two liked IDRISI for educational purposes, particularly its interface. 

Discussion 

In the evaluation of individual GIS the students generally found the programs 

operated satisfactorily. Only with IDRISI did some students express adamant dislike, 

nevertheless, there were others who liked it. One student declared a bias toward raster­

based programs, though the majority showed a preference towards the vector-based 

GIS. The researcher also experienced frustration with many of the idiosyncrasies of 

individual programs identified by the students. 

In ArcView no buffer zones are shown in the analysis and since all the 

polygons which intersect with the buffer are selected, it is not possible to determine the 

extent of the buffer zone within these polygons (Figure 20). Mapinfo does show the 
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buffer, a fact appreciated by the students. Despite this, only the polygons whose 

centroid falls within the buffer are selected, which results in some of the larger urban 

areas not being shown as possibly endangering wetlands (Figure 21). The quality of 

Maplnfo's graphics and the difficulty in enlarging the maps to fill the screen 

necessitated the repeated use of the zoom function. The maps also tend to be skittish, 

occasionally vanishing from the window. In the raster-based programs visual overlay 

is a more complex procedure than in vector programs. However in the analysis, raster 

software can show which urban areas fall in the buffer, within the limitations of cell 

resolution (Figures 22 and 23). Strong opinions were engendered by IDRISI. The 

number and complexity of the dialogue boxes is a disadvantage, as is the absence of 

automatic map display. The students liked Map Factory's graphics and some of the 

easy-to-operate functions, but they did not like the scripting language, nor the small 

sized, gray-tone intermediate maps. Visual overlay with the Manual GIS was of course 

very easy, but the students soon discovered the problems in using it to conduct an 

analysis. They almost all assumed that the computer rendered maps were more accurate 

than the ones they constructed, and as far as line width and measurement consistency 

are concerned this is probably true. This attitude highlights the need for education 

about GIS and data accuracy if students are to effectively utilize this tool. 

When the students ranked the GIS programs at the end of the session several 

inconsistencies emerged. Having declared visual overlay was very easy using the 

Manual GIS, 75% of the students ranked it fifth on visual overlay performance. The 

majority consistently ranked the Manual GIS low for all criteria, except 'ease of 

operation' and 'most intuitive to use'. However, even here 31 % and 38% still ranked 

the Manual fifth for these criteria respectively. This probably reflects these students' 

preference for computer technologies, with which they were proficient. Other students 

without such computer savvy may have preferred the Manual GIS, for as two students 
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ArcView 

Figure 20. Arc View-Results of Spatial Analysis. 

Maplnfo 

Figure 21. Maplnfo-Results of Spatial Analysis. 



www.manaraa.com

Figure 22. 

Figure 23. 
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expressed it " . .it is nice to have all the materials in front of you," and " .. it is ... more 

tangible." On the 'quality of screen graphics' students were told to use the quality of the 

transparencies and paper maps of the Manual GIS in the comparison. The Manual GIS 

was identical to Arc View, from which it was created. Even so, 75% ranked the Manual 

GIS fifth, whereas 100% ranked Arc View between first and fourth. This again further 

illustrates the students preference for computer technologies. 

In five out of the nine groups, the students tended to provide similar rankings to 

their partner, although they were asked to fill out the questionnaires individually. This 

was probably inevitable, since they had worked with the programs together, 

experienced the same frustrations and exhilarations, and discussed the method and 

results in detail. It is also possibly a reflection of the importance to teenagers of group 

membership and cohesion. 

The time taken and sequence of use appeared to have no significant influence on 

GIS program preference. As might be expected, the older students executed the 

exercises marginally faster on some of the GIS programs. 

Age and gender seemed to be the most influential variables for GIS preference. 

In this particular study it is difficult to separate the two, because of the manner in which 

the genders were distributed in the two age groups. For example, with the preference 

for IDRIS! by the older male students, age appears to be the more important variable, 

since the younger boys tended to rank IDRIS! low. With the older girls it is less clear 

as the girl who was working alone disliked IDRIS!, whereas the other, who was 

working with a boy, liked it. A female gender preference for Maplnfo was more 

pronounced, as only on one occasion did a girl rank Maplnfo below third, compared to 

20 occasions with the boys. 

Despite the six hours in which the students were involved in this evaluation, the 

students appeared to enjoy using computerized GIS, and found it interesting and 
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exciting. Cries of "cool!" would often accompany a new map flashing onto the screen. 

When we looked at a false color satellite image of SW Michigan in the lunch break they 

demonstrated they had learnt quite a lot about the geography of Thornapple Township, 

identifying the steep forested slopes on the eastern margins of the township and the 

Thornapple River valley which bisects the area. 

No single selected criterion appeared to be deemed by the students to be of 

critical importance in their choice of the GIS they would most like to use again. This 

suggests some other factor(s) is playing a role in the final preference choice, or the 

students are weighing a combination of individual qualities of the GIS in making their 

selection. Since some students had very strong views against IDRISI, Maplnfo and 

ArcView would appear to be the most widely favored GIS programs for high school 

use by the students in this sample. 
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CHAPTER VI 

THE TECHNOLOGICAL ST A TUS OF HIGH SCHOOLS 
WITHIN THE STUDY AREA 

Introduction 

The third part of this research was an evaluation of the computer technology 

currently available in high schools in the study area. This is an important issue at a 

period of reduced state funding for schools and failing bond and millage proposals as 

communities force school districts to become more efficient and to rethink priorities. 

For Geographic Information Systems to become widespread in pre-collegiate education 

at this time, it has to be easy and economical to implement. This view posed a further 

four research questions: 

5. Do high schools within the study area have the necessary hardware to

operate GIS programs or would new computers have to be purchased? 

6. Do social studies classes have access to computers?

7. Do schools with larger student enrollment have a lower student/computer

ratio than schools with a smaller student enrollment? 

8. Does the rural or urban nature of the communities from which a school

draws its students affect the student/computer ratio? 

Research Design 

In order to address these research questions, it was decided to develop a 

questionnaire to be sent to each of the high schools in the study area. The format was 

designed to be as simple as possible so as to encourage the maximum response. It was 

134 
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further decided to send the questionnaire to the computer teachers at each school, since 

they were thought to be most likely to know the technical details of the school's 

machines. The names of these teachers were ascertained by calling each school, so that 

the questionnaires could be personally addressed, to further encourage the maximum 

response. A cover letter briefly explaining the purpose of the questionnaire was 

enclosed. To determine if high schools had computers capable of running GIS 

programs, questions on numbers, type, and memory capacities of the school's student 

computers were assembled in tabular form. The second question, concerning access of 

social studies students to these computers, was approached by adding two questions to 

the questionnaire, each requiring the circling of a "Yes" or "No" answer (Appendix H). 

Two additional items of information about each school were sought. These 

were the approximate student enrollment of the school and whether the school served a 

rural or urban community. Both these factors were considered to be instrumental in 

influencing the technological status of individual schools. It was hypothesized that 

urban schools with their large size and more affluent tax base may have a lower 

student/computer ratio and more powerful machines than smaller rural schools. The 

designation of a community as urban or rural was based on census data for 1990. 

Materials 

Since GIS are principally concerned with the manipulation of spatial graphics, 

they usually require large amounts of Random Access Memory (RAM) to run even 

basic functions. Program and data storage are also very demanding of hard disk 

capacity. Therefore, the manufacturer's suggested minimum and recommended 

hardware requirements for each GIS program selected for study were obtained to 

provide base levels with which to compare the computing capabilities of school 

computers (Chapter IV). 
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The minimum hardware requirements of the GIS programs examined in this 

study were determined from publications provided by the manufacturer, their sales 

departments or from their World Wide Web sites. These are shown in Table 29. 

Table 29 

Minimum Hardware Requirements for Selected GIS 

GIS Program 

Arc View (PC) 

Arc View (MAC) 

IDRIS! (PC) 

Map Factory (MAC) 

Maplnfo (PC) 

Maplnfo (MAC) 

Maptitude (PC) 

MB '-Megabytes 

Memory (RAM) 
MB' 

8.0 + 17.0 (VM)2 

12.0 + (+VM) 

4.0 

1.5-2.0 

4.0 

8.0 

8.0 

VM2-Virtual Memory 

Program Storage 
MB 

13.0 

25.0 

10.0 

1.1 

4.5 

4.0 

16.0 

Processor/ 
Operating System 

80386/Win 3.1 

Power/68040/ 
Mac OS 7.1 

80386/Win. 3.1 

680x0/Mac OS 7.0 

Win. 3.1 

Power/Mac OS 7 .1 

80486/Win. 3.1 

Table 29 illustrates the wide variation in program storage requirements (1. 1 to 

25.0 megabytes {MB}) and memory requirements (1.5 to 12.0 MB) between the 

programs. Most manufacturers recommend much higher values than the minimums for 

smooth running of the programs. For instance, ArcView suggest 32 MB of RAM 

(12.0 MB minimum) for the MAC version and IDRIS! 8 MB or more (4.0 MB 

minimum). The manufacturers also advise the use of sophisticated operating systems. 

These recommended hardware requirements are shown in Table 30. 
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Table 30 

Recommended Hardware Requirements for Selected GIS 

ArcView (PC) 

Arc View (MAC) 

IDRIS! (PC) 

Map Factory (MAC) 

Maplnfo (PC) 

Maplnfo (MAC) 

Maptitude (PC) 

MB 1-Megabytes 

Memory (RAM) 
MB' 

12.0 +17.0 (VM)2 

32.0 

>8.0

8.0 

8.0 

16.0 

12.0 

VM2-Virtual Memory 

Program and Data 
Storage MB 

38.0 

45.0 

12.0 

4 .0 

12.0 

16.0 

16.0 

Processor/ 
Operating System 

80486/Win 3.1 

Power/Mac OS 7.5 

80486/Win. 3.1 

680x0/Mac OS 7 .0 

Win. 3.1 

Power/ 
Mac OS >7.1 

80486/Win 3.1 
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Information on the approximate student enrollment of each school was obtained 

from the Intermediate School Districts where possible, or from the individual schools. 

The most recent data available for all schools were for the 1994-1995 school year. 

This was also the year for which the schools' technological data were collected. 

Census data for 1990 were studied for the communities served by these high schools in 

order to determine if they were largely rural or urban communities. The Census reports 

total population for each 'designated place' and 'parts of place' and the percentages of 

that population which are considered urban and rural. Thus data were available for 

townships, villages, and cities. 
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Methodology 

Once the questionnaires were returned, the data contained were collated into a 

single table (Appendix H). The minimum hardware requirements of each of the 

selected GIS was compared with technical data supplied by each school. This process 

was repeated for the recommended hardware requirement of each GIS. 

Information on the approximate enrollment of each school was compared to the 

number of student computers available and the capacity of those computers. 
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The 1990 census data were aggregated for each township, see Figure 24. As 

can be seen, most school districts do not encompass entire townships, but often parts 

of several townships. Therefore, it was necessary to estimate whether a school district 

was largely urban or rural using these data. For example, if the estimated population of 

the school district was described by the Census as over 50% urban, then the school 

district was designated as urban. It was recognized, however, that this environmental 

designation did not reflect the true status of the school population. This could only be 

determined by completing an individual student enumeration, which was beyond the 

scope and requirements of this study. Since it was impossible to determine an 

environmental status for schools which were known to draw students from more than 

one school distinct, such as the parochial schools, an "undesignated" category was 

created. The environmental data were related to the student/computer ratio and 

computer capacity in each school. The school enrollment and environmental data are 

shown in Appendix H. 

Results 

Of the thirty-seven high schools which received questionnaires, nineteen 

responded (51 % ) (Figure 25). Of these respondent schools, 11 % had only Macintosh 
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Figure 24. Rural and Urban Townships in the Study Area. 
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Figure 25. High Schools From Which Responses Were Recieved. 

C::J School Districts

* High Schools



www.manaraa.com

computers, 63% had only PC computers, 21 % had both Macintosh and PC computers, 

and 5% had Apple computers. Of those schools having PC computers, 25% stated 

they had the Microsoft Windows interface standard operating system. All the GIS in 

this study which use the PC platform, were Windows versions. None of the GIS 

which use the Macintosh platform would operate on an Apple computer. 

The minimum and recommended hardware requirements for each of the selected 

GIS software packages were compared with the technological data provided by each 

school. The schools which possessed at least some computers which met these 

minimum and recommended requirement are recorded in Table 31. 

Table 31 

Schools With Computers Which Met Software Requirements 

School Enrollment Environment # Students/ # Programs # Programs 
Computer Min. Levels Rec. Levels 

Delton 567 Rural 5.2 5 2 
Kellogg 

Harper 816 Rural 32.6 1 0 
Creek 

Loy Norrix 1292 Urban 14.7 1 1 

Portage 1133 Urban 7.8 2 1 
Central 

Hackett 486 Undesignate 32.4 1 1 

KAMSC 150 U ndesignate 2.5 3 0 

Min.-Minimum hardware requirement 
Rec.-Recommended hardware requirement 
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As might be expected, for each GIS program there were more schools with 

computers which met the minimum hardware requirements than the recommended 

requirements. Thirty-two percent of the respondent schools could operate at least one 

type of GIS software at minimum hardware levels, 21 % of these schools could also 

operate at least one type of GIS at recommended levels. Unfortunately, in only 21 % of 

the schools are these computers available to social studies classes. In one other school, 

(KAMSC), no social studies is taught, nevertheless the computers would be available 

to any class which choose to use GIS software, such as earth science which is taught as 

an elective in the eleventh and twelfth grades. 

The number of schools which could operate each GIS program at minimum and 

recommended hardware levels is shown in Table 32. 

Table 32 

Number of Schools With Computers Which Met Software Requirements 

Minimum Recommended 

Arc View (PC) 1 0 

Arc View (MAC) 0 0 

IDRIS! (PC) 2 1 

Map Factory (MAC) 5 2 

Maplnfo (PC) 3 2 

Maplnfo (MAC) 1 0 

Maptitude (PC) 1 0 
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All the GIS programs except the Macintosh version of Arc View could be 

operated at minimum hardware levels in at least one school. Nevertheless, only 
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IDRISI, Map Factory, and the PC vers10n of Mapinfo could be operated at 

recommended hardware levels. No school had Macintosh computers which could 

operate Arc View at the minimum or recommended levels. 

Student enrollment data were then compared to the numbers of student 

computers in each school, see Figure 26. 
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In this scattergram the schools appear to fall into three zones. In Zone 1 were 

medium to large sized schools with enrollments of 747 to 1006 students. These 

schools usually had one computer laboratory of 12 to 28 machines, giving an average 

student/computer ratio of 40: 1. Zone 2 had a wide range of school sizes (216 to 1292 

students) which had an average student/computer ratio of 13: 1. The third zone also 

showed a variety of student population sizes (150 to 1133) with an average 
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student/computer ratio of 5: 1. Schools representing urban and rural environmental 

designation categories were found in each zone. Undesignated schools were found 

only in Zones 2 and 3. Figure 27 demonstrates more directly the relationship between 

the environmental category and the student/computer ratio and the resultant three 

average student/computer ratio zones identified in Figure 26. For instance, 50% of the 

rural schools have an average student/computer ratio of 13: 1, compared to 40% of the 

urban and 66% of the undesignated schools. Nevertheless, these effects appear very 

marginal and it is probable that in this study area school size and environmental 
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designation do not have any significant influence on student/computer ratios. The 

sample size is too small to justify further statistical analysis and extrapolation of these 

findings to other areas in Michigan. 

Computer capacity was also found to be independent of student enrollment and 

environmental designation. One case in point is Delton Kellogg High School, which is 

a rural school with a relatively small enrollment of 567 students. This school has one 

of the lowest student/computer ratios (5: 1) and could operate the most GIS programs 

both at the minimum (5) and recommended (2) hardware levels. By contrast Portage 

Central High School is an urban school with the second largest enrollment of 1133 

students, a student/computer ratio of 8: 1, and computers capable of operating 2 GIS 

programs at minimum levels and 1 at recommended levels. 

Discussion 

The investigation into the technological status of high schools in the study area 

examined four issues. Firstly, do high schools have the necessary hardware to operate 

GIS programs or would new computers have to be purchased? Just over thirty percent 

of the schools which responded to the questionnaire were found to be technologically 

prepared to operate at least one of the GIS programs under consideration. Even so, 

there is probably little educational gain to be achieved by operating GIS programs at 

minimum hardware requirement levels. The programs run too slowly and the more 

complex functions often do not work at all. Consequently, looking at the analysis on 

the basis of recommended hardware requirement levels, only 21 % ( 4) of the respondent 

schools could operate a GIS at these levels, two of which could operate Map Factory, 

one of these had 16 computers and the other over sixty machines with this capability. 

Eleven percent (2) of schools in the study area could operate Maplnfo (PC) with 

existing hardware. One of these schools could also operate IDRISI. In the latter two 
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schools the computer laboratories contained several types of machines and it was not 

possible to determine from the data collected how many computers had the necessary 

capability. No school could satisfactorily operate ArcView (PC or MAC), Maplnfo 

(MAC), or Maptitude. It would seem apparent, therefore, that few schools could 

introduce GIS using existing hardware and their choice of program would be severely 

limited. 

The second question addressed whether social studies classes have access to 

computer laboratories. In 58% percent of the respondent schools, social studies classes 

did not have access to computers. Even within the six schools which could operate a 

GIS at recommended hardware levels, 50% deny computer access to social studies 

classes. This is mostly a result of the computer laboratories being fully scheduled for 

use by computer science and business classes. 
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The last two questions considered the effects of school size and of the rural or 

urban nature of the school's service area on the student/computer ratio and computer 

capacity. Neither factor was found to be numerically influential. Some small rural 

schools were found to be as well equipped as some large urban schools. The more 

favorable student/computer ratios found in very small rural schools with enrollments of 

197 to 289 students resulted from the presence of a single computer laboratory of 20 to 

25 machines. Unfortunately, several much larger urban and rural schools with 747 to 

1006 students also had one computer laboratory. One urban school with over a 

thousand students had only 28 Apple Ile computers. Computer capacity was also 

found to be independent of student enrollment and environmental designation. The 

school which could run the most GIS programs at recommended hardware levels was a 

rural, medium-sized school with a 5: 1 student/computer ratio. The second most GIS 

capable school was an urban school with twice the enrollment and a 8: 1 

student/computer ratio. 
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Therefore, within this study area there would appear to be little opportunity for 

social studies classes to incorporate GIS into the curriculum without extensive 

computer upgrades and changes in school policies towards computer accessibility. 

However, should a school wish to integrate this technology into the curriculum, the 

two GIS programs with the lowest computing capacity requirements are Maplnfo for 

the PC, a vector system, and Map Factory for the Macintosh, a raster system. 
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CHAPTER VII 

DEFINING THE ROLE OF GIS IN HIGH SCHOOL GEOGRAPHY EDUCATION 
IN A SELECTED REGION OF SOUTHWEST MICHIGAN 

Introduction 

The principal research question posed in this inquiry was, "Could GIS be 

successfully integrated into high school geography education in a selected region of 

southwest Michigan?" In attempting to answer this question this research focused on 

three aspects of the problem. Firstly, the investigation strove to demonstrate how GIS 

could be integrated into the high school geography curriculum in Michigan. Secondly, 

GIS software programs were evaluated using three techniques to identify those suitable 

for use in high schools, and thirdly, the high schools in the study area were assessed 

for their technological capabilities to operate GIS programs. The conclusions reached 

through this inquiry will be summarized within this framework. 

GIS in the High School Geography Curriculum in Michigan 

After sixty years of decline to a position of relative obscurity in the American 

school curriculum, geography is beginning to experience a renaissance as a result of 

numerous national and state initiatives. Within Michigan, geography, as a distinct and 

separate strand of social studies, is now featured in a recommended state core 

curriculum, has a framework of content standards and benchmarks linked to critical 

grade levels throughout K-12 education, and will be the subject of high stakes 

assessment beginning in 1999. Geography as part of social studies has been given 

equity in the Michigan school curriculum, alongside English, mathematics, and science. 
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The concepts, content, and skills have been clearly defined. The final three cross­

cutting content standards of the Michigan Framework for Social Studies Education: 

Content Standards and the teaching standards in Powerful Authentic Social Studies: 

149 

Standards for Teaching (Michigan Department of Education, 1995, 1996) imply this 

content should be taught through an inquiry process, which will engage students in 

higher cognitive processes and problem solving. As Wiske and Houde (1988) suggest, 

incorporating guided inquiry into the average secondary school will require a 

fundamental change in the educational paradigm. Teachers will require not only 

training in this new approach, but new tools to enable them to institute these 

innovations. 

Decades of research have elucidated the cognitive and pedagogical advantages 

of integrating computer technologies into the classroom. However, it is not the 

technologies themselves which mediate learning, but the thought processes which are 

engendered by the technologies which foster erudition (Jonassen, 1988). Therefore, it 

is essential to provide software which will stimulate the most productive thought 

processes. In addition, Learning Theory suggests the most effective types of learning 

experiences are those which engage students actively in the learning process, using as 

many senses as possible (Maffei, 1986). Therefore software which requires direction 

and control by the student will provide the more dynamic interaction (Jonassen, 1988). 

Such self-directed, exploratory activities not only exploit the unique potential of the 

computer, but prepare the student to deal with the complex demands of the modern 

problem oriented and increasingly technological society (Hazen, 1985). GIS is one 

such tool which may be able to energize students into becoming critical thinkers, 

allowing for various learning styles, and fostering collaborative teaching strategies 

(Marran, 1994). 

If the introduction of GIS into the classroom has numerous cognitive and 
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pedagogical benefits, it must still correspond with the developmental level of the 

students and learning objectives of the curriculum (Liben, 1994, Jenkins, 1991 ). There 

has been no research on the cognitive demands of GIS tasks. Therefore, teachers must 

exercise their own judgment on what their students can and cannot comprehend. The 

curricular match also has to be examined on a school by school basis. However, in 

Michigan with the adoption of state geography content standards and assessment it is 

possible to align generic GIS projects with the broad context of the implied curriculum. 

This research has suggested GIS could be used as a tool in an inquiry approach to 

learning in geography education in Michigan. 

The Identification of Suitable GIS Software 
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Three techniques were used to evaluate the suitability of GIS software for high 

school classrooms. Since no educational software has been designed specifically for 

K-12, an initial selection was made from the vast array of business and higher

educational programs on the basis of low cost and a Windows interface standard. Of 

those identified, four were chosen for further study: Arc View, ID RISI, Map Factory, 

and Maplnfo. These programs were representational of both raster and vector formats 

and PC and Macintosh environments. With the addition of a Manual GIS, constructed 

of paper maps and transparencies, the selected GIS were subjected to a systematic 

evaluation to assess their ease-of-use. Although there were some severe limitations to 

the technique used, it was thought to be a realistic simulation of novice use. Maplnfo 

and Arc View, vector GIS, were deemed simplest to use over a wide array of functions. 

Map Factory was found to be the easier of the two raster programs. 

The third stage in the evaluation was conducted by sixteen high school students 

recruited from the Kalamazoo Area Math and Science Center and Loy Norrix High 

School. The students compared the performance of the five GIS selected for the 
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systematic evaluation on two problem solving exercises, one involving visual overlay 

and the other spatial analysis. They ranked the various GIS based on several criteria 

and described what they liked and disliked about individual programs. The students 

displayed a considerable bias towards computerized GIS, despite recognizing some of 

the advantages of a manual version. Caution has to be exercised in interpreting the 

results of this evaluation because of the small sample •size. However, certain trends did 

emerge. ArcView was preferred for performance on visual overlay, which might be 

expected since a map layer can be overlaid with a single click of the mouse. For spatial 

analysis IDRIS! and Maplnfo were equally favored. There was no single criterion 

upon which the students appeared to base their preference for the program they would 

most like to use again. ID RISI and Maplnfo received an equal number of first rankings 

for the program they would most like to use again. However, when first and second 

rankings were considered together the picture changed, and Arc View became most 

popular followed by IDRIS! and Maplnfo. Map Factory was least preferred. The 

majority of students voted Maplnfo as the most fun to use, but no one thought Map 

Factory was fun. Some interesting relationships between variables emerged. Age and 

gender seemed to affect GIS preference for some programs. The 16 and 17 year old 

boys preferred IDRISI, whereas all the girls preferred Maplnfo. In light of the small 

sample size in this research, these relationships will require more extensive study to 

validate. 

It was apparent the students in this study and the researcher evaluated the GIS 

programs from different perspectives. The researcher considered cost and ease-of-use 

the most critical factors in software selection, an administrative or teacher's perspective. 

From the students' view point, cost was not an issue. However, ease-of-use was only 

one of several factors which influenced student preferences. Performance appeared to 

be an important contributory factor in student GIS selection, which suggests they want 
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a program which provides good visualization of problem solving. 

Based on the results of this research, it is doubtful if any of the four GIS are 

really suitable for high school use. The primary disadvantages found are described 

below. Arc View, while having large, clear maps and performing some operations very 

easily, lacks some of the functionality of other programs and provided poor 

visualization of the results of the spatial analysis. The lack of a hardcopy tutorial and 

fully indexed manual is a serious drawback, as is the unnecessarily complex 

terminology it uses. IDRIS! has wide ranging functionality, but it is too complex for 

high school use. For secondary students, the dialogue boxes need to be simplified, 

maps should display automatically, and additional flexible functionality needs to be 

provided for generating output. The manual also needs to be simplified and fully 

indexed. Map Factory has many easy to use features and it will operate on low 

powered machines. However, students did not rank it highly. The scripting language 

seems unnecessarily complex compared to the dialogue boxes of Map Factory's 

predecessor, Map II. The maps should be displayed fully sized and in color for the 

secondary school environment. Maplnfo was well received by the students. However, 

they did not encounter some of the inherent problems of this program. Choropleth 

maps, which students are likely to use extensively, are difficult to create as they can 

only be saved in a 'workspace', and there appears to be no way to save custom color 

palettes. For school use, maps should automatically fill the screen, be colored, the 

terminology should be simplified, and output functionality improved. Software 

manufacturers interested in providing GIS for K-12 need to carefully study the 

demands of the curriculum and perhaps more importantly the perceptions and 

requirements of the students. 
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The Technological Status of High Schools in the Study Area 

The third and last part of the inquiry was an assessment of computing capacity, 

access, and student/computer ratios in high schools. The study area included urban and 

rural schools with a wide range of student enrollment. Computer provision was found 

to vary widely across all school sizes and environments. Few schools had student 

computers capable of operating GIS programs at manufacturer's recommended 

hardware requirement levels. Costs involved in upgrading computer hardware are an 

important consideration. The Arc View White Paper GIS in K-12 Education suggests 

"With less than $3,000 investment (March 1995), schools can have a new, full 

featured, high powered computer ready for classroom needs and a site license for a 

powerful starter package of software and basic data." (ESRI, 1995). This will provide 

one computer using ArcView. Is this a cost-effective investment? Can GIS be 

successfully and usefully integrated into the curriculum using one computer? The 

answer to both these questions is no. GIS is not going to make a significant impact on 

geography education if students cannot work collaboratively on group or class GIS 

projects for an extended period of time. 
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Low computing capacity is a fundamental problem, but accessibility may indeed 

be the most disturbing issue. In over half the schools studied, social studies classes did 

not have access to the computers because they were being fully utilized throughout the 

day by other disciplines. Schools need to address this problem in innovative ways. 

Some are providing mobile laboratories, which consist of several computers and 

associated hardware which are housed on carts that can be moved into the classroom as 

needed. Another solution is a small laboratory which could be booked on an occasional 

or block time basis by any discipline. 
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Conclusion 

Could GIS be successfully integrated into high school geography education in a 

selected region of southwest Michigan? Now that geography has a clearly defined 

position in the K-12 curriculum of Michigan schools, GIS has a place as a tool which 

can engage students actively in inquiry learning, stimulate higher cognitive processes, 

and provide technological skills. It can be integrated into the high school geography 

curriculum in Michigan. However, the schools are not equipped to embrace this 

technology at the present time using the available business or higher educational 

programs. Perhaps the major drawback to GIS implementation is the software. While 

the evaluations conducted in this research identified programs which were more suitable 

in some respects than others, each had serious limitations. None were designed for the 

young student user, each required high capacity powerful machines, and their interfaces 

were not intuitive, making the learning curves unnecessarily long and steep. 

Recommendations 

Education proceeds by a series of small innovations. Because it is so 
highly decentralized, because funds are always short, because the 
mission is split into so many different directions, education cannot 
concentrate resources and make a great leap forward in one direction. 

(Robert F. Tinker, 1994.) 
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The recommendations from this research fall into three categories: further 

research, software development, and classroom organization and management. Before 

GIS can bring some of its obvious advantages to the average classroom, detailed 

research has to be performed on the cognitive requirements of GIS tasks to determine 

the kinds of spatial analysis appropriate for students at different levels, and on the type 

and extent of GIS education and training needed by teachers and by students to use GIS 

effectively. Research is also needed to establish if GIS, when used in an inquiry-based 
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approach to learning, helps students to become critical thinkers. Only then can suitable 

software be designed, appropriate curriculum materials created, and adequate teacher 

training be instituted. 

Software has to be designed specifically for K-12 education, with an interface 

and functionality directed to the requirements of the young student and of the 

curriculum. Terminology must be standardized, preferably adapting the already 

comprehensive and well accepted cartographic vocabulary. Separate documentation 

will have to be written for teachers and students, assuming little or no technological 

background. Software designers will also have to accept the reality of the school 

situation at this time and recognize that to service this market effectively requires 

programs which will run on existing hardware. 

Once all these pieces are in place, GIS will have to face one of the largest 

hurdles to its full integration into the curriculum, that of institutional acceptance. New 

technologies are frequently seen as a threat, involving disruption of known classroom 

patterns and necessitating the need to learn new skills. GIS will have to demonstrate its 

ecological validity to convince teachers and administrators that the required fundamental 

change in classroom practice and the increases in technological and financial support of 

school bureaucracy will be worth while. 
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Appendix A 

Systematic and Student Evaluation-Data Set Preparation 
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DATA SET PREPARATION 

The data set used in the systematic and student evaluation consisted of six map 

layers for Thornapple Township in Barry County, approximately thirty miles north 

northeast of Kalamazoo (Table 33). This data set was available in vector-based format 

in C-Map from the Barry County Mapping Department and in raster-based format, with 

the exception of the map layer ELEVATION, in Map II from the Geography 

Department of Western Michigan University, where it was used in a GIS course. 

Map Layer 

Thome! 

Th94 

Lakes 

Rivers 

Roads 

Highway 

Table 33 

Systematic and Student Evaluation Data Set 

Description and Source Map Number of Classes 

Elevation point data (USGS 1 :24,000) 17,000 points 

Land cover/use 1994 (Miris 1978) 30 

Lakes (Miris) 2 

Rivers (Miris) 2 

Country roads (Miris) 2 

Highway M 37 Hastings to Grand Rapids 2 
(Miris) 

USGS-United States Geological Survey. 
Miris-Michigan Resource Information System. 

Each image is geo-referenced to the State Plane coordinate system ( 1927). The 

topographic map was created by the researcher during an internship with the Barry 

County Mapping Department by digitized the ten foot contour lines of 1 :24,000 USGS 

quads. The other map layers were created by the Mapping Department from Miris 
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maps (Michigan Department of Natural Resources) and modified usmg aerial 

photographs and parcel maps. In raster format each image has cell resolution of 160 

feet, and a file size of 200 rows and 200 columns containing 4 or 8 bit data. This data 

base had to be converted into different formats for entry into the GIS programs. 

File Preparation 

To allow for unbiased evaluation of the GIS programs, care was taken to ensure 

all the map layers looked as similar as possible in each of the GIS by using 

predetermined colors for each map layer. An effort was also made to create raster and 

vector maps which looked similar and contained the same information. For instance, 

information detailed in the legends of raster maps was added to the attribute tables of 

the vector maps, e.g., the explanation of landuse codes. 

The six map layers were taken from C-Map and prepared for importing into the 

GIS programs in the following manner: 

1. Thorne! was a topographic map containing over 17,000 points. This was

exported out of C-Map as an Arc coverage (Arclnfo file). In this project a 

hyposmetrically tinted elevation map drawn at 20 foot contour intervals was required. 

To achieve this, the Arc coverage was converted to a point grid using Arclnfo 

POINTGRID. A 200 by 200 grid was used and a look-up table was created to convert 

the elevation range of 700 to 1000 feet to 70 to 100, so it could be exported as an 

ERDAS 8 bit data grid file. The file was then imported into IDRIS! using the software 

specific module ERDIDRISI. Here it was converted into a point vector file using 

POINTVEC. The satisfactory running of the interpolation module required that the 

number of pixels be thinned. This was done by a factor of two using CONTRACT. 

INTERPOL was then run using a search radius of 6 cells. The map was projected back 

onto its original coordinate system (State Plane, 1927) using RESAMPLE. The map 
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was recoded with RECLASS to simulate a 20 foot contour interval. Since the 

elevations were at this point reduced by a factor of 10, 2 foot intervals were used. The 

file was exported using the software specific module ERDIDRISI as an ERDAS 8 bit 

file. This was taken into Arclnfo and GRID POLY used to create a polygon file. A 

look up table was required to re-establish the correct elevation range of 700 to 1000 

feet. This created a somewhat stepped polygon map, but it was deemed adequate for 

the purpose. This file was named ELEV A TION. 

2. The lake map layer was available in C-Map and Map II. It was exported

from C-Map as an Arc line coverage. This coverage was converted into a polygon file. 

This was done so the lakes could be colored with a fill pattern, following map 

convention and allowing the vector and raster portrayals to look similar. These files 

were renamed LAKES. 

3. The river map layer was available in C-Map and Map II. It was exported

from C-Map as an Arc line coverage. These files were renamed RIVERS. 

4. The country roads map layer was available in C-Map and Map II. It was

exported from C-Map as an Arc line coverage. These files were renamed ROADS. 

5. The highway M37 map layer was available in C-Map and Map II. It was

exported from C-Map as an Arc line coverage. These files were renamed HIGHWAY. 

6. Th94 was the landuse layer. It was available in C-Map, Map II, and

Maplnfo. It was exported from C-Map as an Arc coverage. These files were renamed 

LANDUSE. 

File Conversion 

1. Arc View-the six map layers as Arc coverages could be used directly by

ArcView. Two tables were constructed. In one, CODES.dbf, the landuse codes were 

provided with a descriptive interpretation, e.g., 210 Cropland. This was joined using a 
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relational join to the attribute table of LANDUSE. A second table, HEIGHT.dbf, was 

constructed and joined to the attribute table of ELEVATION to provided a more 

accurate description of each contour interval, e.g., 700 700-719 ft. Both attribute 

tables and the table CODES.dbf were customized so that only the relevant information 

was shown and the column headings were given more descriptive aliases, where 

necessary. See Tables 34, 35, and 36 below. It was found that unless the shape field 

was made visible, shapefiles could not be made as required in one of the Student 

Evaluation Exercises. The shape field was also made visible in the ELEV A TION 

attribute table for consistency. Each map layer was custom colored using 

predetermined shades. 

Visible 

✓ 

✓ 

✓ 

✓ 

Table 34 

Attribute Table for ELEV A TION 

Field 

Shape 

Elev_id 

Area 

Perimeter 

Elev_ 

Grid_code 

ELEVATION 

HEIGHT 

Alias 

Polygon id 

Elevation 

Height 
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Visible 

✓ 

✓ 

✓ 

✓ 

Visible 

✓ 

✓ 

Table 35 

Attribute Table for LAND USE 

Field 

Shape 

Th94_id 

Area 

Perimeter 

Th94_ 

Label 

Newfield 

Descriptio 

Table 36 

Alias 

Polygon id 

Landuse Code 

Description 

Table for CODES.dbf 

Field 

Newfield 

Descriptio 

Alias 

Landuse Code 

Description 

2. Map Factory-The five of the map layers: LAKES, RIVERS, ROADS,

HIGHWAY, and LANDUSE could be imported into Map Factory from Map II. The 

final layer, ELEVATION, had to be converted from an Arc coverage into a Tiff file 

using MIPS, before it could be imported into Map Factory. Descriptive labels were 

added to every item in each legend. This was necessary as no attribute tables are 
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displayed when the maps are queried. Each map layer was custom colored using 

predetermined shades. 

3. Mapinfo-LANDUSE was already available in Maplnfo format. The Arc

coverage line and polygon files, LAKES, RIVERS, ROADS, and HIGHWAY, were 

converted into DXF files in Arclnfo using ARCDXF. A header had to be included to 

retain the coordinate information. These could then be imported into Maplnfo. 

ELEVATION contained attribute information which would be lost if a conversion to a 

DXF file was used. The ELEV A TION Arc coverage file was therefore converted into 

C-Map and then into a MIF file. Since this translation does not handle polygons within

polygons very well, which is the predominant form of polygon on this map, each 

polygon attribute had to be checked for accuracy and corrected where necessary. A 

table, CODES, was constructed to provide a description of each landuse code, e.g., 

210 Cropland. This was then joined to the attribute table of LANDUSE, using a 

relational join. A second table, HEIGHT, was constructed and joined to the attribute 

table of ELEV A TION to provided a more accurate description of each contour interval, 

e.g., 700 700-719 ft. Each map layer was custom colored using predetermined

shades. 

4. IDRISI-Difficulties were experienced in importing any file which had no

feature on its western margin. The western edge of the map was consistently shifted to 

where the first feature began, so the map layers would not overlay correctly. Therefore 

it was necessary to take the LAKE and HIGHWAY files into Arclnfo and in ARCED IT 

screen digitize a line down the western edge. The LANDUSE file was used as 

backcoverage to ensure the western edges were all correctly placed to allow map 

alignment. IDRIS! can display, but not analyze, vector files. The procedure for 

displaying these vector files is much simpler than a conventional raster overlay. 

Therefore, since the line files: RIVERS, ROADS, and HIGHWAY, were only to be 
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displayed and not analyzed, it was decided to make use of this vector display option. 

These vector line files were converted in Arclnfo into "Arc ungenerate" files which 

were imported into IDRIS! using the software specific module, ARCIDRISI. The 

LAKES and LANDUSE files were converted using POLYGRID in Arclnfo into a 200 

by 200 grid. They were exported as ERDAS 8 bit files. A look-up table had to be 

constructed for LANDUSE so that the landuse codes were translated from a range of 

112 to 622 into 1 to 30. These two files were imported into IDRIS! using the software 

specific module ERDIDRISI. The correct landuse codes and descriptions were added 

to the categories 1 through 30 in the document file in Data Entry EDIT, so they would 

be displayed in the map legend. The map showing topography had already been taken 

into IDRIS! in order to translate it into a more acceptable form for use in all the GIS 

(see above). After interpolation and resampling the file was recoded such that 2 foot 

intervals were placed in categories from 1 to 15. Using Data Entry EDIT the correct 

elevation range, 700 to 1000 ft, was added to each category, in the document file, so 

they would be displayed in the map legend. Each map layer was custom colored using 

predetermined shades. 

5. Manual GIS-The manual GIS was constructed using ArcView. A layout

template was developed, so all the map files could be displayed in an identical manner. 

Each map file was then projected into the template, the legends individually aligned so 

they would remain visible in all the overlay combinations to be used. The maps were 

then printed in color on an Apple StyleWriter ink jet printer. ELEVATION and 

LANDUSE were printed on high quality coated paper. LAKES, RIVERS, ROADS, 

and HIGHWAY were printed on transparencies. A table called CODES was 

constructed in Microsoft Word to identify the landuse codes. 

The preparation and conversion of the map files 1s summarized in flow 

diagrams in Figures 28, 29, 30, and 31. 
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Figure 28. 
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( RECLASS ) 

Erdas 8 Bit 
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GRID POLY 

MIPS 

Tiff 

MAP 
FACTORY 

RECLASS 
1 - 15 

IDRISI 

Preparation and Conversion of ELEV A TION Map File. 
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Figure 29. 
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Preparation and Conversion of LAKES and RIVERS Map Files. 
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Figure 30. 
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Preparation and Conversion of ROADS and HIGHWAY Map Files. 
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Lookup Table 

1 - 30 

Figure 31. 
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Appendix B 

Manual Geographic Information System 
(Reduced Size) 
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CODES 

Landuse Codes Description 

112 Multi-family/low rise 

113 Single family/duplex 

115 Mobilehome park 

121 Central Business District 

122 Shopping mall 

124 Strip mall 

126 Institutional 

130 Industrial 

145 Communications 

146 Utilities 

171 Open pit extractive 

193 Outdoor recreation 

194 Cemeteries 

210 Cropland 

230 Confined feeding 

240 Permanent pasture 

290 Other agriculture 

310 Herbaceous openland 

320 Shrubland 

412 Central hardwood 

413 Aspen/white birch 

414 Lowland hardwood 

421 Pine 

423 Lowland conifer 

520 Lakes 

530 Reservoirs 

611 Wooded wetland 

612 Shrub/scrub wetland 

621 Aquatic bed wetland 

622 Emergent wetland 
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Appendix C 

Protocol for Systematic Evaluation 
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NAME: 

COST: 

SYSTEMATIC EVALUATION 

single copy ---------------------------- Licence 
student ___________________________ _ 

PLATFORM 

0 PC D Mac 0 Both D Workstation

HARDWARE REQUIREMENTS 

Memory (RAM) ----------------------------------------------------

Hard disk capacity ___________________________________________________ _ 

DATA REPRESENTATION 

D Raster D Vector D Raster/display vector D Vector/display raster

DATA ENTRY 

□ Tablet digitizing

Scanned maps

□ Screen digitizing

Common data formats

□ Registration

D by relative position D by absolute position

MAP MANIPULATIONS OPERATIONS 

Operations available Number of actions need to implement 

□ Map retrieval 1 2 3 4 5 6 7 8 9 10 

□ Zoom 1 2 3 4 5 6 7 8 9 10 

□ Find point coordinates 1 2 3 4 5 6 7 8 9 10 

□ Search by attribute 1 2 3 4 5 6 7 8 9 10 

□ Classification 1 2 3 4 5 6 7 8 9 10 

□ Find point coordinates 1 2 3 4 5 6 7 8 9 10 

□ Attribute editing 1 2 3 4 5 6 7 8 9 10 

□ Rescale 1 2 3 4 5 6 7 8 9 10 

□ Subset 1 2 3 4 5 6 7 8 9 10 
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MEASUREMENT OPERA TIO NS 

Operations available Number of actions need to implement 

□ Distance between object pairs 1 2 3 4 5 6 7 8 9 10 

□ Area of polygon/zone 1 2 3 4 5 6 7 8 9 10 

□ Perimeter of polygon/zone 1 2 3 4 5 6 7 8 9 10 

LOCATIONAL ANALYSIS 

Operations available Number of actions needed to implement 

□ Visual overlay 1 2 3 4 5 6 7 8 9 10 

□ Logical overlay 1 2 3 4 5 6 7 8 9 10 

□ Buffer zone generation 1 2 3 4 5 6 7 8 9 10 

DATA OUTPUT 

Printer compatibility 

□ Dot matrix □ Ink-jet □ Laser

Operations available Number of actions needed to implement

□ Layout window 1 2 3 4 5 6 7 8 9 10 

□ Map annotation 1 2 3 4 5 6 7 8 9 10 

□ Feature labels 1 2 3 4 5 6 7 8 9 10 

□ Color 1 2 3 4 5 6 7 8 9 10 

□ Line styles 1 2 3 4 5 6 7 8 9 10 

□ Standard graphic symbols 1 2 3 4 5 6 7 8 9 10 

□ Map printing 1 2 3 4 5 6 7 8 9 10 

Quality
Poor Excellent 

1 2 3 4 5 

Tutorial □ Hardcopy □ On-line

Poor Excellent

1 2 3 4 5 

Serious limitations: 
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Appendix D 

Hardcopy Output for Computerized GIS 
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Appendix E 

Protocol Clearance From the Human Subjects 
Institutional Review Board 
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Kalamazoo. Michigan 49008-3899 

616 387-8293 

WESTERN MICHIGAN UNIVERSllY 

Date: March 8, 1996 

To: C. Sonia W ardley 

From: Richard Wright, Chair 

Re: HSIRB Project Number 96-03-02 

This letter will serve as confirmation that your research project entitled "The potential role of 
geographical information systems in high school geography education in the Kalamazoo Valley and 
Calhoun County Intermediate School Districts" has been approved under the exempt category of 
review by the Human Subjects Institutional Review Board. The conditions and duration of this 
approval are specified in the Policies of Western Michigan University. You may now begin to 
implement the research as described in the application. 

Please note that you must seek specific approval for any changes in this design. You must also 
seek reapproval if the project extends beyond the termination date. In addition if there are any 
unanticipated adverse reactions or unanticipated events associated with the conduct of this research, 
you should immediately suspend the project and contact the Chair of the HSIRB for consultation. 

The Board wishes you success in the pursuit of your research goals. 

Approval Termination: March 8, 1997 

xc: Joseph Stoltman, GEOG 
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Demonstration Materials for Student Recruitment 
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STUDENT RECRUITMENT 

Three problem scenarios were outlined to the students and solved as described 

below: 

1. Biodiversity Park. You are the GIS specialist with the Michigan Department

of Natural Resources (DNR). Michigan wishes to develop a State park which will 

demonstrate the advantages of biodiversity. There are three requirements: (1) the area 

must have as much biodiversity _of habitat as possible, (2) the park must be over 60 

square miles in area, and (3) the park must be on State or Federal lands. You have 4 

maps of Michigan which you can use: Landcover of Michigan, Forests of Michigan, 

Rivers, and Administrative Units of Michigan. The procedure to solve this problem 

would be as follows: (a) combine the Landcover, Forest, and Rivers map layers to 

form a habitat map, (b) find areas of greatest biodiversity, (c) group these to find the 

contiguous areas of over 60 square miles, and ( d) find where these areas of greatest 

biodiversity are on State or Federal lands. This would only be a starting point. 

Biologists and natural resource experts would have to survey each possible site to 

catalogue the present flora and fauna populations, to determine the optimum size of the 

park, and the logistics of dealing with large numbers of people visiting to the park. The 

County Roads map layer could be added to the final map to study accessibility to 

possible sites (Figure 32). 

2. Regional Sales Office Sites. You work for a company which is expanding

rapidly and needs to find new sites for regional sales offices and distribution centers. 

The sales manager has determined the requirements for possible sites: (1) they should 

be within 7 miles of a city, so there will be an available labor supply, (2) they should 

not be within the city limits as land prices may be too high as a large area of land will be 
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needed, and (3) the present land use should be agricultural, range, or barren land as 

rezoning of these landuses may be more feasible. You have 2 maps of Michigan which 

you can use: Landcover of Michigan and Cities. The procedure to solve this problem 

would be as follows: (a) draw 7 mile buffers around each city, (b) find areas of 

acceptable landuse (agricultural, range or barren land), and (c) find where there is 

acceptable land within the 7 mile buffers around the cities. These would be possible 

sites for regional sales offices. This again would be only a starting point. The next 

stage would be to look at communications and possible sales regions (Figure 33). 

3. Most Cost Effective Route for a New Power line. You work for a utility

company in the northern Lower Peninsula. Roscommon is a small but expanding 

community near Cadillac, which needs a new power source. This will come from 

Cadillac. You will use a GIS to determine the most cost effective route for the new 

power line. You will assume: (1) the least expensive route would be over agricultural, 

range, and barren lands, (2) it is more expensive to go through forest, since it has to be 

cleared, however deciduous trees provide more valuable wood than coniferous trees, 

and (3) routes through urban areas, over wetlands, and lakes are too expensive and 

may be prohibited by legislation. You have 2 maps of Michigan which you can use: 

Landcover for Michigan and Cities from which you subset out the area under study. 

The procedure to solve this problem would be as follows: (a) determine appropriate 

weightings for the various land uses, (b) construct a cost surface from Cadillac, and ( c) 

find the most cost efficient route from Cadillac to Roscommon (Figure 34). 

The procedures for solving these problems as outlined above could not be 

demonstrated in real time as this would take too long. The map files were exported out 

of ERDAS and imported into IDRISI using the ERDIDRISI module. Maps were 

prepared to illustrate each of the principal stages of the problem solution. These were 

exported using ERDIDRISI as ERDAS files and imported into ArcView for the 
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demonstration. Here, with the judicious use of color and transparent backgrounds, it 

was possible to overlay the map layers to simulate the problem solving process in a 

matter of minutes, for each of the scenarios. 
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Biodiversity Park 

Problem: Identification of areas, over 100 sq. km. in size, on State and Federallands, showing greatest biodiversity. 
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Biodiversity Park-Problem Solving Methodology. 
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Commercial Site Selection 

Problem: Possible sites for regional sales and distribution centers in Michigan. 
Requirements: Sites outside city limits, but under 10 km of large cities (over 15 
sq.km.). Present landuse-agricultural land, rangeland, or barren land. 
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Commercial Site Selection-Problem Solving Methodology. 
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Powerline Route 

Problem: To determine the most cost effective route for a new power line 
between Cadillac and Roscommon. 
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Figure 34. Routing of a Power Line-Problem Solving Methodology. 
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Appendix G 

Materials for the Student Evaluation 
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Road 1 

INTRODUCTION TO GIS 

Vector System 

Coniferous 
"'Forest 

A vector system can show 3 types of features: 
Points, e.g., well site 
Lines, e.g., railroad 
Polygons, e.g., area of forest 

■ 

Building 

There are 5 features on the map: one point feature, three line features, and one polygon 
feature. Take each one and on the table below enter its Feature Type (point, line, or 
polygon), give it a unique number as an Object ID, and give it an Attribute (what is it?). 
One is done for you. 

Feature Type Object ID Attribute 
Point 1 Building 
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Raster System 
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The raster system shows all features in the same way, as pixels (cells or squares). 
Each pixel is given a code number to signify what it represents, 
e.g., coniferous forest-code 1, deciduous forest-code 2.

There are 5 features on the map. ON THE MAP write in the code for each pixel to 
show which feature it represents. 
In this example give: Background-code 0 

Coniferous Forest-code 1 
Roads-code 2 
River-code 3 
Building-code 4 

When complete, enter the code given to each of the pixels listed in the table. 
To find the pixel number "read right, then down," 
e.g., the building is in pixel number: 6.1.

Pixel Number Code 
0.0 2 

0.1 

2.2 

2.4 

4.5 

6.1 

4.3 
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INSTRUCTIONS FOR EXERCISES-FIRST SET. 

Group: _ _ Time: Start __ _ 

Finish __ _ 

ARCVIEW (BLUE-1) 

This GIS requires vector (lines) maps. It can display raster maps, but they can not be 

queried or analyzed. 

In this program maps are called Themes and all the maps (themes) which you will 

need are organized into a Project called Thornapple.apr. Within this project the 

maps (themes) are further grouped into 2 Views called Exercise 1 and Exercise 2. 

Exercise 1 

Concept: Human and environmental interaction. One way in which the environment 

affects human activity can be seen in the rectangular survey system, which was used to 

divide the land in many states including Michigan. The surveyors measured the land 

into one mile square sections. Each six by six mile block of land (36 sections) was 

called a township. Settlers bought 40 acres, quarter sections, or half sections of land to 

farm (see below). 

� 

West 

1 mile 

One section 

640 acres 

North 

40 
Quarter acre, 
section --

160 acres 

Half section 
320 acres 

South 

Rectangular Survey 

East 
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Research Question: How did the environment affect the rectangular survey in 

Thornapple Township? Thornapple Township is in north west Barry County, about 

half way between Hastings and Grand Rapids. 

To begin: 

Make sure the Thornapple.apr Project box is visible on the screen. 

(If not: Go to File-> Open Project 

Select Thornapple folder 

Scroll down and choose Thornapple.apr 

Click Open.) 

Thornapple.apr Project box contains all the maps needed for Exercise 1 and 2. 

Click on Exercise 1 - it will be highlighted in black. 

Click Open. 

The elevation of Thornapple Township will be displayed. 

IF THIS DOES NOT APPEAR OR IT HAS OTHER LAYERS SHOWING AS WELL 

ASK FOR HELP. 

A displayed map is called a Theme and the list of other maps available in that View 

(Exercise 1 ), along with their legends, are displayed on the left hand side of the map. 

This list is called the Table of Content. 

The map which is displayed shows how the height of the land varies throughout 

Thornapple Township. The legend shows which color represents which height. For 

instance the darkest green is used to represent all heights from 700 to 719 feet. Since it 

is difficult to distinguish some of the colors on the map, explore the map using the 

Information Tool. 

Make sure the map is selected by clicking BY the legend of ELEVATION, so that it 

appears raised. That means there is a fine gray line above and below the ELEV A TION 

legend. This means it is selected. 

Click on the Information Tool (1st button on second row of tool bar) (i). 

The cursor will become crosshairs as you move it across the map. 
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Click anywhere on the map. The height at that point is shown in an Identify Results 

box in the middle of the screen. 

Move the box to the lower left of the screen by click and dragging on top bar. 

Double click on the map to find another height. 

Describe where the lowest elevation on the map is located. (The map is aligned 

conventionally with north at the top of the screen.) 

Describe where the highest elevation on the map is located. 

Try to get some idea of the shape of the land. 

Close the Identify Results box by clicking on the square in the upper left hand comer of 

the box. 

To close ELEV A TION - click on the ✓ in the small box to the left of the word

ELEVATION in the Table of Content (the list on the left). The ✓ and map disappear.

Now look at the hydrology (lakes and rivers). 

To open LAKES click on the small box to left of LAKES in the Table of Content, ✓ 

and map appears. 

The map which is displayed shows lakes in Thornapple Township. 

Look at their sizes and distribution. 

Overlay the rivers. 

To open RIVERS click on the small box to left of RIVERS in the Table of Content, ✓ 

and map appears. 

This shows the drainage pattern. The area is drained by the Thornapple River and its 

tributaries. 

Now look at the hydrology and the elevation together. 
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To open ELEVATION click on the small box to left of ELEVATION in the Table of 

Content, ✓ and map appears. 

However it has obscured the hydrology. The order of maps in the Table of Content is 

important. ELEV A TION contains no transparent portions, therefore it has to be drawn 

first and the other layers drawn on top of it. The maps in the Table of Content are 

drawn in order from the bottom of the list up, therefore you have to move 

ELEV A TION to the bottom of the list. 

To do this, click BY the legend of ELEV A TION to select it, then click and drag the 

legend to the bottom of the list in the Table of Content. The map will be displayed first 

and LAKES and RIVERS on top of it. 

You can see all the lakes and rivers as well as the elevation. 

What is the elevation of the large lake in the north west? 

Close the Identify Results box if you used it, by double clicking on the square in the 

upper left hand comer. 

This is the environment in which the surveyors had to work when they laid out the 

rectangular survey system. You can see evidence of their work in the road pattern. 

Overlay the layer ROADS on your map. 

To open ROADS click on the small box to left of ROADS in the Table of Content, ✓

and map appears. 

Look carefully at the map. 

Describe where on the map the rectangular survey is most obvious. 

To close this exercise, click on the ✓ by ROADS, RIVERS AND LAKES to close 

them. 

Keep ELEVATION open and make sure it is selected. Move ELEVATION to the top of 

the list again by clicking and dragging legend to top of the Table of Content. 

Close Exercise 1 by clicking on small box in top left corner of MAP window. 
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Exercise 2 

Concept: Human and environmental interaction. Here you will look this concept from 

the opposite perspective. How do people impact the environment. Wetlands are now 

considered vital to the health of the ecosystem. However they are increasingly under 

threat from residential and industrial development. 

Research Question: Are urban developments encroaching on wetlands in 

Thornapple Township? 

Begin by looking at the landuse in Thornapple Township. 

Click on Exercise 2 in the Project box for Thornapple.apr. - highlighted black. 

Click Open. 

This will open Exercise 2 - This contains all the maps needed for Exercise 2. 

A new map will be displayed. This is a landuse map which shows how land is used in 

Thornapple Township. 

IF THIS DOES NOT APPEAR OR IT HAS OTHER LAYERS SHOWING AS WELL 

ASK FOR HELP. 

The legend shows which colors represents which landuse codes. Landuse codes are 

used to classify the different types of landuse. 

Explore the map using the Information Tool. 

Make sure the map is selected by clicking BY the legend of LANDU SE, so that it 

appears raised. That is there is a fine gray line above and below the LANDUSE legend. 

This means it is selected. 

Click on the Information Tool (1st button on second row of tool bar) (i). 

The cursor will become crosshairs as you move it across the map. 

Click anywhere on the map. The landuse code and its description at that point are 

shown in the Identify Results box. You may have to enlarge the box to see the whole 

description. 

Move the box to the lower left of the screen by click and dragging on top bar, so that 

you can see as much of the map as possible. 

Double click on the map to find another landuse. 
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Which landuse covers the largest area? (Give the code and the description.) 

Close Identify Results box by double clicking on the square in the upper left hand 

corner. 

Even with the Information Tool it is difficult to distinguish landuse patterns. Therefore 

you will now direct the computer to select and show some features on their own. This 

is called "querying." 

You will direct the computer to show all the areas of wetlands and then all the areas of 

residential, commercial, and industrial development. Then you will direct the computer 

to show where there are areas of residential, commercial, and industrial development 

within 500 feet of wetlands. These are the areas which may be encroaching upon and 

endangering the wetlands. 

However first you will need to determine which codes are used for these landuses. 

If necessary move map to right by clicking and dragging on the top bar, so that you can 

see the Project box for Thomapple.apr. 

Double click on Tables (2nd icon down) in Project box. 

Choose CODES.DBF by clicking on it - it will be highlighted in black. 

Click Open. 

Scroll through the table. 

Which range of codes denotes residential, commercial, and industrial use? 
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Which range of codes denotes wetlands? _______________ __ 

Close Table by double clicking on the square in the upper left hand comer. 

Click on Views (1st icon) to return to the map. 

Click on the map to make it active - top bar becomes striped. 

Move map to left so that it is all visible. 



www.manaraa.com

To query you have to direct the computer where to look for the features you want to 

see. 

Make sure LAND USE is selected. (Click BY legend of LANDU SE, so that it appears 

raised.) 

Now you will direct the computer to choose all the areas that have a coding for 

wetlands, that is a code of 611 and above. 

Go to Theme-> Properties. 

Properties box opens. 

Under Definition click on Query Builder button (hammer and ?). 

Query Builder box opens. 

Here you have to place the statement which tells the computer exactly what to do. It is 

therefore very important to get the wording exactly right! So follow the directions 

carefully. 

Under Fields. 

Double click on Landuse Code (that is the column in which the landuse codes are 

listed). 

The word "Landuse Code" will appear in the box. 

Click on >= (greater than or equals) - this will appear in box. 

Under Values scroll down and double click on 611. 

The Query should read: 

([Landuse Code]I >= 611) 

Click on OK. 

Click on OK in Theme Properties box. 

The progress of the procedure is shown by the blue line under the Tool Bar. 

All the wetlands will be displayed. 

This map has to be converted into a file so that you can keep it to work on. 

Go to Theme-> Convert to Shapefile. 

Under Convert LANDUSE, in box 

Type in name: WETLANDS.shp 

Click Save. 

Click on "Yes" to question "Add Shapefile as a theme to a view?" 
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When asked "Add theme to:" 

Click on "Exercise 2" (highlighted in black.) 

Click OK. 

WETLANDS.shp is now added to the Table of Content. 

Although the Wetlands appears to be displayed, this is not the new file, only the 

selected areas on the LANDUSE map. To display the new map, click on the ✓ by 

LANDUSE to remove it, then click on the box by WETLANDS.shp so that ✓ and the 

map appear. 

You will now color the wetlands an appropriate color. 

First you need to make the layer selectable. 

Click By the legend of WETLANDS.shp, so that it appears raised. 

Double click on the colored legend box under WETLANDS.shp in the Table of 

Content. 

Legend Editor opens. 

Double click on the colored box in the table section below the word: "Symbols." 

Fill Palette box opens. Make sure there is a black line around the solid black square. If 

not click on it. 

Click on the button with the colored paintbrush (5th from left at top of Fill Palette box). 

Color Palette opens. 

Choose a bright shade of turquoise by clicking on a colored square. 

Close Color Palette by clicking on square in top left of Palette. 

The box should now be turquoise (the box in the table section below the word: 

"Symbols.") 

Click on Apply. 

The legend box in the Table of Content should now be turquoise. 

Close the Legend Editor by clicking on square in top left. 

Wetlands should be colored turquoise. 

Look carefully at the distribution of wetlands. 

To check that only wetlands are shown, click on Table button on tool bar (5th from left 

on top bar). 

Scroll quickly through the table. Check only wetlands are shown. 
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How many wetlands are there in Thornapple Township? (Look at the line beneath the 

tool bar - this will tell you how many polygons are wetlands.) 

Close Table by clicking on the square in the upper left hand comer. 

Click on ✓ by WETLANDS.shp to remove map. 

Click on box to left of LAND USE to display original map. ✓ and map will appear, 

however it will show the selected wetlands not the total landuse. 

To return the LANDUSE map to its original form: 

Select LANDUSE by clicking BY1egend so that it appears raised. 

Go to Theme-> Properties. 

Click on CLEAR to remove query statement. 

Click OK. 

The original landuse map will be displayed. 

To find all the residential, commercial, and industrial areas (they are called urban from 

now on), you will direct the computer to find all the areas with a coding of 130 or less. 

(Communication, utilities, open-pit extractive, and cemeteries are excluded here for 

simplicity.) 

Go to Theme -> Properties. 

Properties box opens. 

Under Definition click on Query Builder button (hammer and ?). 

Query Builder box opens. 

Here you have to place the statement which tells the computer exactly what to do. It is 

therefore very important to get the wording exactly right! So follow the directions 

carefully. 

Under Fields. 

Double click on Landuse Code (that is the column in which the landuse codes are 

listed). 

The word "Landuse Code" will appear in the box. 

Click on <= (less than or equals) - this will appear in box. 
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Under Values double click on 130. 

The Query should read: 

([Landuse Code]I <= 130) 

Click on OK. 

Click on OK in Theme Properties box. 

All the urban areas will be displayed. 

This map has to be converted into a file so that you can keep it to work on. 

Go to Theme-> Convert to Shapefile. 

Under Convert LANDUSE, in box 

Type in name: URBAN.shp 

Click Save. 

Click on "Yes" to question "Add Shapefile as a theme to a view?" 

When asked "Add theme to:" 

Click on "Exercise 2" (highlighted in black). 

Click OK. 

URBAN.shp is now added to the Table of Content. 

Although the URBAN appears to be displayed, this is not the new file, only the 

selected areas on the LANDUSE map. To display the new map, click on the ✓ by 

LANDUSE to remove it, then click on the box by URBAN.shp so that ✓ and the map 

appear. 

You will now color the urban areas an appropriate color. 

First you need to make the layer selectable. 

Click BY legend of URBAN.shp, so that it appears raised. 

Double click on the colored legend box under URBAN.shp in the Table of Content. 

Legend Editor opens. 

Double click on the colored box in the table section below the word: "Symbols." 

Fill Palette box opens. Make sure there is a black line around the solid black square. 

Click on the button with the colored paintbrush (5th from left at top of Fill Palette box). 

Color Palette opens. 

Choose a bright yellow by clicking on a colored square. 

Close Color Palette by clicking on square in top left of Palette. 
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The box should now be yellow (the box in the table section below the word: 

"Symbols.") 

Click on Apply. 

The legend box in the Table of Content should now be yellow. 

Close the Legend Editor by clicking on square in top left. 

Urban should be colored yellow. 

Look carefully at the distribution of urban areas. 

To check that only urban polygons are shown, click on Table button on tool bar (5th 

from left on top bar). 

Scroll quickly through the table. Check only urban landuses are shown. 

How many urban landuse polygons are there in Thornapple Township? (Look at the 

line beneath the tool bar - this will tell you how many polygons are urban.) 

Close Table by clicking on the square in the upper left hand comer. 

Click on ✓ by URBAN.shp to remove map. 
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Click on box to left of LANDU SE to display original map. ✓ and map showing selected 

urban areas not the total landuse map will appear. 

To return LANDUSE map to its original form: 

Select LANDUSE by clicking BY legend so that it appears raised. 

Go to Theme-> Properties. 

Click on CLEAR to remove query statement. 

Click OK. 

The original landuse map will be displayed. 

To display the wetlands and urban areas together: 

Click on ✓ by LANDUSE to remove this map. 

Click in the boxes to the left of the WETLANDS.shp and URBAN.shp maps so that ✓ 

appears. The maps will appear overlaid. 
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Although you can now clearly see all the wetlands and all the urban areas, it is still 

difficult to see every place where they are in close proximity. 

You will now direct the computer to answer the question: "Which urban areas are 

within 500 feet of wetlands?" 

You will do this by directing the computer to create 500 foot buffer zones (or circles) 

around each wetland and then to find which urban areas fall within these buffer zones. 

This next step is tricky, so make sure you follow the instructions precisely. 

Make sure that URBAN.shp is selected by clicking BY legend, so that it appears 

raised. It is now active. 

Go to-> Theme ->Select by Theme ... 

Enter the following: 

Select features of active themes that: Scroll down and select "Are Within 

Distance Of' 

the selected features of Scroll down and select WETLANDS.shp 

Selected Distance: type 500 

Click New Set. 

The map displayed will show no buffer zones, but the urban areas within 500 feet of a 

wetland are highlighted in red. The other urban areas are still yellow and the wetlands 

are all turquoise. 

To enlarge an area click on Zoom-in Tool on tool bar (4th from left). 

Click on center of map -it will enlarge with each click. 

Click on Grabber Tool on tool bar (6th from left). 

Click and drag to move the map around so that you can inspect other areas. 

NOTICE that the whole polygon is highlighted even when only a small part of it is 

within 500 feet of a wetland. 

Is it possible to see which areas are within the 500 foot buffer zone? Explain your 

answer. 
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Use the Zoom-out Tool (5th from left right) to return map to original size, reposition it 

with Grabber Tool (6th from left). 

Overlay the Roads on the map. 

To overlay ROADS click on the small box to left of ROADS in the Table of Content, ✓ 

and map appears. 

Overlay the main Grand Rapids-Hastings HIGHWAY in the same way. 

How would you describe the distribution of the wetlands most under threat from urban 

expansion? 

Does this GIS give you an accurate picture of which wetlands are most under threat? 

Explain your answer. 

Close ROADS, and HIGHWAY, by clicking on the ✓ marks. 

Select URBAN.shp (so that it is raised), go to Edit-> Delete Themes. 

Select WETLANDS.shp (so that it is raised), go to Edit-> Delete Themes. 

Open LANDUSE and select (so that it is raised). 

Go to File-> Close All. 

Now please could each student fill in a questionnaire on this GIS. 
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Group: __ Student A: 

ARCVIEW (BLUE) 

What did you like about the way this GIS performed the overlays in Exercise 1? 

What did you dislike about the way this GIS performed the overlays in Exercise 1? 

What did you like about the way this GIS performed the analysis in Exercise 2? 

What did you dislike about the way this GIS performed the analysis in Exercise 2? 

How well did this GIS define (show) the endangered wetlands in Exercise 2? 

FINISHED 

Return these instructions to the front desk. 

While you take a break discuss what you have just done. What did you like and dislike 

about this GIS? How effective was it at helping you solve the research questions? 

Remember you will be asked to rank and comment on this GIS program at the end of 

the session. 
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INSTRUCTIONS FOR EXERCISES-SECOND SET. 

Group: __ Time: Start __ _ 

Finish 
---

IDRISI (GREEN-2) 

This GIS can display both raster (pixel) and vector (lines) maps, but can only analyze 

raster maps. The raster maps are called image files and the vector maps are called 

vector files. 

Exercise 1 

Concept: Human and environmental interaction. 

Research Question: How did the environment affect the rectangular survey in 

Thornapple Township? Thornapple Township is in north west Barry County, about 

half way between Hastings and Grand Rapids. 

To begin: 

Go to menu Environment-> Environ 

Check you are in correct directory (Top box). 

Path of working data directory: c:\idrisi\thomapp\exl 

(If not: in large central box: 

under Drive: select c:\ 

under Directory double click on c:\ 

scroll and double click on idrisisw 

double click on thornapp 

double click on ex 1 

Make sure Path of working data directory: reads c:\idrisi\thornapp\exl.) 

Click OK. 

To display the first map: 

Go to menu Display-> Display Launcher. 

Enter the following: 
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Type of file: image file (this is raster). 

Name of file to display: double click on empty box 

Click on ELEV on list (this will highlight it in blue) 

Click OK. 

Map Components: click on legend (x appears in box). 

Palette options (these are the colors): double click on User Defined empty box 

Click on ELEV on list (this will highlight it in blue) 

Click OK. 

Click OK. 

The elevation of Thornapple Township will be displayed. 

IF THIS DOES NOT APPEAR ASK FOR HELP. 

The legend shows which color represents which height. 

What is the range of codes? _________________ _ 

Explore the map using the information Tool. 

Click on the Information Tool ( J, ?) on the tool bar (7th from left). 

The cursor will become crosshairs as you move it across the map. 

Click anywhere on the map. The code at that point is shown at the bottom right of the 

screen: the z: is the code. The corresponding height is given in the legend. 

As you move the crosshairs across the map the column (c) and row (r) numbers of the 

pixels and the x and y coordinates change in the boxes at the bottom of the screen. 

Move the crosshairs about until: x = 1700338.0 and y =442787.6, then carefully click. 

What is the height of the land at these map coordinates? 

Close this map. Double click on small box in top left corner of the MAP window. 

Now look at the hydrology (lakes and rivers). 

Go to menu Display-> Display Launcher (or 4th from left on tool bar - world map). 

Enter the following: 

Type of file: image file (this is raster). 
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Name of file to display: double click on empty box 

Click on LAKES on list (this will highlight it in blue) 

Click OK. 

Map Components: click on legend (x appears in box). 

Palette options: double click on User Defined empty box 

Click on LAKES on list (this will highlight it in blue) 

Click OK. 

Click OK. 

Notice that the background is white and in the legend it is classified as zero - this means 

that it is transparent. The LAKES are classified as 1. This becomes important later. 

Now we can overlay the RIVERS. This is a vector layer (lines as opposed to pixels) so 

it can be displayed directly on top of the LAKES. 

To the right of your map there is a tool box called Composer this shows which maps 

are being displayed, in this case LAKES. 

Click on Add Layer in Composer. 

Enter the following: 

Vector file to display: double click on empty box 

Click on RIVERS to highlight 

Click OK. 

Symbol file (this is the colors): double click on User Defined empty box 

Click on RIVERS to highlight 

Click OK. 

Click OK on original Add Layer box. 

Look at how the land is drained. 

Do you notice anything unusual about the drainage in the SW quarter of the map? 

Suggest a reason for this pattern. 

Close this map. Double click on small box in top left corner of the MAP window. 

Now look at the hydrology and the elevation together. 
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Since LAKES and ELEV are both raster maps you have to use an overlay procedure. 

Go to: Analysis-> Database Query-> OVERLAY. 

Here you choose a first map to overlay over a second map. 

Remember how on the LAKES map lakes were classified as 1 and the background was 

classified as zero, which is transparent. The ELEV was classified from 2 to 16. 

Therefore if we overlay LAKES over the ELEV the lakes ( 1) will show on top and the 

elevation (2-16) will show through the transparent background of LAKES. The top 

map must have transparent background and all the codes must be different if they are to 

be seen as separate features after overlay. 

Therefore enter the following: 

First Image: double click on empty box 

Click on LAKES to highlight ( or double click) 

Click OK. 

Second Image: double click on empty box 

Click on ELEV to highlight ( or double click) 

Click OK. 

Output Image: Click to place cursor in box then type on keyboard: ENVIRON. 

Overlay options: Click on last one - First covers Second except where zero. 

Click OK. 

A blue line in bottom left box of screen will show the progress of this overlay 

procedure. When complete you can display the map you have created. 

Go to Display-> Display Launcher. 

Enter the following: 

Type of file: image file (this is raster). 

Name of file to display: double click on empty box 

Click on ENVIRON to highlight ( or double click) 

Click OK. 

Map Components: click on legend (x appears in box). 

Palette options: double click on User Defined empty box 

Click on ENVIRON to highlight ( or double click) 

Click OK. 
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Click OK. 

A new map will be displayed. You can see all the lakes ( 1) as well as the elevation (2-

16). You may have to scroll through the legend to see it all. 

Add the RIVERS (vector). 

Go to Composer (to the right of your map). 

Click on Add Layer. 

Enter the following: 

Vector file to display: double click on empty box 

Click on RIVERS to highlight (or double click) 

Click OK. 

Symbol file (this is the colors): double click on User Defined empty box 

Click on RIVERS to highlight ( or double click) 

Click OK. 

Click OK on original Add Layer box. 

Look carefully at the map. 

Which part of the principal river valley do you think is most prone to flooding? 

What map evidence did you use to determine this? 

Add the vector layer ROADS to your map. 

Go to Composer (to the right of your map). 

Click on Add Layer. 

Enter the following: 

Vector file to display: double click on empty box 

Click on ROADS to highlight ( or double click) 

Click OK. 

Symbol file: double click on User Defined empty box 

Click on ROADS to highlight ( or double click) 

Click OK. 
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Click OK on original Add Layer box. 

Look carefully at the map. Although there is plenty of evidence of the rectangular 

survey system in the road pattern, there are deviations. 

Describe any deviations you can see on the eastern half of the map. 

What has caused these do you think from the map evidence? 

To close this exercise, double click on small box in top left comer of the MAP window 

for each map. 

Exercise 2 

Concept: Human and environmental interaction. 

Research Question: Are urban developments encroaching on wetlands in 

Thornapple Township? 

To open landuse in Thornapple Township: 

Go to Environment-> Environ (or 1st from left on tool bar). 

In large central box : double click on thomapp 

Double click on ex2 

Check the top box it should read: c:\idrisiw\thomapp\ex2 

Click OK. 

To display LANDUSE in Thornapple Township: 

Go to Display-> Display Launcher. 

Enter the following: 

Type of file: image file (raster). 

Name of file to display: double click on empty box 

Click on LANDUSE on list 

Click OK. 

Map Components: click on legend (x appears in box). 
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Palette options: double click on User Defined empty box 

Click on LANDUSE on list 

Click OK. 

Click OK. 

IF THIS DOES NOT APPEAR ASK FOR HELP. 

Enlarge the legend window by double clicking on legend, red dots appear at edges. 

Place the cursor on the dot on the bottom edge, it becomes a double arrow, then click 

and drag, until the legend is tall as possible. You will still have to use the scroll bar to 

see all of it. Do the same to widen the legend window. 

The legend shows which colors represents which landuse, followed by the code, then a 

description of the landuse. 

Explore the map using the Information Tool. 

Click on the Information Tool on the tool bar ( J, ?) (7th from left). 

The cursor will become crosshairs as you move it across the map. 

Click anywhere on the map. The code at that point is shown at the bottom right of the 

screen: the z: is the code. The corresponding landuse description is given in the legend. 

What is the complex red and orange area to the lower right of center? 

You will now direct the computer to select all the areas of wetlands and then all the 

areas of residential, commercial, and industrial development. However first you will 

need to determine which codes are used for these landuses. 

Scroll down through the legend and find: 

Which range of codes denotes residential, commercial, and industrial use? 
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Which range of codes denotes wetlands? ________________ _ 

To perform this query you have to reclassify the map codes so that only the ones you 

want to see will be displayed. Therefore you will recode all the landuse codes other 

than wetlands (0 to 26) to zero (transparent) and the wetlands codes (27 to 30) to 1. 
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Go to Analysis-> Database Query-> RECLASS 

Enter the following: 

Type of file to reclass: image. 

Classification type: used defined reclass. 

Input file: double click on empty box 

Click on LANDUSE on list 

Click OK. 

Output file: click and type on keyboard: WETLANDS 

Assign a new value of: click and type 0 

To all values from: click and type 0 

To just less than: click and type 27 

Click on right hand arrow to enter next code - check it reads 2 beneath the arrows. If it 

read anything more, use the left arrow to get back to 2. YOU MUST NOT HA VE ANY 

BLANK CLASSES. 

Assign a new value of: click and type 1 

To all values from: click and type 27 

To just less than: click and type 31 

Click OK. 

To display Wetlands: 

Go to Display -> Display Launcher. 

Enter the following: 

Type of file: image file (raster). 

Name of file to display: double click on empty box 

Click on WETLANDS on list 

Click OK. 

Map Components: click on legend (x appears in box).

Palette options: click on QUALITATIVE 16. 

Click OK. 

Look carefully at the distribution of wetlands. 

In which area of the map are there fewest wetlands? ___________ _ 
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Why are there few wetlands here? (You will have to think back to the maps you made 

in Exercise 1). 

Leave WETLANDS map open. 

Now you will direct the computer to find all the urban, that is all the areas in codes 1 

through 8. Therefore you will recode all the landuse codes other than urban (9 to 30) to 

zero (transparent) and the urban codes (1 to 8) to 3. Why 3 was chosen will become 

apparent later. 

Go to Analysis-> Database Query-> RECLASS 

Type of file to re class: image.� 

Classification type: used defined reclass. 

Input file: double click on empty box 

Click on LANDUSE on list 

Click OK. 

Output file: type URBAN 

Assign a new value of type 0 

To all values from: type 9 

To just less than: type 31 

Click on right hand arrow to enter next code - check it reads 2 beneath the arrows. If it 

read anything more, use the left arrow to get back to 2. YOU MUST NOT HA VE ANY 

BLANK CLASSES. 

Assign a new value of type 3 

To all values from: type 1 

To just less than: type 9 

Click OK. 

To display URBAN: 

Go to Display-> Display Launcher. 

Enter the following: 

Type of file: image file (raster). 

Name of file to display: double click on empty box 

Click on URBAN on list 

Click OK. 
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Map Components: click on legend (x appears in box). 

Palette options: click on QUALITATIVE 16. 

Click OK. 

Look carefully at the distribution of urban areas. 

Leave URBAN map open and place it next to the WETLANDS map so you can see 

both together, by clicking and dragging on top blue bar of map. 

Notice the codes for each. 

You will now direct the computer to answer the question: "Which urban areas are 

within 500 feet of wetlands?" 

To create the 500 foot buffer zones(or circles) around each wetland, this GIS will first 

construct a distance surface from every wetland to the edge of the map. You will then 

use RECLASS to define 500 foot buffer zones. 

Go to-> Analysis-> Distance Operators ->DISTANCE 

Enter the following: 

Feature image: double click on empty box 

Click on WETLANDS 

Click OK. 

Output image: type DISTANCE 

Click OK. 

This may take a while. You can monitor its progress in the lower right 

hand box, it will make 4 passes. When box is empty the analysis is 

complete. 

To display DISTANCE: 

Go to Display-> Display Launcher. 

Enter the following: 

Type of file: image file (raster). 

Name of file to display: double click on empty box 

Click on DISTANCE on list 

Click OK. 

Map Components: click on legend (x appears in box). 

Palette options: click on QUALITATIVE 256. 
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Click OK. 

To see exactly what has been done, zoom in using the Zoom-in Tool (9th from left -

magnifying glass) on tool bar. 

Click on center of map - it will enlarge. Reselect the Tool before each click. 

Use the scroll bar to move the map around so that you can inspect other areas. 

Notice the wetlands are black and each distance zone is a pixel wide. 

Use the Zoom-out Tool (8th from left - rectangle within rectangle) to return map to 

original size. Place cursor on center of map and click on RIGHT mouse button. It 

should return to original size at once. 

If necessary reposition map by dou5le clicking on the map, red dots appear at edges. 

Place the cursor on the dot on the top edge, it becomes a double arrow, then click and 

drag. 

Now you have to define the buffer zones. You will reclassifying the wetlands (0) as 1, 

the 500 foot buffer (1 to 500) as 2, and the rest of the map (501 to 10000) as 0 

(transparent). 

Go to Analysis-> Database Query -> RECLASS 

Type of file to reclass: image. 

Classification type: used defined reclass. 

Input file: double click on empty box 

Click on DISTANCE on list 

Click OK. 

Output file: type BUFFER 

Assign a new value of type 1 

To all values from: type 0 

To just less than: type 1 
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Click on right hand arrow to enter next code - check it reads 2 beneath the arrows. If it 

read anything more, use the left arrow to get back to 2. YOU MUST NOT HA VE ANY 

BLANK CLASSES. 

Assign a new value of type 2 

To all values from: type 1 

To just less than: type 501 
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Click on right hand arrow to enter next code - check it reads 3 beneath the arrows. If it 

read anything more, use the left arrow to get back to 3. YOU MUST NOT HA VE ANY 

BLANK CLASSES. 

Assign a new value of type 0 

To all values from: type 501 

To just less than: type 10000 

Click OK. 

To display BUFFER 

Go to Display -> Display Launcher. 

Enter the following: 

Type of file: image file (raster) 

Name of file to display: double click on empty box 

Click on BUFFER on list 

Click OK. 

Map Components: click on legend (x appears in box). 

Palette options: click on QUALITATIVE 16. 

Click OK. 

Wetlands appear blue with a yellow circular buffer around each. Check codes. 

To find the urban areas which are within the 500 foot buffer zones around the 

wetlands, you will use a procedure called CROSSTAB. This looks at each pixel, first 

on one map and records its value and then at the same pixel on the other map and 

records its value. The new map then shows all the possible combinations of values. 

Go to Analysis -. Database Query-> CROSST AB 

Enter the following: 

First image: BUFFER 

Second image: URBAN 

Output type: Cross-classification image 

Output image: type ENDANGER 

Click OK. 

To display ENDANGER 
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Go to Display -> Display Launcher. 

Enter the following: 

Type of file: image file (raster). 

Name of file to display: double click on empty box 

Click on ENDANGER on list 

Click OK. 

Map Components: click on legend (x appears in box). 

Palette options: click on QUALITATIVE 16. 

Click OK. 

Study the legend carefully. It tells you what combination each code represents. 

Remember: 

On the first map: BUFFER 

code O was background 

code 1 was wetlands 

code 2 was buffer zones 

On the second map: URBAN 

code O was background 

code 3 was urban 

Using this, fill in the codes for ENDANGER: 

code 1 is 0/0 - this is background/background 

code 2 is 1/0 - this is 
---------

code 3 is 2/0 - this is 
---------

code 4 is 0/3 - this is ________ _ 

code 5 is 2/3 - this is 
---------

You can now create a final map to show the wetland areas, urban areas, urban within 

buffer zones, and background. This can be done by custom coloring the map to 

improve its appearance. As you do not need the buffer zones to show, they can be 

colored the same as the background. 

Go to Display-> Palette Workshop 

Click on the SECOND black square, the number 1 beneath turns red - it is now 

active. This is code 1, the background. Move the three sliders (red, green and blue) to 

the right, so that they all read 255. The square should now be white. That's the 

background color. 

222 



www.manaraa.com

Click on the third black square, the number 2 beneath turns red - it is now active. 

This is code 2, the wetlands. Move the green and blue sliders to the right, this colors 

the square. Select a suitable blue shade for the wetlands. 

Click on the fourth black square, the number 3 beneath turns red - it is now active. 

This is code 3, the buffer. Move the three sliders (red, green and blue) to the right, so 

that they all read 255. The square should now be white. That's the background color. 

Click on the fifth black square, the number 4 beneath turns red - it is now active. 

This is code 4, the urban areas. Move the sliders to the right, this colors the square. 

Select a suitable shade e.g. yellow or green for the urban. 

Click on the sixth black square, the number 5 beneath turns red - it is now active. 

This is code 5, the urban within buffer. Move the sliders to the right, this colors the 

square. Select a suitable bright contrasting shade e.g. red, for the urban within buffer. 

Autoscale minimum: type 0 

Autoscale maximum: type 5 

To save these colors, still in Palette workshop: 

Go to File in Palette workshop -> Save as: 

Save file as: type ENDANGER 

Click OK. 

Close Palette workshop. 

To recolor the map with new palette; 

Go to Composer (to the right of your map). 

Click on Properties. 

Enter the following: 

Palette file: double click on box 

Click on ENDANGER 

Click OK. 

Click OK. 

All the urban areas that fall within a buffer are now highlighted in the bright color you 

selected. 

Click on Zoom-in Tool ((9th from left) on tool bar. 

Click on center of map - it will enlarge. Reselect Tool with each click. 
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Use the scroll bar to move the map around so that you can examine the map in more 

detail. 

Use the Zoom-out Tool (8th from left) to return map to original size. Place cursor on 

center of map and click on RIGHT mouse button. It should return to original size at 

once. Reposition if necessary. 

Add the ROADS and HIGHWAY to the map. These are vector layers. 

Go to Composer: 

Click on Add Layer. 

Enter the following: 

Vector file to display: double click on empty box 

Click on ROADS to highlight 

Click OK. 

Symbolfile (this is the colors): click on STANDARD DEFAULT 

Click OK. 

Click OK on original Add Layer box. 

Repeat and add HIGHWAY using STANDARD DEFAULT for Symbol file. 

Zoom in and scroll to examine the map in detail. 

NOTICE all the urban areas within the buffer zones are highlighted, however the 

buffer zones are only 480 feet wide because of the limitation of cell resolution (pixel 

size, which is 160 feet). 

Does this GIS give you an accurate picture of which wetlands are most under threat? 

Explain your answer. 

To close this exercise, double click on small box in top left corner of the MAP window 

for each map. 

Now please could each student fill in a questionnaire on this GIS. 
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Group: __ Student B: 

IDRISI (GREEN) 

What did you like about the way this GIS performed the overlays in Exercise 1? 

What did you dislike about the way this GIS performed the overlays in Exercise 1? 

What did you like about the way this GIS performed the analysis in Exercise 2? 

What did you dislike about the way this GIS performed the analysis in Exercise 2? 

How well did this GIS define (show) the endangered wetlands in Exercise 2? 

FINISHED 

Return these instructions to the front desk. 

While you take a break discuss what you have just done. What did you like and dislike 

about this GIS? How effective was it at helping you solve the research questions? 

Remember you will be asked to rank and comment on this GIS program at the end of 

the session. 
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STUDENT QUESTIONNAIRE 

Once you have finished all the exercises using the paper and the electronic systems, 
please fill out this questionnaire as accurately as possible. 

Age: _ __ _ Male/Female 
Grade: 

----

1. How do you rate yourself: ( check the boxes)

Expert Advanced Inter- Novice No 
mediate experience 

Using a PC 
Using a Macintosh 
Using new software 
Your geographical 

-

knowledge 

2. Rank each of the GIS systems, 1 (best) through 5 (worst) for the following:

GIS 1 GIS 2 GIS 3 GIS 4 GIS 5 
White Red Blue Green Yellow 
Manual Mao Fact. ArcView IDRISI Maplnfo 

Performance on Ex 1 - overlays 
Performance on Ex 2 - analysis 
Ease of operation 
Most intuitive to use 
Quality of screen graphics 
Quality of hardcopy 
Helped your understanding of the 
geographic concepts 
Most fun to use 
Like to use again 

3. Would you like this software available in your high school classes?

4. Give at least two reasons why you think you would find it useful in school.

5. Other Comments: (about GIS programs in general and/or about specific programs).
Use the back of this sheet.
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Appendix H 

High School Technological Evaluation 
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Technology Questionnaire: COMPUTER AVAILABILITY AND CAP ABILITY 

Lab# # of Student PC/MAC Type of PC Memory Hard Disk 
Computers orMAC (RAM) Capacity 

1 PC/MAC 

2 PC/MAC 

3 PC/MAC 

4 PC/MAC 

5 PC/MAC 

2. Do social studies classes have access to a computer lab? YIN 

Networked Network 
Yes/ No Type 

(Ethernet) 

YIN 

YIN 

YIN 

YIN 

YIN 

Server Server Disk 
Memory Capacity 

(RAM) 

3. Would any particular lab not be available to them? YIN If yes, which one(s)? Lab ___ _ 

Please include your name and telephone number, so I may contact you if any clarification is necessary. 

Name: 

School: 

Telephone: 
N 
N 
00 
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Table 37 

The Technological Status of High Schools in the Study Area 

School # Computers Type Operating Memory Hard Disk Networked Server Server Disk Accessible to 
System MB of RAM Capacity Yes/No Memory Capacity SS Classes 

MB MB of RAM MB 

Allegan NP PC386/486 DOS 5/6 NP NP Yes NP NP Yes 

Otsego 55 PC DOS 4 None Yes 12 1000 No 

Delton Kellogg 70 PC386/486 Win 4-8 150-250 Yes NP NP Yes 

40 Mac Plus/LC old/7.1 min/4 None/80 Yes NP NP Yes 

Athens 20 PC286 DOS 0.64 20 No NA NA No 

Harper Creek 25 Mac 7.1 4 80 Yes 16 120 Yes 

Lakeview 28 Apple Ile NP NP None No NA NA Yes 

Marshall 22 PC286 DOS 6.2 0.64 21 No NA NA No 

Three Rivers 12 Mac Plus NP 1 NP No NA NA No 

Climax-Scotts 50 PC DOS 3.3/6.2 1 /8 40/250 Yes 16/32 400/800 Yes 

Comstock 48 PC286 DOS 3.1 None Yes NP 100 No 

Kai.Loy Norrix 72 PC286/386/ DOS 3.3 NP NP Yes 16 NP No 
486 

N 
N 
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School # Computers Type Operating Memory Hard Disk Networked Server Server Disk Accessible to 
System MB of RAM Capacity Yes/No Memory Capacity SS Classes 

MB MB of RAM MB 

16 Mac 8 80 No NA NA Yes 

Portage Central 55 MACLCIII/ 7+ 4/8 160 Yes 8 250 Yes 

LC550-475 

60 PowerMac 7+ 8 500 Yes 16 700 Yes 

30 30/286 DOS 2 none Yes 8 350 Yes 

Schoolcraft 22 PC DOS NP NP Yes 40 80 No 

KAMSC 50 MAC 7.1 5 80 Yes 16 1000 No 

IO PC486 Win3.I 4 120 Yes 16 1000 No 

Hackett 35 PC285/385 DOS/Win 2/4-8 120/80-280 No NA NA No 

Kai. Christian 36 PC DOS 6.22 4 240 No NA NA No 

Decatur 20 PC386 Win 2 45 No NA NA No 

Gobles 29 PC NP 0.64/8 None Yes 16 400 No 

Mattawan 28 PC486 NP 8 400 Yes 8 850 Yes 

SS Classes-Social Studies Classes NP-Not Provided by the respondent. NA-Not Available. 
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Table 38 

Information on Schools Responding to the Questionnaire 

ALLEGAN INTERMEDIATE SCHOOL DISTRICT 

School 

Allegan 

Otsego 

Student Enrollment Environment 
1994-95 

767 Rural 

686 Rural 

BARRY INTERMEDIATE SCHOOL DISTRICT 

School 

Delton Kellogg 

Student Enrollment Environment 
1994-95 

567 Rural 

CALHOUN INTERMEDIATE SCHOOL DISTRICT 

High Schools Student Enrollment Environment 
1994-95 

Athens 216 Rural 

Harper Creek 816 Rural 

Lakeview 1006 Urban 

Marshall 798 Urban 

#Students per 
computer 

NP 

12:1 

#Students per 
computer 

5:1 

#Students per 
computer 

11:1 

33:1 

36:1 

36:1 
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CASS INTERMEDIATE SCHOOL DISTRICT 

School 

Three Rivers 

Student Enrollment Environment 
1994-95 

800 approx. Rural 

#Students per 
computer 

67:1 

KALAMAZOO VALLEY INTERMEDIATE SCHOOL DISTRICT 

School Student EnrQllment Environment #Students per 
1994-95 computer 

Climax Scotts 197 Rural 4:1 

Comstock 645 Urban 13:1 

Kal. Loy Norrix 1292 Urban 15: 1 

Portage Central 1133 Urban 8:1 

Schoolcraft 289 Rural 13:1 

KAMSC 150 U ndesignated 2:1 

Hackett Catholic 486 U ndesignated 14: 1 

Kal. Christian 482 U ndesignated- 13:1 

VAN BUREN INTERMEDIATE SCHOOL DISTRICT 

School Student Enrollment Environment #Students per 
1994-95 computer 

Decatur 267 Rural 13:1 

Gobles 263 Rural 9:1 

Mattawan 747 Rural 27:1 

NP - Not Provided 
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